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Before you start

Thank you for purchasing Pinnacle Studio. We hope
you enjoy using the software.

This manual covers all versions of Studio, including
Studio Plus. Differences between versions will be noted
as applicable. Most of the time, the word “Studio” will
be used generically to refer to all versions.

If you have not used Studio before, we recommend that
you keep the manual handy for reference even if you
don’t actually read it all the way through.

In order to ensure that your Studio experience gets off
on the right foot, please review the three topics below
before continuing to Chapter 1: Using Studio.

Equipment requirements

In addition to your Studio software, here is what you
need to make a Studio editing system.

Computer

e Intel Pentium or AMD Athlon 1.4 GHz or higher
(2.4 GHz or higher recommended)
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512 MB of RAM (1 GB recommended; 1 GB
required for HD)

Windows XP

DirectX 9 or higher compatible graphics card
compatible with 32 MB (ATl Radeon or NVIDIA
GeForce2 or higher with 128 MB recommended for
SD; 128 MB required for 720p HD; 256 MB
required for 1080i HD)

DirectX 9 or compatible sound card (Creative
Audigy or M-Audio recommended)

500 MB of disk space to install software plus 3 GB
to install bonus content.

DVD-ROM drive

The following items are optional:

CD-R(W) burner for creating VCDs or S-VCDs
DVD-/+R(W) burner drive for creating DVDs
A microphone, if you want to record voice-overs

Note: HD video is supported by Studio Plus only.

The hard drive

Your hard drive must be capable of sustained reading
and writing at 4 MB/sec. Most drives are capable of
this. The first time you capture, Studio will test your
drive to make sure it is fast enough. Video in the DV
format occupies 3.6 MB of hard drive space per
second, so just four and a half minutes of DV video
will consume a full gigabyte on the drive.

Tip: We recommend using a separate hard drive
dedicated to video capture. This avoids competition
between Studio and other software, including
Windows, for use of the drive during capture.

Pinnacle Studio 10 Plus



Video capture hardware

Studio can capture video from a variety of digital and
analog sources. See “Capture hardware” on page 23.

Video output hardware
Studio can output video to:

e Any HDV, DV or Digital8 camcorder or VCR. This
requires an OHCI-compliant IEEE-1394 (FireWire)
port (as provided by Pinnacle Studio DV). The
camcorder must be set up to record from DV Input.

e Any analog (8mm, Hi8, VHS, SVHS, VHS-C or
SVHS-C) camcorder or VCR. This requires Pinnacle
Studio USB-700, PCI-500, PCI-700, or another
Pinnacle device with analog outputs. Output to
analog camcorders or VCRs is also possible using a
Pinnacle Studio DV or other OHCI-compliant 1394
port if your DV or Digital8 camcorder or VCR can
pass a DV signal through to its analog outputs (see
your camcorder manual and Chapter 12: Making
your movie, for more information).

Note: HDV camcorders are supported by Studio Plus
only.

Abbreviations and conventions

This guide uses the following conventions to help
organize the material.

Terminology

Studio: “Studio” and “Studio Plus” refer to the editing
software.
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DV: The term “DV” refers to DV and Digital8
camcorders, VCRs and tapes.

HDV: A “high-definition video” format that allows
video in frame sizes of 1280x720 or 1440x1080 to be
recorded in MPEG-2 format on DV media.

1394: The term “1394” refers to OHCI-compliant
IEEE-1394, FireWire, DV or i.LINK interfaces, ports
and cables.

Analog: The term “analog” refers to 8mm, Hi8, VHS,
SVHS, VHS-C or SVHS-C camcorders, VCRs and
tapes, and to Composite/RCA and S-Video cables and
connectors.

Buttons, menus, dialog boxes and windows

Names of buttons, menus and related items are written
in italics to distinguish them from the surrounding text,
whereas window and dialog names are written with
initial capital letters. For example:

Click the Edit menu button to open your menu in the
Title Editor.

Choosing menu commands

The right arrowhead symbol (>>) denotes the path for
hierarchical menu items. For example:

Select Toolbox » Generate Background Music.

Keyboard conventions

Key names are spelled with an initial capital and are
underlined. A plus sign denotes a key combination. For
example:

Press Ctrl+A to select all the clips on the Timeline.
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Mouse clicks

When a mouse click is required, the default is always a
left-click unless otherwise specified:

Right-click and select Go to Title/Menu Editor.

On-line help

Two kinds of immediate help are always available
while you are working in Studio:

e Help file: Click the help button [?] in the Studio
main menu bar, or select the Help > Help topics
menu, or press F1 to open Studio’s help file.

e Tool tips: To find out what a button or other Studio
control does, pause your mouse pointer over it. A
“tool tip” appears explaining its function.
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CHAPTER 1:

Using Studio

Creating movies with Studio is a three-step process:

1. Capture: Import source video material — your “raw
footage” — to your PC hard drive. Possible sources
include analog videotape (8mm, VHS etc.), digital
videotape (HDV, DV, Digital8), and live video from a
video camera, camcorder or webcam.

Capture mode is covered in Chapter 2: Capturing
video.

Availability: HDV capture is supported in Studio Plus only.

2. Edit: Arrange your video material as desired by
reordering scenes and discarding unwanted footage.
Add visuals, such as transitions, titles and graphics, and
supplementary audio, such as sound effects and
background music. For DVD and VCD authoring,
create interactive menus that give your audience a
customized viewing experience.

Edit mode is the arena for most of your work in Studio.
See “Edit mode” later in this chapter (page 5) for a
fuller introduction.

Chapter 1: Using Studio 1



Studio Overview

1 Capture Mode ——

Import video to your computer's hard drive,

Diskemater:

Organize your movie, adding audio, graphics and effects.

Video and Audio Teolboxes:

Album:

Make Movie Mode —I
Save your movie on the media of your chaice.
Output Tabs:
B =S

-
Creats:
08, VDS and VOO >
Digital Dusput:
(o s
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3. Make movie: When your project is complete,
generate a finished movie in your choice of format and
storage medium: tape, VCD, S-VCD, DVD, AVI,
MPEG, RealVideo or Windows Media.

Make Movie mode is covered in Chapter 12: Making
your movie.

Setting the mode

Select which step of the movie-making process you
want to work on by clicking one of the three mode
buttons at the top left of the Studio window:

‘ 1 Capture ”2 Edit ﬂ 3 Make Movie ‘

When you switch modes, the Studio screen changes to
display the controls needed for the new mode.

Undo, Redo, Help, Support and Premium

The Undo, Redo, Help, o n 2 0 &
Support and Premium buttons —
are always to be found in the top right corner of the
Studio window, no matter which of the three modes
you are currently working in.

e Undo allows you to back out of any changes you
have made to your project during the current session,
one step at a time.

e Redo reinstates the changes one by one if you undo
too far.

e The Help button launches Studio’s built-in help
system.
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e The Support button opens Studio’s technical support
site in your web browser.

e The Premium button lets you expand Studio by
purchasing and installing premium content. (See
page 11 for details.)

All other controls on the Studio screen are dedicated
to tasks within the current mode.

Setting options

Options in Studio are set in two tabbed dialog boxes.

The first lets you control options related to Capture
mode and Edit mode. It has four tabs:

Pinnacle Studio Plus Setup Options

| Capture source ] Capture format ] Project preferences ] Video and audio preferences ] —‘

The other dialog box is concerned with options relating
to Make Movie mode. It has three tabs, one for each of
the three movie output types:

Pinnacle Studio Plus Setup Options

Make Disc | Make Fil | Make Tape| . |

Each panel of both dialog boxes can be opened
individually with a corresponding command on the
Setup menu (e.g. Setup » Capture Source). Once either
dialog box is open, however, all of its panels are
available through the tabs.

For simplicity, we generally refer to the different
options panels independently, as in “the Capture source
options panel”.

Detailed explanations of the options in both dialog
boxes are contained in Appendix A: Setup Options.
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¢ EDIT MODE

Studio opens in Edit mode each time it is launched,
because that is the mode you use most often. The Edit
mode display includes three main areas.

The Album stores resources you will use in your
movies, including your captured video scenes.

The Movie Window is where you create your edited
movie by arranging video and sound clips, and by
applying transitions and effects.

The Player provides playback and previewing for
whichever item is currently selected in Studio. That
may be an Album resource — such as a video scene, title
or sound effect — or your edited movie, complete with
transitions, titles, effects and several audio tracks. The
Player is covered below.

See Chapter 3: The Album and Chapter 4: The Movie
Window for detailed information on those topics.

1 3 e s

Album Movie Window — Player
= ]

=

SN Gl

I ImD I [

m.
e S M
o J i .y )

B o
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The Player

The Player displays a preview of your edited movie, or
of the item currently selected in the Album.

It consists of two main areas: a preview window and
playback controls. The preview window displays video
images. The playback controls allow you to play the
video, or go to an exact position within it. These
controls come in two formats: standard and DVD.

Standard mode

The standard playback controls are similar to those on a
camcorder or VCR. They are used for viewing ordinary
video.

Preview
window

Full-screen
button

&
2 £
=
2 a
-
] | 2 &
Player L8 9
scrubber 1 o g
1 Lon |
— — N 00 ey (]
Transpor‘t—-rﬁ.,.-..:o- 0:00:55.07 1= e
|
controls e “ @,_J_Q

Current position counte?
P Master volume and mute

DVD mode

The DVD playback controls emulate the navigation
controls on a DVD player or remote control. Use them
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for previewing your DVD, VCD or S-VCD disc
productions, including menu interaction.

B—c c
x v o
Preview o g
window B a
1
=
w
c
o
b}
3
=]
L
o
[=1]
o
3 - *!
Transport =@ 2
controls | O v O 00 fa)

T

Disc navigation controls

The preview window

This is a point of focus in Studio because you use it so
often, especially for previewing your movie. It can also
be used to display:

e Any type of Album content.

e Still images or titles from your movie.

e Changes to video effects in real time while you
adjust the parameter controls for the effects.

o Still frames from your video.
While viewing a still frame, you can step by as little
as a single frame in either direction with the *“jog”
controls.

The DVD toggle button

Switch between the two playback modes with the |E
DVD toggle button at the bottom right-hand
corner of the Player. This button is only available when
your edited movie contains at least one menu.
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Playback controls

The Player presents either of two sets of playback
controls depending on the playback mode you choose.

When you play your movie back as ordinary video, you
will be using the standard playback controls. If your
movie uses disc menu navigation, you can play it back
as an optical disc with interactive on-screen menus by
using the DVD playback controls. Both groups of
controls are covered below.

The full-screen preview button: This button, just
above the top right-hand corner of the preview
window, switches to a full-screen preview. It is
available in both playback modes. On a single-monitor
system, the full-screen display ends when your movie
ends, or you double-click the screen or press the Esc
key. See the Video preview options in the Video and
Audio Preferences panel (page 257) for settings that
apply to multiple-monitor systems.

The Video preview options on the Video and audio
preferences options panel let you direct the full-screen
preview to the secondary monitor on your system if
there is one. In Studio Plus, you can simultaneously
send your preview to an external device, if desired.

Standard playback controls
These buttons control playback in the Player.

Play / Pause: The Play button previews the
movie from the current position. Once preview
begins, Play becomes Pause. When playback is
paused, the Album scene or Movie Window clip
at which previewing stopped remains selected. The
[Space] key can also be used to start and stop playback.

(91T ]
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Go to beginning: This button halts playback and .«
skips back to the first frame of the material being
previewed.

Fast reverse, Fast forward: These buttons let .4
you preview your movie at two, four or ten times

the normal speed, in either direction. Use them [
to scan for a particular piece of video you want

to work with. Click the buttons repeatedly to loop
through the speed factors.

Loop: This button causes the currently-selected ‘g,
clips in the Movie Window to play back
repeatedly. This feature is especially convenient whilst
selecting and editing add-on effects and transitions.
Click any playback button to halt looping. The loop
button lights up while looping is active. Looping is
maintained even if you switch playback speeds.

Jog buttons: This pair of controls normally steps =
your movie forward and backward by one frame
at a time. To step by seconds, minutes or hours instead
of frames, select the corresponding field in the counter
(see below), then use the jog buttons to modify it.

The Player scrubber

Use the Player scrubber to quickly traverse your
captured video or edited movie in either direction. The
scrubber position corresponds to the position of the
current frame in the captured video file (not just the
current scene) or in the edited movie (not just the
current clip). Thus the scrubber bar always represents
the entire length of the content being viewed.

L F

As you move the scrubber, the preview window shows
the current frame. If you have activated the audio
scrubbing button in the Movie Window, you will also
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hear snatches of your movie’s audio as you scrub. See
page 60 for details.

The ability of the preview to keep up with the scrubber
depends on the speed of your computer. If you move
the Player scrubber slowly, the preview display
responds smoothly. As you increase the rate at which
you move the scrubber, the preview will jump frames.
The point at which it does so depends on your
hardware. The smoothness of the preview also
diminishes as the overall length of the material being
scrubbed increases.

The counter
The counter displays the current (g.00.0s 282

playback position in hours, minutes, Fl

H rames
seconds and frames. You can directly Sacnns
modify the counter fields to select an Minutes

exact frame to view or at which to "ours

start playback. Simply click on the number you wish to
change and type a new value. To move to a different
field, click again or use the Left and Right arrow keys.

You can also modify the value in a selected field by
using the jog buttons beside the counter or the Up and
Down arrow keys.

The master volume slider

U
This control sets the overall audio volume during
preview playback. It is equivalent to turning up the
master volume on your sound card using the system

volume tool. It does not affect the volume of the final
movie Studio creates in Make Movie mode.

The small loudspeaker icon at the right of the control
serves as a master mute button during playback.
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DVD playback controls

(« These controls include the four
f . standard transport buttons detailed
= above (Play/Pause, Fast reverse,
R MY Fast forward, Go to beginning) plus
the DVD Player Control, which is described under
“The DVD Player Control” on page 171.

Further editing topics

Please see the following for details on specific editing
topics:

e Chapter 5: Video clips

o Chapter 6: Two-track editing with Studio Plus

e Chapter 7: Transitions

o Chapter 8: Still images

o Chapter 9: Disc menus

e Chapter 10: The Title Editor

e Chapter 11: Sound effects and music

Expanding Studio

One way to add pizzazz to your productions is to use a
variety of video and audio filters, animated transitions,
titles, VCD and DVD menus, and sound effects.

Studio includes an extensive selection of hundreds of
content items and special effects, but it’s also designed
to grow along with your needs. When you want a
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particular filter, transition, menu or effect that isn’t part
of the basic set, an easy-to-use upgrade mechanism lets
you find, purchase and install the materials you need
without even leaving the program.

B Most of the premium content available for
Studio does not even require downloading.
Studio’s Bonus Content DVD includes
numerous items, like the Hollywood FX transition at
left, that initially appear as “bonus” content in Studio,
symbolized by a small treasure chest symbol in the top-
left corner of the icon. Such items can be upgraded by
purchasing a code called an activation key. Each key
activates a small group or theme pack of related
content.

Additional items of premium content will be provided
for download as they become available. These items
can sampled and purchased within Studio using the
same activation method as for the premium content
included with the program installation.

You can easily try out bonus content before purchase to
make sure that it meets your needs. Until you actually
purchased your activation code for the item, it will
produce “watermarked” output when you preview or
when you make your finished movie.

New tools, new media, new frontiers

You can purchase additional media and filters in any of
three ways from within Studio:

» With the Help > Purchase activation keys @ )
menu command (or the premium shortcut =
button at the top right of the Studio screen).

This opens a special browser window in which you
can access a catalog page for any type of premium
content that interests you.
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o With the Album commands More transitions, More
sound effects and More menus.

These commands are found on the dropdown lists in
the corresponding sections of the Album. They will
enable you to download, try out and purchase
additional premium content that was not included
with the program installation.

¢ By clicking the activate buttons found in some parts
of Studio.

% Activate Effect Pack

These buttons can be found whenever premium
content is on display within Studio. The one above,
when seen in the Audio effects tool and the Video
effects tool, would let you activate a pack of audio or

video filters.
o | [ Video Efects A Vidoo Cifoc
T . ;:.Iwev:;acr:RTFx
®| :
| (4
& |
5]
[5] .

C 8

%'g Activate Effect Pack

Here, the “RTFX Volume 2 page is open in the
Video Effects tool. The Activate Effect Pack button
could now be used to unlock the effects in this set.

Similar buttons in the Album let you purchase all the
media on a particular Album page as a theme pack.
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[ | [
| o | [® ® ® B
He A m B Hollywood FX Transitions
[T ) J
=] @ ® s 3 -
e Hl A E &3 I
| o J — \
— & r & R
«‘'m'm | @ 2
I é J — -
& & B B Click here to activate
HE T @ # '

The Transitions section of the Album, open to one of
the many theme packs of Hollywood FX transitions.
Click anywhere in the activation panel on the right-
hand page to activate this set of transitions.

How activation works

“Activating” premium content for Studio means to
obtain a license allowing you unrestricted use of the
content on the single machine where Studio is installed.
The licensing mechanism employs two distinct but
mutually related codes:

An activation key for each premium content item you
purchase;

Your Passport, which is a number generated the first
time you install Studio on your computer. You can
view your Passport by selecting the Help » My
Passport menu command.

Because the Passport is specific to one computer, you
will need to obtain new activation keys if you install
Studio on a different machine. These will be provided
at no charge, but your user licenses for both Studio and
any premium content you have obtained then apply to
the new machine only.

Pinnacle Studio 10 Plus



Note: Although your Passport is specific to an
individual computer, it is not affected by ordinary
hardware modifications such as adding or removing
expansion cards, drives or memory.

If you don’t have an Internet connection...

You can purchase and apply premium content
activation keys even if you don’t have an Internet
connection on the computer where Studio is installed.
When you click one of the unlock links within Studio, a
dialog will be displayed showing information needed
for ordering the specific content you want, including:

e An Internet URL where you can activate the content

e Numeric identifiers for the Studio program and the
item you want to activate

e Your Passport and your Serial Number

Navigate to the given URL from another computer,
enter the information, and complete the purchase as
directed. You will then be given an activation key with
which you can activate the content on the original
computer by using the Help > Enter Activation Keys
menu command.

Hiding and showing premium content

If you would prefer not to view the premium content
and features available in Studio, open the Project
preferences options panel and uncheck either or both of
Show premium content and Show premium features.
(See page 253.)
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CHAPTER 2:

Capturing video

Capture is the process of importing video from a video
source such as a camcorder to a file on your PC’s hard
drive. Clips from this “capture file” can then be used in
Studio as ingredients of your edited movies.

You can open capture files into the Album in Studio’s
Edit mode (see Chapter 3: The Album).

Footage Capture files Video scenes Video clips
in the camera ”“* on hard drive ""» in the Album ”"» in your movie

Capture is the first step in using your video footage.

Studio is able to capture from both digital (DV,
Digital8, HDV) and analog video sources.

See “Capture hardware” on page 23 for details on
configuring Studio to capture from your equipment.

Availability: Capturing video from HDV camcorders is supported in
Studio Plus only.
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Switching to Capture mode

The very first step in capturing is to switch into
Studio’s Capture mode by clicking the Capture button
at the top of the screen.

1 Capture “ 2 Edit ” 3 Make Movie ‘

This opens the Capture mode interface, enabling you to
set up and carry out video capture. The details of the
interface are somewhat different for analog than for
digital video sources.

Topics in this chapter

e “The Capture mode interface” (below) introduces the
controls and displays for both analog and digital
captures.

e “The Capture Process” (page 23) covers setting up
your hardware, gives step-by-step capturing
instructions, and describes the automatic scene
detection feature.

e “Digital capture” (page 28) and “Analog capture”
(page 30) cover topics specific to each type of
source.

e Another method of obtaining video material,
although it isn’t capture in the strict sense, and
doesn’t require using Studio’s Capture mode, is to
import files from a DVD disc or image. This
operation is carried out using the File > Import DVD
Titles menu command. See page 33 for details.
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“0 THE CAPTURE MODE INTERFACE

4

The tools and controls you see in Capture mode are
different depending on whether your capture hardware
is digital or analog.

Digital capture

If your video source is digital, your Capture mode
screen will look like this:

Album _ Player

Camcorder controller Diskometer

The Album, at the top left of the screen, displays icons
representing the video scenes as they are captured. The
Player, at top right, lets you view the incoming video
while cueing for capture, and monitor the capture itself.
Readouts on the Player tell you the exact length of the
captured video, and the number of frames dropped
during the capture (normally zero).
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The Camcorder Controller, at bottom left, provides a
tape counter display and a set of transport controls for
operating the playback device. Finally, the Diskometer,
at bottom right, displays the capture space remaining
on the drive. It also provides the Start Capture button
and buttons for setting capture options.

The Diskometer and the Camcorder Controller are
described in detail beginning on page 21.

Analog capture

Both the Album and the Player are used in analog as
well as digital captures, so when you capture from an
analog source the top half of the screen is the same as
shown and described above for digital sources.

Not the bottom half of the screen, however. It now
features a second version of the Diskometer, with two
fly-out panels for adjusting audio and video levels
during capture. (The panels are described under “Audio
and video levels — analog” on page 31.)

=< Ty feac TR
(s Por - T \ e o 0o -1
# r ) & i ] :: : &

Digital vs. analog

To summarize, the digital and analog setups reflect two
major differences in capability:

e The digital setup lets you control the tape transport
of the camcorder or VCR using the Camcorder
Controller.

e The analog setup lets you modify audio and video
levels dynamically during capture.
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The Diskometer

The Diskometer displays, both numerically and
graphically, the amount of space available on your
capture drive. It also indicates the approximate duration
of video that can be accommodated, which depends on
both the available space and the configured capture
quality. Capture quality settings are selected using the
preset buttons that are displayed on the Diskometer for
some capture devices, or by entering custom settings.
See “Capture source settings” (page 246) and “Capture
format settings” (page 250) for information on capture
settings.

The Diskometer when capturing from a digital
source (L) and an analog source (R). Click the side
tabs on the analog version to open fly-out panels for
adjusting video and audio levels during capture.

The Start capture button on the Diskometer begins and
ends the capture process. The caption changes to Stop
capture while the operation is in progress.

The default save location for captured video is your
system’s Shared video directory.
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Setting the capture directory: To save captured video
to a different location, click the file folder button (&
This displays the Select Folder And Default Name For
Captured Video dialog. The folder you assign will be
used to store captured video during this and future
sessions. The file name you enter will be offered as the
default file name on your next capture.

The Camcorder Controller

This panel of transport controls is shown in Capture
mode if you are capturing from a digital video source.
(Analog devices must be cued and operated manually.)

cJclclcle)
@@

pe——

The Camcorder Controller and a close-up view of
the transport controls. The counter window above
the control buttons displays the current position of
the source tape, along with the current transport
mode of the camcorder.

From left to right, the transport control buttons are:
Stop, Rewind / Review, Play, Fast forward / Cue and
Pause.

The Frame reverse and Frame forward buttons (second
row) let you locate the exact frame you want. These
two buttons are available only when the device is in
pause mode.
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€ THE CAPTURE PROCESS

Studio lets you capture video from a variety of analog
and digital hardware types. Choose the device you wish
to use on the Capture source options panel. See
“Capture hardware” (below) for more information.

Performing the actual capture is a straightforward step-
by-step procedure (see page 25). As the capture
proceeds, Studio automatically detects the natural
breaks in the incoming video and divides the material
into “scenes”. Each scene is added to the Album, where
it is represented by an icon of its first frame. Automatic
scene detection is described starting on page 27.

Some capture options apply to digital captures only or
to analog captures only. These are covered in their own
sections, “Digital capture” (page 28) and “Analog
capture” (page 30).

Capture hardware

Studio can capture digital and analog video from the
following sources, depending on your hardware:

e Digital: A DV or Digital8 camcorder connected to
an IEEE-1394 (FireWire) port. Capturing from HDV
sources is additionally supported in Studio Plus.

e Analog: A camcorder or VCR with analog outputs
connected to a DirectShow-compatible capture board
or external device.

e Analog: A USB video camera or webcam.

Chapter 2: Capturing video 23



24

Pinnacle Systems offers a complete line of DV, analog,
and combination capture boards and devices. For more
information see your dealer or visit our web-site:

www.pinnaclesys.com

To select a capture device:

1. Click the Setup » Capture Source menu command.
The Capture source options panel appears.

2. Select the devices you want to use from the Video
and Audio dropdown lists in the Capture devices
area, and click OK.

Capture source ] Capture format ] Project preferences ] Video and audio preferences ]

Capture devices

Video TV Standard Aspect Ratio
[Pinnadk: 700.-UsE = nsc =] a3 =l
Audio [~ VCR Input

|Pinnac|e 700-USB j [¥ Capture preview

See “Capture source settings” on page 246 for
detailed information about the Capture source
options panel.

Standard vs. widescreen capture

Studio can capture in both the standard (4:3) and the
widescreen (16:9) frame- aspect ratios. With digital
hardware, the frame format is detected automatically.
With analog hardware, you use the Aspect ratio
dropdown on the Capture source options panel to select
the format that matches the source material. You can’t
use this setting to change one format to another: it
simply lets Studio know how to display the video at the
correct aspect ratio.
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Capture step-by-step

Here is a step-by-step outline of the capture process.
The instructions apply to both digital and analog
captures, with differences noted as required.

Further information relating to some of the steps can be
found elsewhere in this chapter. Also see Appendix A:
Setup Options (page 245) for detailed descriptions of
the Capture source and Capture format options panels.

To capture video:

1. Verify that your equipment is properly connected.

For a digital capture, your camcorder or VCR must
be connected to your PC’s 1394 port.

For an analog capture, connect the source video to
the Composite or S-Video input of your capture
hardware. Connect your source audio to the audio
input of the capture hardware, if there is one;
otherwise, connect the audio to the audio input of
your PC’s sound card.

2. Click the Capture button at the top of the screen if
you are not already in Capture mode. The Capture
mode interface is displayed (see page 19).

3. Click the desired capture setting on the Diskometer.
If you need to make detailed adjustments, click the
Diskometer’s Settings button, which opens the
Capture format options panel (page 250).

Keep in mind that DV capture uses much more disk
space than does MPEG. If you are planning to
output your finished movie to disc (VCD, S-VCD
or DVD), you may choose to capture in MPEG
rather than DV format.
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For an analog capture, keep in mind that the higher
the quality setting, the larger will be your captured
video file.

See “Digital capture” (page 28) and “Analog
capture” (page 30) for further explanation of these
options.

Click the Start capture button on the Diskometer.
The Capture Video dialog box is displayed.

Type in a name for the video capture file you are
about to create, or accept the default name. You can
optionally also enter a limiting duration for the
capture.

If you are capturing from an analog camcorder or
VCR, start playback now. This step is unnecessary
with a digital-source capture, as Studio will control
the playback equipment automatically when
needed.

Click the Start capture button in the Capture Video
dialog box. The button caption changes to Stop
capture.

Capture begins. The Player displays the incoming
digitized video that is being saved to your hard
drive (unless you have unchecked Capture preview
on the Capture source options panel).

During capture, Studio performs automatic scene
detection based on the current setting in the
Capture source options panel.

Click the Stop capture button to end capture at a
point you select.

Studio automatically stops capturing if your hard
drive fills up or the maximum duration you entered
is reached.
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Scene detection

Automatic scene detection is a key feature of Studio.
As video capture proceeds, Studio detects natural
breaks in the video and divides it up into scenes. A new
icon is created in the Video Scenes section of the
Album for each scene detected.

Depending on which capture device you are using,
automatic scene detection is carried out either in real
time during capture, or as a separate step immediately
after capture is completed.

You can configure scene detection using the options
under Scene detection during video capture on the
Capture source options panel (Setup » Capture
Source). Not all scene detection options are available
with every type of video source. Options that do not
apply to your setup are disabled in the dialog.

The four possible options are:

e Automatic based on shooting time and date: This
option is available only when you are capturing from
a DV source. Studio monitors the time stamp data on
the tape during capture, and starts a new scene
whenever a discontinuity is found.

e Automatic based on video content: Studio detects
changes in the video content, and creates a new
scene wherever there is a large change in the images.
This feature might not work well if the lighting is not
stable. To take an extreme example, a video shot in a
nightclub with a strobe light would produce a scene
each time the strobe flashed.
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e Create new scene every X seconds: Studio creates
new scenes at an interval you choose. This can be
useful for breaking up footage that contains long
continuous shots.

o No automatic scene detection: Select this option if
you want to monitor the entire capture process and
decide for yourself where scene breaks should occur.
Press the [Space] key each time you want to insert a
scene break during capture.

€ DIGITAL CAPTURE

This section covers aspects of capturing from a DV
source deck (camcorder or VCR) and a 1394 port. To
read about capturing from analog hardware, please see
“Analog capture” on page 30.

You have two choices for the way the video data is
encoded and compressed in full-quality captures. For
most purposes, DV format is the logical choice, but if
you are planning to output your finished movie to disc
(VCD, S-VCD or DVD), you may prefer the MPEG-1
or MPEG-2 format instead.

Because of the intensive computation required for
MPEG-2 encoding, older computers may not be fast
enough to achieve a satisfactory MPEG-2 capture. The
type of capture hardware you have and the capture
quality you choose also help determine the minimum
CPU speed needed. In cases where Studio is able to
estimate that your computer is not fast enough to carry
out a particular capture, it will advise you of the
problem and give you a chance to cancel the operation.
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DV

DV is a high-resolution format with correspondingly
high storage requirements.

Your camcorder compresses and stores video on the
tape at 3.6 MB/s, at a quality equivalent to broadcast
video. During capture, the video data is transferred
directly from the camcorder tape to your PC hard drive
with no changes or additional compression. Capturing
DV video consumes a lot of drive space, so you may
want to pick small segments to capture instead of the
entire tape if space is an issue on your system.

You can calculate the amount of disk space you will
need by multiplying the length of your video in seconds
by 3.6, which gives the number of megabytes required.
For example:

1 hour of video = 3600 seconds (60 x 60)

3600 seconds x 3.6 MB/s = 12,960 MB (12.7 GB)

Hence 1 hour of video uses 12.7 GB of storage.
To capture DV video, your hard drive must be capable
of sustained reading and writing at 4 MB per second.
All SCSI and most UDMA drives are capable of this.
The first time you initiate a capture, Studio will test
your drive to make sure it is fast enough.

MPEG

DVD and S-VCD discs both use files in MPEG-2
format, an extension of the MPEG-1 format used for
VCDs. MPEGs intended for use on the Internet will be
at lower resolutions and in MPEG-1 format.

The Capture format options panel (Setup » Capture
Format) includes a variety of options to control the
quality of MPEG captures. Refer to “Capture format
settings” on page 250 for detailed information about
MPEG quality options.
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Audio and video levels — digital

With digital captures, you are using audio and video
that have been encoded digitally during recording, right
in the camera. When you transfer the footage through a
1394 port to your computer, the data remains in the
compressed digital format throughout, so you cannot
adjust the audio or video levels during the capture. This
IS in contrast to analog captures, where the audio and
video can be adjusted as capturing takes place.

With digital captures, you defer any needed adjustment
of audio and video levels until Edit mode, where Studio
provides plug-in video effects for adjusting the visual
balance of a clip, and audio effects to enhance the
sound. These effects allow you to adjust individual
clips rather than having to make global adjustments
affecting all the video in a capture file. For details see
“Analog capture” (below), “Using video effects” (page
98), and “Audio effects” (page 223).

¥ ANALOG CAPTURE

The topics in this section relate to capture with analog

equipment, such as:

e A camcorder or VCR with analog outputs connected
to a DirectShow-compatible capture board or
external device.

e A USB video camera or webcam.

If you are using a digital camcorder connected to your
computer via a 1394 port, please refer instead to “DV
capture” on page 28.
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Capture quality options

With most analog capture hardware, Studio offers three
preset quality choices — Good, Better and Best — plus a
Custom option. Your hardware’s capabilities determine
how the presets translate into particular settings for
picture size, frame rate, compression characteristics and
quality. Keep in mind that the higher the quality, the
more disk space is required. Choose the Custom preset
to configure your own video capture settings. For more
information on video capture settings, see Appendix A:
Setup Options (page 250).

Audio and video levels — analog

Studio provides fly-out panels for controlling video and
audio levels during capture. This feature is especially
useful when you need to compensate for differences in
video captured from multiple sources.

Video input - Pudo caplurs

0 corooms @ $v2e0 Do & o=

Cijilje® L

e

Video (L) and audio (R) panels for setting levels during
analog capture.

it

Chapter 2: Capturing video 31



Although you can also adjust these levels with the
appropriate Video effects in Edit mode, setting them
correctly for capture can save you from having to
worry about color correction later on.

Setting your audio options correctly as you capture will
help in achieving consistent volume levels and quality.

Particular capture devices may offer fewer options than
are shown and discussed here. For instance, with
hardware that doesn’t support audio captures in stereo,
a balance control will not appear on the audio panel.

Video

Choose the type of video you are going to digitize by
clicking the appropriate Source button (Composite or
S-Video). The five sliders allow you to control the
brightness (video gain), contrast (black level),
sharpness, hue and color saturation of the incoming
video.

Note: The Hue slider does not appear when capturing
from PAL equipment.

Audio

Use the Audio capture buttons to control whether
Studio should capture the audio along with the video.
Select the Off button if your source is video only. The
sliders on the tray let you control the input level and
stereo balance of the incoming audio.
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”0 IMPORTING VIDEO FROM DVD

4

Although it isn’t capture in the strict sense, you can
also bring video into Studio by importing it from a non-
protected DVD disc or a DVD disc image on your hard
drive. The File » Import DVD Titles menu command
opens a dialog that lets you locate and preview the
DVD material of interest, then import it as an MPEG-2
file to the folder of your choice.

Note: If the audio on the DVD is in AC3 format, it
may be necessary to purchase an activation code for the
AC3 codec software.

Import DVD Titles

Chaose & dise or image: Choose  destination folder:
-] Program File[a | Clvelt (=]
3 Psfonts 1 -
= recraLer Type & name for this disc:
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) Temn
-0 WINDOWS Check the titles to import
=) WuTemp Title 1 [~
e DISKEPARTOL (0 i::z § [
& é DVD-RW Drive: (f Title 4
& (=) DVOT (F) THie 5
(4 e DISKERARTOR (¢ THiE 6
% < Local Disk (H) Tile 7
& B Documerts Tie 8
18 My Camera T
() Thorkney's Docy| GEmrT——
-8 My Network Places Impart

() Unused Deskkop Shel_|
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OO E]
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™ f
Cancel
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To import DVD video:
1. Select the DVD disc or image using the folder
explorer controls under Choose a disc or image.

Studio lists the “titles” (video files) available at the
location under Check the titles to import.

2. Use the folder browser button (&3] to select a
destination folder for the imported files.
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3.

Enter a name for the DVD. This will be used as part
of the imported file names. For example, if you
name the DVD or image “My DVD”, and import
Title 12, the resulting file name will be:

My DVD_Title_12.mpg
Select the title or titles you wish to import by
checking the boxes next to the names. You can use

the player controls on the right side of the dialog to
preview the content of the currently-selected title.

Click the Import button.

Studio displays a progress bar to let you monitor
the progress of the import operation. When it is
complete, you can access the contents of the file for
editing from the Album as with an ordinary capture
file (see next chapter).

Pinnacle Studio 10 Plus



CHAPTER 3:

The Album

'G - B DO

The Video Scenes section of the Album. Click the
tabs down the left side of the Album to access the
materials in the other sections.

The source materials you need for making a movie are
stored in the various sections of the Album, each of
which is accessed by its own tab as follows:

Video Scenes: This section contains your |,
captured video footage. You can access and
preview the capture files directly, or you can load one
into the Album, where its scenes are represented by
thumbnail icons.

To use some of the scenes in your movie, just drag their
icons into the Movie Window. See “The Video Scenes
section”, page 38.
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Transitions: This Album section contains
fades, dissolves, slides, and other transition
types, including the elaborate Hollywood FX
transitions. To use a transition, position it next to or
between video clips and graphics in the Movie
Window. See “The Transitions section”, page 51.

Titles: This section contains editable titles, E
which you can use as overlays or as full-screen
graphics. You can create your own titles from scratch,
or use or adapt the supplied ones. Studio supports rolls,
crawls, and many typographical effects. See “The
Titles section”, page 53.

Photos and Frame Grabs: This is a section of
photographs, bitmaps and grabbed video
frames. You can use these images full-screen or as
overlays on the main video. Most standard image file
formats are supported. See “The Photos and Frame
Grabs section”, page 54.

Disc Menus: Studio has an extensive collection
of chapter menus to use in DVD, VCD and
S-VCD authoring. You can use these as they are,
modify them, or create your own. See “The Disc
Menus section”, page 55.

Sound Effects: Studio comes ready with a | gz
wide range of high-quality sound effects. You

can also use wav, mp3 and avi files that you have
recorded yourself or obtained from other sources. See
“The Sound Effects section”, page 57.

Music: In this Album section you can locate E
and use music files stored on your hard drive.

Files in wav, mp3 and avi formats are supported. See
“The Music section”, page 58.
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Using the Album

Each section of the Album contains as many pages as
are necessary to hold the icons representing the items in
that section. At the top right of each Album page,
Studio shows the current page number and the total
page count for the section. Click the arrows to move
forward or back through the pages.

Page 2of 3 (""J l:) ||||

All types of Album content can be previewed simply
by clicking on the icons.

This chapter introduces each of the Album sections in
turn, beginning with a detailed discussion of the all-
important Video Scenes section. Actually using the
contents of the Album to create your edited movie will
be the subject of chapters 4 through 11.

Source folders for Album content

The scene icons in the Video Scenes section come from
a captured video file, while the Transitions section is
filled from resource files associated with the Studio
program.

The icons in each of the other five Album sections are
different: they represent the files contained in a
particular disk folder. Each of these sections — Titles,
Images, Disc Menus, Sound Effects and Music — has a
default folder assigned to it, but you can select a
different folder if desired.

The source folder for the section’s content is listed at
the top of the left Album page, next to a small Folder
button [&3]. To change the source of the current section,
either select a folder from the dropdown list, or click
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the button, browse to another folder on your system,
and select any file. The file you select will be
highlighted in the repopulated Album section.

R
= | Stardard Tles

‘ M-qm

The icons in the Titles section represent files stored
in a selected source folder on your hard drive. The
dropdown list at the top of the Album page lets you
select either “*Standard Titles” or “My Titles” from
the installed “Titles folder. The folder button beside
the list lets you look elsewhere on your hard drive.
The Disc Menus section works similarly.

Some Album sections also provide a Parent folder
button (& to facilitate moving around within a group of
folders containing appropriate media.

® THE VIDEO SCENES SECTION

=,  This is where the editing process really begins
— in the Video Scenes section of the Album

with your captured raw footage. In a typical production,
your first step will probably be to drag some scenes
from the Album down into the Movie Window (see
Chapter 5: Video Clips).
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In the Album, scenes are displayed in the order in
which they were captured. This order cannot be
changed, since it is determined by the underlying
capture file, but scenes can be added to your movie in
any order you choose.

Similarly, while you can’t trim (edit) Album scenes,
you can use any desired portion of a scene when it
appears as a clip in your movie.

Interface features

The Video Scenes section offers several special
interface features:

e Scenes that have been added to the Movie Window
are distinguished in the Album by a green
checkmark. The checkmark remains as long as any
clip in the Movie Window originates with that scene.

e To see how a particular Album scene is used in your
current project, use the Album > Find Scene in
Project menu command. Studio highlights any clips
in the Movie Window that originate in the selected
scene (or scenes). To go the other way, use the Find
Scene in Album command, which is on the right-
click menu for Movie Window clips.

Nearly all menu commands that apply to scenes are
available both on the main Album menu, and on the
pop-up menu that appears when you right-click a
selected scene.

Tip: When this documentation calls for a menu
command like Album » Combine Scenes, remember
that an equivalent command is usually available on the
pop-up “context” menu as well.
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Summary of operations

Because of its central role, the Video Scenes section of
the Album provides an extensive set of operations.
These are covered below in the following topics:

e Opening a captured video file

e Viewing captured video

e Selecting scenes and files

o Displaying scene and file information

o Comment view

e Combining and subdividing scenes

o Redetecting scenes

I———
Opening a captured video file

The default locations for your video files are the
Windows default capture folder and the My videos
folder. When you are viewing the folder contents page
of the Video Scenes section, both of these locations
always appear on the dropdown list at the top of the
Album.

You can also choose other hard drive folders to access
stored video files. Both the current and previous folders
are also listed, if they are different from the two
standard locations, making four different folders that
may appear in the list at any one time.

Under Windows XP, the system capture folder is
located in the Windows’ *“all users” documents folder.
The capture folder’s real name is My videos, but
Windows Explorer and Studio customarily call it by an
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alias, Shared videos. This distinguishes it from My
videos in the user’s personal documents folder.

4l

= |Trave| j E D

Travel
Family Video
My Videos
Shared Yideo

Opening a folder

The folder contents page is displayed whenever you
choose a new folder. It lists both the subfolders and the
digital video files within the folder you chose:

£7

A

= |Fami|y Wideo ﬂ @ D
D Christras
[ vacation

Three ways to open a folder:

e Select the folder name on the dropdown list on the
folder contents page.

o Select a folder listed on the folder contents page.
o Click the parent folder button [&]
Opening afile

When you open a video file, the file contents page is

displayed, showing icons that represent the scenes in
the file:

.|

|D\u'demo.aw j @ D

=
- A R =3
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Three ways to open a digital video file:

e Select the file name on the dropdown list on the file
contents page.

e Double-click a file listed on the folder contents page.

o Click the browse for file button [t5] and use the Open
dialog to locate a digital video file of any supported
type on your hard drive.

Scene detection and thumbnails

The Album now fills with the detected scenes from
your captured video (see “Scene detection” on page
27). Each scene is denoted by a thumbnail frame — an
icon of the scene’s first frame. It may be that the first
frame doesn’t make a good icon for the scene, so
Studio lets you pick a different one if desired.

To change thumbnails in the Album:

1. Select the scene to be changed.

2. Use the Player to find the frame you want used for
the thumbnail.

3. Click the Album > Set Thumbnail menu command.

Video aspect ratios

Most digital video files provide format information that
allows Studio to detect the frame aspect ratio of 4:3 or
16:9 automatically. If the file does not provide aspect
ratio information, Studio defaults to the standard 4:3
format.

The Aspect Ratio 4:3 and Aspect Ratio 16:9 commands
on the Album menu let you manually set whichever
ratio you need. These commands also appear on the
right-button context menu for video in the Album.
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Their method of operation is to stretch the original
frames to the new frame size. If you set the ratio of a
4:3 movie to 16:9, for example, people and objects will
appear widened relative to their height.

This is different from the frame-size conversion that
occurs when you add a scene to a movie project with
the “opposite” aspect ratio. In that case, the scene is
scaled in both dimensions equally to fit within the
target frame, and excess area appears as black.

L ; .o i | [ I; i | e wa |
(L) Original 4:3 frame; (C) Same frame with black
sidebars on adding to 16:9 project; (R) Same frame

after Aspect ratio 16:9 command is used.

Note: The movie project’s frame format, which cannot
be changed after the project is created, can be set for
new projects in the Project preferences options panel.
See page 253 for more information.

_________________
Viewing captured video

Individual or multiple scenes in the open captured
video file can be viewed at any time.

To view captured video starting at a selected scene:

1. Click on the scene’s icon in the Album.

The Player displays the first frame of the selected
scene.
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2. Click the Play button in the Player.

The Player now plays the selected scenes and any
subsequent ones. Progress is indicated in three
ways.

e The scenes highlight successively as they are
played.

e The Player scrubber shows the current point of
play relative to the entire movie.

e Scene thumbnails display a progress bar during
preview. As you continue to view your captured
video, the progress bar moves from one
thumbnail to the next.

i
= |D\-' demo P3.avi

Previewing digital video files

When a folder is open in the Album and the name of a
digital video file is selected, you can use the Player to
preview the video without actually opening the file into
the Album.

™= |Family'\n'ideo ﬂ @ D

m Christmas
B Wacation
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Selecting scenes and files

Studio offers a variety of ways to select scenes and
other items in the Video Scenes section of the Album.
Selected video scenes are indicated by a highlighted
border. Selected folders and video files are shown with

text highlighting.
| e.l R

Selected scenes have a highlighted border (center).

Selection techniques follow standard Windows
conventions. Use any of the following, separately or in
combination:

e Choose the Edit » Select All menu command or
press Ctrl+A to select all the scenes (or files and
folders) currently displaying in the Album, including
those on other pages.

o Shift-click to select a range of neighboring items.

o Ctrl-click to add or remove individual items from the
selection.

e Starting with the mouse pointer over a blank area of
the Album page, click and drag to “marquee” an
area, selecting all the items that intersect the area.

e Use the arrow keys to navigate the Album grid. Use
the arrows with Shift to select items as you go.

Hel) Bert scales wall
L“,"_EJl Grandma basks|

IEE whistler smother

Selected folders and video files have highlighted text.
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Displaying scene and file information

As you move the mouse pointer over
video scenes, the pointer changes to a
grabber symbol. If you pause
= momentarily on the scene, the start time

owation=+03|  and length is displayed in a pop-up box.
If you leave the grabber on the scene, the display
persists for several seconds. The start time shown is the
timecode from the original source video, in minutes,
seconds, and frames.

For information regarding video files

!ﬁ oo v 2s57es  When the Video Scenes section is in
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e folder view mode, select Details view

in the Album’s right button context

menu. The file name, resolution, aspect ratio, duration

and frame rate are displayed. Switch back to a more
compact listing with Icon view.

Comment view

In the default view for the Video Scenes section,
known as Scene view, each scene is represented by a
thumbnail frame icon. To see more information about
each scene, use the Album >» Comment View menu
command.

In comment view, editable captions are displayed for
Album scenes. The usage of these captions is up to
you: they might be search keywords, or scene names,
or text comments describing the scene content. The
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default caption is generated from the scene’s sequence
number and duration (e.g. “Scene 3, 7:21").

—

= |DV dema PS.avi j @ D

-
_‘lﬁ Scene |
Duration = 7.05

If you click on a video scene, an in-place text field
appears, allowing you to enter the custom name or

|2

Selecting scenes by name

A related option lets you select video scenes by
scanning for keywords in the comments. Use Album >
Select By Name to open this dialog box:

Duration = 16.01

Chroma 1 ‘

Select Scenes by Name
Keywords:
I~ Mat " and |Ehr0mal
o~ O
r r
| 0K | Cancel

Enter a keyword into the text field and click OK to
highlight all Album scenes whose caption contains the
keyword. The default captions are not searched — only
the ones you have customized.

4| Scene2
Duration = 520

Seene 3
Durstion = 1:21.07
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Combining and subdividing scenes

After previewing your scenes, you might want to
combine or subdivide some into larger or smaller units.
Such adjustments are easily made.

To combine scenes in the Album:

1. Select the scenes to be combined.
2. Select Album » Combine Scenes.
The selected scenes are combined into one.

Only selected adjacent scenes can be combined.
Furthermore, they are joined in the order in which
they appear in the Album, regardless of the order in
which they were selected. (Album order proceeds
across rows and then down the page.) To revert,
press Ctrl+Z, or click the undo button.

If the scenes you selected were not all neighbors,
each set of adjacent scenes is combined, but the
different sets are not combined with each other.

1 2 | 1,2 4

4 E 11T = 6-9

Several selected scenes (black) are merged into two
longer scenes. Having no neighbors, scene 4 is
unaffected, even though it was part of the selection.
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To subdivide scenes in the Album:

1. Select the scenes to be subdivided.
2. Select Album > Subdivide Scenes.
The Subdivide Selected Scenes dialog box appears.

Subdivide Selected Scenes

How many seconds per scene?

—

QK (" cancsl

3. Choose the length of the subdivided scenes by
typing in a value.

The smallest allowed subdivision is one second.
Any video remaining after subdivision is added to
the last scene.

4. Click OK.

A progress bar appears, the scene is subdivided, and
new scenes are added to the Album. To revert,
press Ctrl+Z, or click the undo button.

You can subdivide these scenes still further, if
desired, down to the minimum duration of one

second.
1 2 3 la 1b 2
1i2s 7s 19s 5s 7s 7s

e |32, | P2, | IS,

Three selected scenes are subdivided to a duration
of five seconds. The vertical stripes indicate five-
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second divisions within each scene. The uneven
clip timings at right occur because time left after
subdivision is added to the final divided scene; that
is also why scene 2 is ultimately unaffected by the
subdivision operation.

Redetecting scenes

If you combine or subdivide scenes and later decide
that you’d prefer to restore them to their original state,
you may redetect any scene or selection of scenes. The
detection results are identical to those obtained after
capturing, provided the same scene detection technique
is used.

If you have subdivided scenes, you must first
recombine them. Even if you cannot exactly recall the
initial state and so recombine more than is necessary,
the detection process will restore the original scene
sequence.

To redetect scenes:

If you need to recombine any scenes, first select the
subdivided scenes, then apply the Album > Combine
Scenes menu command.

1. Select the scenes you wish to redetect.

2. From the Album menu, select either Detect Scenes
by Video Content or Detect Scenes by Shooting
Time and Date.

A progress window appears as Studio detects the
scenes and repopulates the Album.
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® THE TRANSITIONS SECTION

@ The Transitions section of the Album provides

a large set of drag-and-drop clip transitions. To
keep things manageable, the transitions are divided into
groups. Use the dropdown list to select which group of
transitions you want to view. All the transitions in the
group are displayed, using as many Album pages as
necessary.

To learn about transitions, and how you can use them
in your movies, see Chapter 7: Transitions.

Farnily Fun 1 j
STAMDARD TRAMSITIONS ad

2D Transitions

Alpha Magic I,

Hollywood FX Far Studio by

Flving Windows

Extra Fix

Family Fun 1

Fun Pack.

Studio’s transitions collection includes 74 standard
transitions, more than 50 Alpha Magic transitions, a
starting set of unrestricted Hollywood FX 3-D
transitions, and many more “locked” Hollywood FX
transitions (with a treasure chest symbol in the top-left
corner of the transition icon).

Note: If no premium transitions are visible, click
Editing environment » Show premium content on the
Project preferences options panel to reveal them (see
page 253).
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Using the premium transitions

These demo transitions are freely available for you to
try, but a Studio “watermark” will be superimposed on
part of the video frame during playback. To make use
of them in an actual production, simply open the
Album to the desired transition, then click in the
activation panel on the same Album page. You can
purchase an activation key in just a few minutes, with
no need to exit Studio.

| senocipays

L G & . £
d ! - ﬁ Hollywood FX Transitions

2| | e | . -
| 3| W 2

Ei "m *‘ﬁ ‘ Click here to activate
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The Transitions section of the Album, open to a
theme pack of Hollywood FX transitions. Click
anywhere in the activation panel on the right-hand
page to activate this set of transitions.

For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.

Displaying the transition name

As you move the mouse pointer over the transition
icons in the Album, the pointer changes to a grabber
symbol (indicating that the transition can be

dragged from the Album to the Movie
%7 Window). If you pause momentarily on the
icon, the name of the transition is displayed.

The display persists for several seconds or until your
mouse pointer moves off the transition.
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Previewing transition effects

When you click on a transition icon, the Player
demonstrates the transition using the convention that
“A” represents the original clip and “B” the new clip.
The demonstration cycles for as long as the icon
remains selected.

(w0
.

To see a detailed view, stop the Player and use the jog
buttons (Frame reverse and Frame forward) to step
through the transition one frame at a time.

0‘0 THE TITLES SECTION

®

E This section of the Album contains a collection

of text titles in a variety of styles. They can be
used in your movie as either full-screen or overlay
titles. The difference is that in an overlay title the
transparent background is replaced by other material
(usually a video clip), whereas in a full-screen title, the
background is replaced with black.

In the Album, a gray checkerboard is
used to indicate the portion of a title that
will be treated as transparent in overlays.
(If you prefer a black background, use the
Album > Black background menu command.) As with
video scenes, titles that have been added to your current
project are indicated in the Album by a green
checkmark symbol.
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With Studio’s powerful built-in Title Editor, you can
readily create your own titles when needed. However,
you may find it easier still to start with one of the
supplied titles and customize it in the Title Editor.

The Titles folder: The icons in the Titles section
represent files in the folder named at the top of each
left-hand page in the section. Titles that you have
created or modified can be added to the section by
saving them into this folder from the Title Editor. You
can also select a different folder to source the section
(see “Source folders for Album content” on page 37).

For information on using titles in your movie, see
Chapter 8: Still images.

€ THE STILL IMAGES SECTION

This section of the Album displays thumbnail
icons of image files, which may include
grabbed video frames, photographs and bitmapped
drawings. Most standard image file formats are
supported. As with video scenes, images used by your
current movie are indicated by a green checkmark.

The Still Images folder: The icons in the Still Images
section represent files in the folder named at the top of
each left-hand page in the section. Images can be added
to the section by storing them in this folder. For
instance, you can save grabbed video frames into the
folder from the Frame grabber tool, or save a title from
the Title Editor. You can also select a different folder
to be the source of the section (see “Source folders for
Album content” on page 37).
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For information on using still images in your movie,
see Chapter 8: Still images.

€ THE DiIsCc MENUS SECTION

This section of the Album contains a collection

of artist-designed menus for VCD, S-VCD and
DVD authoring. Menus in Studio are really specialized
titles: they can be created and edited in the Title Editor,
and either saved from the editor into a disk folder or
incorporated directly into your movie.

As with video scenes and other visual resources, disc
menus that are in use in your movie are distinguished in
the Album by a green checkmark symbol.

For information on using disc menus in your movie,
see Chapter 9: Disc menus.

The Disc Menus folder: The icons in the Disc Menus
section represent files in the folder named at the top of
each left-hand page in the section. Menus can be added
to the section by storing them in this folder. You can
also select a different folder to be the source of the
section (see “Source folders for Album content” on
page 37).

The motion background symbol: Some of the menus
supplied with Studio incorporate a background of
moving video rather than a static picture, and you can
also create such menus vyourself. This “motion
background” can help give a professional look to your
finished disc.
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Availability: The motion background feature is
available in Studio Plus only. See “Adding a motion
background” on page 196 for information on creating
or editing a moving video background. See Adding a
motion background for information on creating or
editing a moving video background.

Menus with motion backgrounds are indicated by a
small symbol in the bottom right-hand corner of the
Album icon.

Along with the many standard menus that come with
Studio, and the motion menus that come additionally
with Studio Plus, you will also find several folders of
menus in the “Pinnacle Premium DVD Menus” series.
These are “premium” menus (indicated by a treasure-
chest symbol in the top-left corner of the menu icon).
Many of these professional DVD menus include
looping soundtracks.

Note: If no premium disc menus are visible, make sure
you have checked Editing environment » Show
premium content on the Project preferences option
panel (see page 253).

Activating the premium menus

The demo menus are freely available for you to try, but
a Studio “watermark” will be superimposed on part of
the video frame whenever one is playing. If you want
to use one in an actual production, simply open the
Album to the desired menu, then click in the activate
panel on the same Album page. You can purchase an
activation key in just a few minutes, with no need to
exit Studio.

For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.
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€ THE SOUND EFFECTS SECTION

E Studio comes with a wide range of ready-to-use

sound effects. These wav files are installed into
a number of folders, covering categories such as
“animals”, “bells” and “cartoons”.

The Sound Effects folder: This section of the Album
displays the sound files contained in one disk folder,
named at the top of each left-hand page in the section.
You can display the sounds in a different folder — not
necessarily one of those installed by Studio — by
selecting that folder to be the source for the section (see
“Source folders for Album content” on page 37).

Besides wav (Windows “wave”) files, files in mp3
format and avi animation files are also displayed in this
section of the Album, and may be drawn upon for
supplemental audio in your productions.

Any sound clip can be previewed simply by clicking its
name or icon.

For information on using sounds in your movie, see
Chapter 11: Sound effects and music.

Along with the many unrestricted sound effects that
come with Studio, you will also find several folders of
effects in the UFX, or “Ultimate FX” series. These
effects are premium effects (indicated by a treasure
chest next to the sound effect name in the Album).

Note: If no premium sound effects are visible, click
Editing environment » Show premium content on the
Project preferences options panel (see page 253).
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Using the premium sound effects

These demo effects are freely available for you to try,
but a Studio “watermark” will be superimposed on part
of the video frame whenever the sound is playing, and
an intermittent beep will be added to the soundtrack. To
make use of the effects in an actual production, simply
open the Album to the desired effect, then click in the
activation panel on the same Album page. You can
purchase an activation key in just a few minutes, with
no need to exit Studio.

For more information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.

4 THE MUSIC SECTION

E This section of the Album displays the music

files in a folder on your hard drive. To use a file
drag it onto the Music track or another audio track on
the Movie Window Timeline,

The Music folder: The wav, mp3 and other audio files
come from the folder named at the top of each left-hand
page in the section. Other music files can be added to
the section by storing them in this folder. You can also
select a different folder to be the source of the section
(see “Source folders for Album content” on page 37).

For information on using background music in your
movie, see Chapter 11: Sound effects and music.
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CHAPTER 4:

The Movie Window

The Movie Window, where you build your movie from
the raw materials in the Album, occupies the bottom
half of the screen in Studio’s Edit mode. To access the
Movie Window, first switch to Edit mode if you are not
already there:

‘ 1 Capture ”2 Edit ﬂ 3 Wake Movie ‘

The Movie Window title bar contains several important
controls and displays. The toolbox buttons at the left of
the title bar open the Video toolbox and the Audio
toolbox, which are discussed on page 68.

To the right of the toolbox buttons is a text area where
the project file name is displayed. Status and warning
messages are also displayed in this area when required.
Further still to the right are the Audio scrubbing, Clip
split and Clip delete buttons, while at the far right are
three view selection buttons (see “Movie Window
views” on page 62).

Delete clip
Toolbox File name and Split clip -| View buttens
| I
| | B 5 =
?

| buttons message area | Scrub sgund
Clown party * .1,.__ E! [
n | ) '.-' 1
s
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Audio scrubbing button

) By default, your project’s audio is previewed

during playback only. Studio’s audio scrubbing
feature, which is turned on and off by the loudspeaker
button, provides audio preview when you are scrubbing
through your movie as well.

Audio scrubbing makes life much easier when making
editing decisions that depend on sound cues.

Split clip/scene button — the razorblade

£ Click this button to split the currently-selected clip
in the Movie Window, or the currently-selected
scene in the Album.

No information is lost. If the item is an Album scene, it
is split at the indicated point into two shorter scenes. If
the item is a clip in the Movie Window, it is duplicated
and automatically trimmed to the split point.

The razorblade button can be used in conjunction with
the track-locking buttons in the Movie Window’s
Timeline view to carry out special operations like insert
edits, and edits in which the audio leads or lags behind
the video. See “Advanced Timeline editing”, page 90.

Splitting a clip: The placement of the edit line in the
original clip determines the split point. When you
apply the razorblade tool, Studio duplicates the clip
and trims away the portion after the split point in the
first copy and up to the split point in the second.
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Delete Clip button —the trashcan

This button deletes the currently-selected content

in any of the Movie Window views. By default,
when video clips on the main video track of your
project are deleted in any view, the gap in your movie
that would otherwise be created by the deletion is
automatically closed up, and clips on other tracks are
removed or shortened as required to keep everything in
sync.

If you delete clips on other tracks, the default behavior
is that gaps between them are not automatically
removed, so the timing of other clips is not affected.

If you press the Ctrl key while clicking the delete
button, or pressing the Delete key, the default behavior
for the current track is reversed. That is, on the main
video track, Ctrl+Delete leaves a gap when the clip is
removed, while on the other tracks, the gap on the track
is closed up. In neither case are other tracks affected.

You can also access the delete operations through the
right-button context menu for clips on the Timeline.

Fagy  Spdicudl Fdy  Jpdlgudn

Delete Delete Delete Delete
Delete (leave gap) Chrl+Delete % Delete (close gap) Chrl+Delete [:k

mE el ok helne

The delete options on the right-button menu for
Timeline clips are not the same for clips on the main
video track (L) as for those on other tracks (R). The
menus summarize the context-dependent keyboard
shortcuts.
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Positioning: edit line, scrubbers

The current position is the frame showing in the Player
when you are working with a clip in the Movie
Window. In the Timeline view, it is indicated by the
edit line. The current position can be changed by
moving either the Timeline scrubber (to which the edit
line is attached) or the Player scrubber.

Timeline scrubber Trim scrubber Player scrubber
1 Camen fres T T S Llas N - )

Sl o e 351 T

When the Clip properties tool is open, a third
scrubber, the trim scrubber, is available for
adjusting the current position within the clip during
trimming.

“0 MoVIE WINDOW VIEWS

4

The Movie Window provides three different views of
your project: Timeline, Storyboard and Text. Select the
one you want to use by clicking the view selection
buttons in the upper right corner of the Movie Window.
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Storyboard view

Storyboard view shows the order of [gs= =
video scenes and transitions. It uses
thumbnail icons for quickly structuring a movie. You
can choose to work with large or small thumbnails with
the Show large storyboard thumbnails checkbox on the
Project preferences options panel.

Timeline view

Timeline view shows the positions gg= E|
and durations of clips relative to the
Timescale. This view also displays up to eight tracks
on which you can place various types of clip:

e Video, plus full-screen disc menus, titles s[=;
and graphics: The video track contains the
primary visual material in your production. See
Chapter 5: Video clips, Chapter 8: Still images and
Chapter 9: Disc menus for more information.

e Original (or “synchronous”) audio: The é?
original audio track contains the audio that
was captured along with the video from your camera.
You can manipulate the audio clips on this track to
achieve various effects using insert-editing and split-
editing techniques. See “Insert editing” (page 92)
and “Split editing” (page 94) for more information.
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Overlay video and audio: In Studio Plus, [
video and images placed on the overlay track

can be used with the Picture-in-picture and
Chroma key tools to give your video %
productions a professional appearance. These &
features are locked in other versions of Studio,
producing “watermarked” output when used. You
can upgrade to Studio Plus at any time if you need its
advanced capabilities. Original audio for overlay
video is stored on the linked audio track. See
Chapter 6: Two-track editing with Studio Plus for
details about the overlay track.

Title and graphic overlays: Images placed TS
on the title track will be rendered as overlays

upon the main video, with transparent backgrounds.
See Chapter 8: Still images and Chapter 9: Disc
menus for more information.

Sound effects and voice-overs: The audio |~
clips on this track are mixed with the original

audio track and the background music track to create
the final soundtrack for your movie. See Chapter 11:
Sound effects and music for full information.

Background music: The background music for 2
your movies can be created to any desired J
duration with the SmartSound tool (page 206) or
imported with the CD audio tool (page 205). Your
soundtrack can also make use of mp3 and other
music files (see page 201).

Disc menus, chapter marks and return-to- [Z
menu links: This is an extra track that appears
above the video track whenever the movie has at
least one disc menu. See Chapter 9: Disc menus for
information.
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Because many editing operations can be carried out
only in Timeline view, you should choose it whenever
extensive, detailed or advanced editing is required.

Track locking

The video track normally takes precedence over all
other tracks for trimming or deleting. This has several

consequences:

e When you trim a video clip, clips running
simultaneously on other tracks are also trimmed.

e When you delete a video clip, the time segment it
used is also removed from any parallel clips.

o Clips that fall entirely within a deleted video clip’s

span are also deleted.

These behaviors can be bypassed when necessary with
a feature that allows you to “lock” any track indepen-
dently of the others, thereby excluding it from editing

and playback operations.

The padlock buttons along the right
edge of the Movie Window, can be
clicked to toggle locking for the
corresponding track. Track-locking
gives Studio insert-edit and split-
edit capability (see Chapter 5:
Video clips).

Chapter 4: The Movie Window
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Track muting and hiding

The audio tracks can be individually = [= =
muted with the mute buttons at the o s

right edge of the Movie Window. e
These buttons have the same function *
as the mute buttons in the Volume and a

(1]
balance tool. (See page 218 for more [ saas A“E
information.)

The equivalent operation for video
tracks is effected with the hide
buttons, which can be wused to
temporarily omit a track’s video from
your project. This is especially handy
to see what’s really going on while
editing overlay video in Studio Plus.

Placement feedback

Studio gives you several types of feedback about your
actions as you place clips in the Timeline view.

The status line: The status line area on the left of the
Movie Window title bar displays messages as you place
clips and perform other actions.

Placement symbols: While you are dragging a clip
into position on the Timeline, Studio provides feedback
to tell you whether the current placement of the clip is
valid.

The mouse pointer shape and the colors of the vertical
placement lines indicate what you can and cannot do.
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For example, if you attempt to drag a sound onto the
video track, the placement guidelines turn from green
to red, the mouse pointer changes from “copy” to
“unavailable”, and the status line tells you, “Only
scenes, titles, photos, menus and transitions on video
track.”

Green placement lines with the “copy” pointer X mean
that an action is valid; red placement lines with the
“unavailable” pointer © show that it is not.

Status line explains problem with operation
= nt:-E y sotnis, litkes, pholas, minus and transtions en video Lrack ) m & W (B =
BECE ] o L [T
B e : =1l |
g ©
¢l — l i o

Red placement lines | L unavailable symbol
indicate invalid operation

Text view

The Movie Window Text view isa g2 = g‘
list showing the start and end times
of clips, as well as their duration.

In addition, custom names for clips are visible in this

VIEW.
B i Clown pany * b o m B B (=

Hame Treneeod slaet Movio dusbon  Movie sl |
1 Menu: "Family - Dirthday Party’ WOOAZE0 00000 4

Chapter | in Menu 1 0:00:12.00

2 Widen clip: "0¥ dema |.00]" LDO:BAZT D000
Audio clip: "0V deme [.00]" 0:00:04.27 oenizen

Wnve aadia: Bosnlesh U:DOBEBE 000000

‘EmanSound® sudio: sland Party [Party dowal' 0:00:51.18 0:00:12.00

Title everdy: ‘Family - Hapgy Birthday Sis* LSS B R EX ]

a Widen clip; "0V dema [28,0]" LEZIOE  GDRAZT BO0GET

Audio clip: "0V deme [28.02]" 0:e0:z8.02 0:00:04.27 0000627

Worve audia; "Applause’ EDETSIE  nnsnnon
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€ THE TOOLBOXES

The toolboxes provide a convenient point-and-click
interface for editing operations — adding clips to your
movie, modifying existing clips and applying special
effects. Studio provides separate toolboxes for video
and for audio operations.

The toolboxes are available only in Edit mode. They
are opened and closed with the buttons at the top left of
the Movie Window.

(@ u: Video toolbox open

'.G’ A Audio toolbox open

[ ot Both toolboxes closed

Select the toolbox you want to open by moving your
cursor over the icons. The individual buttons highlight,
indicating which toolbox will open when you click.
The Album is then replaced by the toolbox display,
which contains two main areas:

e Tool selector buttons in a panel on the left. Clicking
one of these opens the corresponding tool.

e The currently-selected tool on the right. Double-
clicking a clip in the Movie Window also displays
the corresponding tool (except for title clips, which
are opened directly in the Title Editor when you
double-click).

All the tool-selector buttons, except the top one in each
set, open specialized tools. The top button in both
toolboxes is the Clip properties tool. It displays a tool
appropriate for trimming and otherwise editing the type
of clip currently selected in the Movie Window.
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The Title Editor

One powerful tool that is not directly accessed through
the toolboxes is the Title Editor, in which you can
combine text, images and other graphic resources to
make titles and disc menus for your Studio productions.
Access the Title Editor through the Title and Disc menu
tools, or with the Go to Title/Menu Editor command
from the right-button context menu in the Movie
Window. See Chapter 10: The Title Editor for full
information.

]
The Video toolbox

The seven tools in this toolbox modify or create visual
clip types, including video clips, titles, still images and
disc menus.

‘ Clip properties

Titles

Disc menus
L5

Frame grabber

E ‘Smartl'-‘lo\rle

 Picture-in-picture
=) and Chroma-key

| Video effects
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Clip properties: The Clip properties tool
adjusts the start and end times of any type of

clip. This is called “trimming”. The tool also allows
you to type in a descriptive name for the clip. The tool
also presents additional interface components
appropriate to the type of clip being edited.

Titles: This tool lets you edit the name and | . ‘
length of titles. The Edit Title button provides
access to the Title Editor window where you can
change the text and appearance of the title.

Disc menus: The Disc menu tool has a number ‘
of controls for editing the links between the
buttons on a disc menu and entry points into your
movie called chapter marks, which are represented on
the menu track in the Movie Window. The Edit Menu
button opens the Title Editor, where you can modify
the visual appearance of a menu.

Frame grabber: This tool takes a snapshot of a | &
single frame from your movie or from your
current video source. You can use it in your movie, or
save it for use in other applications. As with Capture
mode itself, this tool presents a different interface if
your current capture source is DV than if you are using
a non-DV source.

SmartMovie: This tool automatically combines | <
your source footage with a digital song file to
create a music video in any of a variety of styles.

PIP and chroma key tool: This tool provides an |
alternative, graphical interface to the Studio Plus
Picture-in-picture and Chroma key effects.

Video effects: Studio provides numerous plug-in | g
video effects with this tool. Each video clip or

still image in your project can use effects, whether
alone or in combination.
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Along with its basic library of useful effects, Studio
provides some “locked” premium effects that you can
try out. For information about purchasing premium
content for Studio, see “Expanding Studio” on page 11.

]
The Audio toolbox

The six tools in this set operate on or create audio clips
— “original” audio, voice-overs, sound effects and other
audio files, CD tracks and SmartSound background
music.
Clip properties
ﬁ]é | Volume and balance
d ’£ Voice-overs
CD audio

@

| Background music
JI

| Audio effects

Clip properties: The Clip properties tool lets @
you adjust (“trim”) the start and end times of any

type of clip. You can also enter a descriptive name for
the clip to replace the default name if desired. (Clip
names are displayed when the Movie Window is in
Text view.) The tool’s other controls vary depending
on the type of clip.

Volume and balance: This tool gives you 2
master volume controls for each of the three :
audio tracks: original audio (audio captured with
video), sound effects and voice-overs and background
music. It also enables you to mute any or all of the
tracks, and to add real-time volume fades. Use the
balance and surround control to position each track
independently of the other two in a one-dimensional
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stereo or two-dimensional surround-sound space.
When the overlay track is open, the tool provides a
fourth set of controls, which affect the overlay audio
track.

Availability: Surround sound and overlay video are supported in
Studio Plus only.

Record voice-overs: To record a voice-over, £
simply click the Record button and begin
speaking into your microphone.

Add CD audio: Use this tool to add tracks, in ®
whole or in part, from an audio CD.

Background music: This tool lets you add | r
background music using SmartSound, Studio’s
powerful music generator. Choose a style, song, and
version. Studio will create a musical soundtrack that
matches the duration of your movie.

Audio effects: This tool lets you apply plug-in | g
effects to any audio clip. The popular VST
standard for audio plug-ins is supported, enabling you
to augment your library with add-on and third party
effects. A configurable noise reduction filter is supplied
as a standard effect. Effects available in Studio Plus
also include both graphic and parametric EQ, reverb,
chorus and others.

Some “watermarked” premium effects may also be
included for you to try out, with others available
through the Pinnacle web-site by clicking the More
effects... “category” in the audio effects browser. For
information about purchasing premium content for
Studio, see “Expanding Studio” on page 11.

Pinnacle Studio 10 Plus



CHAPTER 5:

Video clips

The cornerstone of most Studio video projects is the
Album section containing your captured video scenes.
To create your edited movie, you drag scenes from the
Album into the Movie Window, where they are treated
as editable video clips.

This chapter explains how to set the “in” and “out”
(start and end) points for each clip. The Movie
Window’s editing interface makes this “trimming”
process simple, rapid and precise. The methods covered
in this chapter for trimming video (“Trimming video
clips”, page 81) can for the most part also be applied to
the other types of clip (such as titles and sound effects)
that are covered in later chapters.

A later section of the chapter covers more advanced
editing techniques, including split edits and insert edits,
that you can use to give your movies a more
professional look. See “Advanced Timeline editing” on
page 90.

We’ll look at using visual effects in Studio, and at
some of the effects you can use in your movies — to
correct a flaw, to communicate an idea, or just for fun.
See “Video effects” on page 98.

And finally we’ll explore SmartMovie, Studio’s
automatic movie generator. SmartMovie intelligently
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combines a music soundtrack with your video footage
to create a beat-synchronized music video, or with a
series of still images to create a slideshow. Both modes
support a variety of style options.

¥ VIDEO CLIP BASICS

The first step in creating a movie is to introduce some
video scenes from the Album into the Movie Window,
where they become editable clips. At some point you
will probably also add some transitions, titles, audio
and other extras, but a set of video scenes is the starting
point for just about any project.

This section explains how to add scenes to your movie,
and how to work with scenes from multiple capture
files. It also covers some interface features that provide
useful feedback as you work.

Adding video clips to your movie

There are two ways to add a video clip to your movie:

Drag and drop: Drag a scene from the Video Scenes
section of the Album and drop it into the Movie
Window. This is normally the easiest and quickest way
to put together a rough cut of your movie. You can drag
multiple scenes simultaneously if you wish.
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The clipboard: The standard clipboard operations
(Cut, Copy and Paste) can be used with video clips in
the Movie Window. The Copy operation works on
Album scenes also.

When a scene or clip is pasted into the Movie Window,
it is inserted at the first clip boundary starting at the
edit line position. You can use the standard keyboard
shortcuts for clipboard operations (Ctrl+X for cut,
Ctrl+C for copy, Ctrl+V for paste), or select the desired
operation from the right-button menu.

When the Movie Window is in Timeline view, you can
drop a video scene or clip onto any of the following:

e The main video track. If the clip has associated
audio, it is added to the original audio track. This
video will serve as the background for any overlay
video or titles on the lower Timeline tracks.

e The overlay track. Video on this track is
superimposed on the contents of the video track. The
picture-in-picture and chroma key effects are used to
make a portion of the overlay frame transparent so
that some of the main video can be seen. Except in
Studio Plus, any clips on the overlay track are
displayed with a “watermark” graphic. If you decide
to use the overlay track in your movies, you can
upgrade to Studio Plus at any time.

e The title track. In Studio Plus, if the overlay track is
hidden, dropping a video clip on the title track causes
the overlay track to open and the clip to be placed
upon it. In other versions of Studio, or when the
overlay track is already displayed, the title track does
not accept video clips.

e The sound effects track or the background music
track. Attempting to drop a video clip on either of
these tracks actually drops the clip’s original audio.
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Working with multiple capture files

For some projects you may want to incorporate scenes
from multiple source tapes, or from different capture
files made from one tape. To achieve this, load in each
of the files in turn and drag whichever scenes you want
from each file into your movie.

To use multiple capture files:

1. Drag scenes from the first capture file into the
Movie Window.

2. Using the dropdown list or the folder button in the
Video Scenes section of the Album, open the
second capture file. Studio displays scenes from
only the current file in the Album.

See “Opening a captured video file” on page 40 for
detailed information on this step.

3. Drag scenes from the second captured file into the
Movie Window. Continue in this manner until you
have gone through all the files.

Because any given movie can be in only one of the
standard (4:3) format and the widescreen (16:9) format,
Studio does not let you mix frame formats in the Movie
Window.

By default, the first video clip you add to a movie
determines the movie’s frame format, and later clips
are modified as necessary to conform to it. See “The
project video format” below for further information.
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The project video format

The video scenes you add to a project need not all
originate with the same device or be in the same file
format. They need not even have the same frame size,
aspect ratio or frame rate.

When video is played back within Studio, however, a
common frame format must be used. The Project
format box on the Project preferences options panel
lets you specify the format for new projects either
explicitly (e.g. “NTSC Widescreen”) or implicitly,
from the format of the first clip you add to the project.

Project Format

(™ Set From First clip added to project
(% Use this Format For new projects:

NTSC Standard -

Current: 720 x 480, 29.97 frames/sec
4.3, interlaced

The current project format is displayed as a tooltip over
the project title in the Move Window.

B ] Rational aspects

e
I . VORITSC Standard )
720 x 480, 29,97 frames/sec

The project format applies to all video and image clips
in the Movie Window, and to the preview of those clips
in the Player. Visual content in the Album, such as your
captured video scenes, is shown by default in its
original format, whether or not that matches the project
format.

Chapter 5: Video clips 77



If you want to avoid black bars (“letterboxing”) in your
project video, but still want to use scenes shot in the
wrong aspect ratio, here are two other approaches:

e Use the Aspect ratio commands on the Alboum menu.
These let you stretch the Album scenes to conform to
the proportions of the project frame, at the cost of
some distortion. Please see “Video aspect ratios” on
page 42 for more information.

e Use the 2D Editor effect with keyframing to create a
“pan and scan” version your video. Studios often use
this technique to make their movies fit a standard
television screen when they are transferred to
videotape or DVD. There is no distortion with this
method, but some material is lost from each frame.
Careful tracking of the action with the aid of
keyframing generally allows you to obtain
acceptable results despite this problem.

Availability note: The 2D Editor effect and the keyframing feature
are provided in Studio Plus only.

Compensating for source video in the “wrong”
aspect ratio by adding black bars (L), stretching to
the full frame (C), and pan-and-scan (R). Each
method has its own drawbacks.

Background rendering

The project format is also used as the target format for
rendering, which is the process of generating video for
footage in which HFX transitions, effects or other
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computationally demanding features are used. Until
such video has been rendered, it may not display
smoothly and with full detail during preview.

Studio is able to carry out rendering behind the scenes
while you work. This feature is controlled from the
Background rendering box on the Video and audio
preferences options panel.

Background rendering

|v Enable background rendering

(" Set codec automatically

(% se this codec For backaround rendering:!

D best for output to DY Lape j

Current: DV

Following the dialog’s advice regarding the codec to
use for background rendering may help reduce the
rendering time when your final movie is output.

If you are planning to preview your video on an
external device (Studio Plus only), you may need to set
the project format and the background rendering codec
to match that device. For instance, if you are
previewing on an analog monitor plugged into your DV
camcorder, you should do your background rendering
in DV.

Interface features

Studio provides a variety of visual cues regarding the
video clips in the Movie Window:

e When a clip is added to the Movie Window, a green
checkmark appears on the Album’s icon for the
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corresponding scene. The checkmark remains as
long as any clip in the Movie Window belongs to
that scene.

To see the original location of a clip in your source
video, use the Find Scene in Album command on the
right-click menu for Movie Window clips. Studio
highlights the Album scene from which the selected
clip is drawn. To go the other way, use Album >
Find Scene in Project to show how a particular
Album scene is used in your current project.

When neighboring scenes from the Album are placed
in sequence in the Movie Window, the border
between the clips is displayed as a dotted line. This
is to help you keep track of your clips, and does not
affect how they can be manipulated in the Movie
Window.

In Timeline mode, any special effects you have
applied to a clip are indicated by small icons along
the bottom of the clip. These correspond to the effect
groups shown on the Video effects tool browser. You
can open the tool for parameter editing by double-
clicking any of the icons.

DD:IM.DD | D:DD:I'IB.DD D)

The star icon below this video clip shows that at least
one effect in the “Fun’ category has been applied.
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® TRIMMING VIDEO CLIPS

In general, captured video scenes contain more material
than you actually require for your movie. “Trimming”
— the process of adjusting the in and out points of a clip
to remove unwanted footage — is a fundamental editing
operation.

No data is lost by trimming: Studio sets new start and
end points for the clip in the Movie Window, but the
source of the clip — the original Album scene — remains
intact. This means you can always reset clips to their
original state, or select different trim points.

Studio offers two ways to trim any clip (video scenes,
transitions, titles, still images, audio clips and disc
menus):

e Directly on the Timeline (see “Trimming on the
Timeline using handles” below).

e Using the Clip properties tool (see “Trimming with
the Clip properties tool” on page 86).

A video clip can be trimmed to any desired in and out
points within the limits of the original scene.

Trimming on the Timeline using handles

The quickest way to trim is by dragging the edges of
clips directly on the Timeline. Watch the Player as you
trim, so you can find the frame on which you want to
begin or end.
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Let’s first consider the simplest trimming case, in a
movie with only one clip. Then we’ll turn to the more
usual situation of trimming a single clip that is
surrounded by other clips.

To trim a single clip on the Timeline:

1.

Delete all but one clip from the Timeline. If the
Timeline is empty, drag a scene in from the Album.

Expand the Timescale to make fine adjustments
easier.

Position the mouse pointer anywhere on the
Timeline except directly over the edit line. The
pointer becomes a clock symbol. Click-drag it to
the right to expand the Timescale.

This illustration shows maximum expansion, where
each tick mark represents a single frame:

wman s  cmma amma

Position your mouse pointer over the right edge of
the clip. The pointer becomes a left-pointing arrow.

T OmpAE womm [T 1]

m |

Click-drag to the left while keeping an eye on the
Player, which updates continuously to show the last
frame in the trimmed clip.

As you shorten the clip, the arrow cursor becomes
two-directional, indicating that the clip edge can be
dragged both left and right. You can reduce the clip
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to as little as a single frame, or increase it up to the
end of the source scene.
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5. Release the mouse button. The clip is now trimmed.

Multiple clips

The secret to trimming a clip when multiple clips are
on the Timeline is that you must first select the clip to
be trimmed by clicking on it with the mouse.

To trim with multiple clips on the Timeline:

1. Set up the Timeline with two short clips.

2. Adjust the Timescale until the clip you want to
adjust is a convenient size for editing.

3. Click the second clip. The video track should now
look something like this:

You can trim the right-hand edge of the clip just as
in the single-clip example above. As you do so, the
last frame of the clip is displayed in the Player. As
long as the second clip remains selected, you can
continue to trim more video by dragging the edge to
the left, or restore some of the trimmed video by
dragging the edge to the right.
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4. With the second clip still selected, move your
mouse pointer over the left edge of clip until the

-

As you drag, the first frame of the clip is displayed
in the Player. As long as the clip remains selected,
you can continue to trim more video by dragging
the edge to the right, or restore some of the trimmed
video by dragging the edge to the left.

6. Release the mouse button. The clip you trimmed
snaps back against the right edge of the first clip.

mEm

Gaps and fills: Trimming with the Ctrl key

As we have seen in the example above, when you
shorten a clip on the video track, the clip and any clips
to the right of it move leftwards as necessary so that no
gap is left. At the same time, clips on other tracks are
shortened to keep the whole Timeline in sync. When
you trim a clip on any other track, however, gaps are
not automatically closed up, and no other track is
affected.
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This default trimming behavior simplifies editing under
most circumstances, but Studio also gives you a way to
invert the behavior when needed. If you press the Ctrl
key before you begin trimming a clip on the video
track, neither that clip nor any other will be
repositioned, and gaps are not closed up. There is no
effect on other tracks.

Meanwhile, using Ctrl when trimming clips on other
tracks again inverts the normal behavior. The clips on
the track will close in to fill any gap left by the trim.
Clips on tracks besides the one being trimmed are again
unaffected.

Note: See page 61 for a description of the parallel
behavior of Ctrl when deleting clips.

Clip-trimming tips

If you are having difficulty manipulating the edges of
clips during trimming, try the following:

e Verify that the clip you wish to trim is selected, and
that it is the only one selected.

o Expand the Timescale until it is easier to make fine
adjustments.

e Avoid expanding the Timescale too far, which makes
clips appear very long. If that happens, undo until the
scale is the way you want it; or reduce the scale by
dragging it towards the left; or select an appropriate
value from the Timescale’s context menu.

Chapter 5: Video clips 85



86

Trimming with the Clip properties tool

Although it is possible to trim video clips

directly on the Timeline with full frame
accuracy, rapid, precise trimming is often easier to
achieve with the Clip properties tool. To access this
tool, select the clip you want to change, then use the
Toolbox » Modify Clip Properties menu command, or
click one of the toolbox buttons at the top left of the
Movie Window. (Clicking the same button a second
time will close the tool.)

In the case of video clips — in fact, any clips other than
titles — you can also open and close the Clip properties
tool by double-clicking the clip in any Movie Window
view.

The Clip properties tool can be used to modify any
kind of clip. It offers an appropriate set of controls for
each type.

The Name text field: For a video clip, most of the clip
property controls are for trimming. The only exception
is the Name text field, which lets you assign a custom
name to the clip to replace the default one assigned by
Studio.

The Name field is provided on the Clip properties tool
for all clip types. Clip names are used by the Movie
Window’s Text view, and can also be viewed as fly-by
labels when your mouse moves over clips in the
Storyboard view.

Preview areas: Separate preview areas show the in and
out frames of the trimmed clip, together with a counter
and jog buttons. The layout of each preview area is
similar to that of the Player during normal editing.
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Setting playback position: A scrubber control across
the bottom of the tool lets you set the playback position
anywhere within the clip. You can also set the playback
position using the counter and jog buttons located
between the two preview areas.

Using the counters: The positions reported by all three
counters are relative to the beginning of the clip, which
is position 0:00:00.0. As with the counter on the Player,
you can adjust the counters in the Clip properties tool
by clicking in one of the four fields (hours, minutes,
seconds, frames) to select it, then using the jog buttons.
When none of the fields is explicitly selected, the jog
buttons apply to the frames field.

Transport controls: While the Clip properties tool is
in use, the transport controls in the center area
substitute for those that normally appear on the Player.
These special transport controls include a Loop
play/Pause button @ that can be used to cycle
repeatedly through the trimmed portion of the clip
while the trim points are being adjusted.

Setting the trim points: The left bracket [ button

beside the counter in the left preview area, and the right
bracket 3 button beside the counter in the right
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preview area, set their respective trim points to the
current position.

You can also adjust either trim point by:

e Entering a value directly into its counter
e Adjusting a counter field with the jog buttons
e Dragging the corresponding trim caliper

The Duration text field: This field shows the length of
the trimmed clip in hours, minutes, seconds and frames.
If you modify the value, either by editing the numbers
directly or by clicking the associated jog buttons, the
effect is to change the out point of the clip. Of course,
you cannot reduce the duration to less than a frame, or
increase it beyond the limits of the original video scene.

Usage tip: If you want to switch from trimming one
clip on the video track to trimming another, just click
on the new clip while the Clip properties tool remains
open, or drag the Timeline scrubber to the new clip.

Resetting trimmed clips

If you change your mind about a particular trim
operation (or group of operations) after previewing,
either use the Undo button (or Ctrl+Z) or manually
reset the trimmed clip using one of these methods:

e Drag the clip’s right edge directly on the Timeline
until it stretches no further,

 In the Clip properties tool, drag the trim calipers to
the ends of the clip.
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© SPLITTING AND COMBINING CLIPS

If you want to insert one clip on the video track into the
middle of another clip, split the latter into two parts
then insert the new item. “Splitting” a clip actually
results in it being duplicated. Both clips are then
automatically trimmed so that the first ends at the split
point and the second begins there.

To split a clip in Timeline view:

1. Choose the split point.

You may use any method that adjusts the current
position, such as moving the Timeline scrubber,
clicking Play and then Pause, or editing the counter
value in the Player.

2. Either right-click within the clip you wish to split
and select Split Clip from the pop-up menu; or,
make certain the edit line is positioned where you
wish to split the clip, and click the Split clip/scene
(razorblade) button (see page 60).

The clip is split at the current position.

To restore a split clip:

e Use the Undo button (or press Ctrl+Z). Even if you
have performed other actions since you split the clip,
the multilevel undo allows you to step back as far as
needed. Or,

e If undoing is not desirable because of intervening
actions that you don’t want to discard, you can
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replace both halves of the split clip with the original
from the Album. Or,

e Delete one half of the split clip, and trim out the
other.

To combine clips in the Movie Window:

Select the clips you wish to combine, then right-click
and choose Combine Clips.

The operation is allowed only if the combination of
clips will also be a valid clip — that is, a continuous
excerpt of the source video. On the Timeline, clips that
can be combined meet along a dotted edge.

& ADVANCED TIMELINE EDITING

Note: The additional advanced features of Studio Plus, making use
of the overlay track, are covered in Chapter 6: Two-track editing with
Studio Plus.

During most editing operations, Studio automatically
keeps the clips on the various Timeline tracks
synchronized. For instance, when you insert a scene
from the Album onto the video track, the relative
positions of all clips to the right of the insertion remain
unchanged.

Sometimes, though, you might like to override the
default synchronization. You might want to insert a
new video clip into your project without displacing any
clips of other types. Or you might want to edit video
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separately from its accompanying original audio — a
technique with several variations, discussed below.

Such special edits are possible using the track lock
buttons along the right edge of the Movie Window in
Timeline view. Each of the standard tracks (all except
the menu track) provides a lock button. See “Track
locking” on page 65 for more on track locking.

A locked track is grayed out in the Timeline view,
indicating that the clips on the locked track cannot be
selected or edited in any of the three views; nor are
they affected by editing operations on unlocked tracks.

Apart from the menu track, any combination of tracks
can be locked.

Locking the title track, for example prevents the
duration of a title from being changed even when you
trim clips on the main video track at the same time
index.

When the title track is unlocked, trimming the main
video clip above it automatically trims the title.
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Insert editing

In ordinary Timeline editing, a video clip and the
original audio that was captured with it are treated as a
unit. Their special relationship is symbolized in the
Movie Window by the line connecting the video track
indicator with the original audio track indicator,
showing that the latter is dependent on the former.

The track lock buttons make it possible to deal with the
two tracks independently for operations like insert
editing, which typically means replacing part of a clip
on the video track while the original audio track
continues uninterrupted.

Note: Under Studio Plus, insert editing may also be carried out on
the overlay video and audio tracks, using analogous methods to
those described here.

For instance, in a sequence that shows someone
recounting a story, you might wish to insert a shot of an
audience  member smiling (or sleeping!) without
breaking away from the main audio.

To perform an insert edit on the video track:

1. In the Timeline view of the Movie Window, click
the original audio track’s padlock button to lock
the track.

E The lock button is highlighted in red, and
.2 the track itself is grayed to show that its

contents will not be affected by editing
operations.

2. Clear space on the video track for the video clip you
want to insert. Position the Timeline scrubber at the
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point you want the insertion to start and use the
Split clip/scene button. Now move to the point
where the insertion should end and again split the
clip. Finally, delete the portion of video that will be
replaced by the insertion.

Because the audio track is still intact, having been
locked, the video to the right of the insertion point
does not move leftwards to fill the gap you have
made in the Timeline, for the video and audio
would then no longer be synchronized. If you were
to preview your video now, you would see a black
screen as the gap portion played back, but the
soundtrack would be normal.

3. Now all that remains is to place the clip you want to
insert. Drag the clip (whether from the Album or
elsewhere on the Timeline) into the hole in the
video track that you’ve just opened up.

If the inserted clip is too long for the space you
created it is automatically trimmed to fit the space.
You can adjust the trimming with the Clip
properties tool.
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Insert editing on the original audio track

The converse insert-editing operation, in which a sound
clip is inserted into the original audio track over
unbroken video, is needed less often but is also readily
performed in Studio.

The procedure is analogous to the one for inserting
video: simply reverse the roles of the two tracks at
every step.

Split editing

In “split editing”, a clip’s audio and video are
separately trimmed so that the transition to one occurs
before the transition to the other.

Note: Under Studio Plus, split editing may also be carried out on the
overlay video and audio tracks, using analogous methods to those
described here.

In an “L-cut”, the video precedes its sync audio; in a
“J-cut”, the audio comes first.

Tip: For faster, more precise trimming, you may find it
helpful to have the Clip properties tool open when
following the procedures in this section. To open the
tool, just double-click one of the video clips before you
begin.

Pinnacle Studio 10 Plus



The L-cut

In an L-cut, the cut to new video comes before the cut
in the audio.

Imagine a videotaped lecture in which the video
periodically cuts away from the speaker to show travel
or nature scenes illustrating the lecture topic.

oo I‘IZ.DU . U.DD.I‘I .00 D.DU.IZU.DD
T

Audio and video cut simultaneously.

Instead of cutting the audio and the video
simultaneously, you might decide to let the speaker’s
voice overlap into the following scene. This makes it
clear to the audience that the new scene they are now
watching illustrates whatever explanation the speaker
has been providing.

Notice that the video and audio clip boundaries in the
completed cut form an L-shape.

0:00:12.00 . 0 DD:I‘I E.00 i D:DD:IZU.DU i
1

Audio cuts after video. The resulting ““L”” shape is
outlined in this illustration.
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There are many effective uses of this technique. It can
be considered whenever the second clip’s video serves
to illustrate the first clip’s audio.

To perform an L-cut:
1. Adjust the Timeline so you can easily count off the
number of frames or seconds you want to overlap.

2. Select the left-hand clip and trim its right edge to
the point where you want the audio to end.

n U:UEI:I'IZ.EIEI . , ' EIEIEI:JE.EIU "
I

, U:UU:‘EU.UEI n

3. Lock the audio track. Now drag the right-hand edge
of the same clip’s video leftward to the point where
the following clip’s video should start.

) U:UD:I‘I2.DD ) , . DDD:JB.DU " n " D:DD:?D.UD .

4. With the audio track still locked, drag the second

clip’s video to the left until it meets the original
clip.
If there isn’t enough excess video at the start of the
second clip to make this trim possible, you will first
need to trim off a sufficient amount from both its
video and audio then try again.
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5. Unlock the audio track.

The video now cuts away to the second clip ahead
of the audio. Video has been trimmed from the end
of the first clip, and audio has been trimmed from
the start of the second clip.

The J-cut

In the J-cut, the new audio cuts in before the video
switches. This can be effective when the second clip’s
audio prepares the viewer for the material in the scene.

Returning to the videotaped lecture example, let’s say
we are now going to switch back to the speaker at the
end of the interpolated footage. If we let the next part
of the lecture appear on the soundtrack a few moments
before the video shows us the podium again, the change
will be much less abrupt.

This time the clip boundaries outline the letter J:

DDDJZDD . DDDI‘IEDD ) 0:00:20.00

Audio cuts before video. The resulting “J” shape is
outlined in this illustration.
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To perform a J-cut:

1.

Adjust the Timeline so you can easily count off the
number of frames or seconds you want to overlap.
As before, trim back the right edge of the left-hand
clip, both video and audio, by the overlap interval.
Lock the audio track. Now drag the right-hand edge

of the same clip’s video back to the right by the
overlap interval.

Unlock the audio track.

The audio now cuts away to the second clip ahead
of the video.

Note: The procedures described above for performing
the L-cut and the J-cut are not the only possibilities.
With the J-cut, for example, another method would be
to trim the right-hand clip to the desired start point of
the video then, with the video track locked, drag the
audio portion leftwards to overlap the audio of the left-
hand clip.

® USING VIDEO EFFECTS

Most video editing consists of selecting, ordering and
trimming video clips, of connecting clips with
transition effects and combining them with other
materials such as music and still images.

Sometimes, though, you also need to modify the video
images themselves, manipulating them in some way to
achieve some desired effect. Studio’s Video effects tool
provides an extensive set of plug-in video effects that
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can be applied either to video or still images. See page
109 for descriptions of the basic set of effects supplied
with Studio.

The Video effects tool is the seventh tool in the ‘@
Video toolbox. It has two main areas: at the left,

an effects list showing which effects are already
attached to the currently-selected clip(s), and at the
right, a parameters panel where you can tune the effect

as required.

__

o | [ Video Effects (7 Lans Flam Prosess:| ast ] |
| = [

%' I Flam Direction 60 85 letien -

3 o] o

6| | clow |
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- | |

I sy kames .' Reset__| ||

Video effects vs. audio effects

In most respects, the Video effects tool and the Audio
effects tool work identically, except for the type of
material they apply to.

Working with the effects list

Each video or image clip in your project can be
modified by one or more video effects. Each effect is
applied to the original image in turn, in the order in
which they are listed on the Video effects tool.

=n Video Effects

B =5 Auto Color Correction
||:| ‘* Water Drop
B (&7 Soften
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The checkboxes next to each effect name allow you to
enable and disable effects individually without having
to remove them from the list (which would cause any
customized parameter settings to be lost). In the above
illustration, the “Speed” effect has been disabled while
the other two effects on the list remain in force.

Adding and deleting effects

To add an effect to the list for the e ————
current clip, click the Add new effect

button, which opens an effects browser on the right-
hand side of the tool window.

Click an item in the browser’s Category list to display
the names of the individual effects in that category.
Select the effect you want, then click the OK button to
add the effect.

To remove the currently-selected effect from i
the list, click the delete effect (trashcan) button.

Add Video Effect
( Category [ Effact
[Standard RTF -~ \@ HFX Filter 2
Studio Plus RTFX @2 Blur
Free with Registration EP Emboss
RTFX Wolume 1 EP 0ld Film
RTFX Volume 2 @2 gofen
MewBlue Art Effects P Stained Glass
MewBlue Effects (@) Chroma Keyer
NeswBlue Time Effects (9] Luma Keyer
BWFLUGING (D) Picture-in-Picture
BNPLUGINS 2 *ﬁ 2D Editar
BWPLUGING 3 & EarthCuake
Bravo Studio Pack 1 ¢ Lens Flare
Bravo Studio Pack 2 b :ﬁ Magnify [
1] — { Cancel

The Video Effects browser is open here to the Studio
Plus RTFX page, which contains an additional set of
effects for Studio Plus. Other packs contain other
premium effects for separate purchase. The last
‘category’, More Effects, opens a page on Pinnacle’s
web-site where more premium effects are available.
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Premium video and audio effects, like other locked
content in Studio, can be used freely, but cause a
“watermark” graphic to be added to the video when
played back. If you want to use the effect in an actual
production, you can purchase an activation key without
leaving Studio. For information about purchasing
locked video and audio effects, and other premium
content for Studio, see “Expanding Studio” on page 11.

Changing the order of effects

The cumulative result of using more than one [,
effect on the same clip can vary depending on %}
the order in which the effects are applied. With

the up and down arrow buttons to the right of the
effects list, you can control the position of each effect
in the processing chain. The buttons apply to the
currently-selected effect.

Changing effect parameters

When an effect is selected in the effects list, the
parameters panel on the right-hand side of the Video
effects tool window provides controls for adjusting the
effect’s parameters, if any.

6 ‘Water Drop Presets | Big Drop x
Drop Position
Harizantal f L) 0
‘ertical f 1} 0
Waves
Wave Count |4 |
Wave Width _n 10
Wave Height f L} 20
Refraction F L) 30.00
m -
Use keyframes { Reset )
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The controls for the basic library of effects supplied
with Studio are described below (beginning on page
111). Add-on effects are described in their own on-line
documentation, which you can access from the
parameters panel by pressing function key F1 or

clicking the help button (z at the top left of the
parameters panel.

Note: Some plug-in effects may provide their own
parameter windows with specialized controls. In those
cases, the parameters panel on the effects tool displays
a single Edit button, which accesses the external editor.

Using parameter presets

In order to simplify the use of parameters, many effects
offer presets that let you configure an effect for a
particular use simply by selecting a name from a list.

In Studio Plus, there are two kinds of preset: static,
which store a single set of effect parameters, and
keyframed, which store multiple sets of parameters in
the form of keyframes (see below).

[ 2 ‘Water Drop Presets: | Small Drop hd
Static Presets
Drop Position Big Drop
i f EomallDrmp
Horizantal ] Infinite VWaves %
“ertical f ] CormerWaves
Wiild Drop

In versions of Studio that do not support keyframing
only static presets are available.

[ 2 “Water Drop Presets: | Small Drop hd
Static Presets
Drop Position Big Drop
i f ESmall Drap
Horizantal ] Infinite VWaves R§
“ertical f ] CormerWwaves
Wiild Drop
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Often, the quickest way to configure an effect is to start
with the preset that comes closest to what you want,
then fine-tune the parameters by hand.

Resetting effects: A special type of
preset is the factory default setting of
each effect. The default can be restored at any time by
clicking the Reset button at the bottom of the
parameters panel.

Reset J

If Reset is clicked when keyframing is in use, the
default parameter values are assigned only to the
keyframe at the current movie position. That keyframe
is created if it did not already exist.

Keyframing

The parameters for Studio video effects are ordinarily
applied at the first frame of the video clip and continue
unchanged to its end. This is the standard behavior for
each effect you add to the clip.

(2 Pan And Znom Preseg
(1) 2) |
Toom f [ A 70.00 70.00 70.00

Horizantal Position f L] -10.00
Wertical Position f n 40.00

Ordinarily, an effect’s parameter values do not vary
throughout the video clip the effect belongs to.

Keyframing — the ability to change parameter values
smoothly within a video clip — opens a wide range of
new possibilities for using effects in your movies.

Availability note: The keyframing feature described here is provided
in Studio Plus only.
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Each keyframe stores a full set of parameter values for
the effect, and specifies at which frame within the clip
those values should be fully applied.

(2) Pan And Zoom Pres{i\ fi\ /g\
Zoom f ]‘\.4’70 00
Horizon tal Position f " -10.00
ertical Position f L) 40.00

With keyframing, new sets of parameter values can
be applied as often as desired throughout the clip.

Between keyframes, numeric parameter values are
automatically adjusted from frame to frame to connect
the keyframe values smoothly.

0 H
A graphical view of the keyframes in the example
above. The values of Zoom (Z), Horizontal Position
(H) and Vertical Position (V) are set by keyframe 1
at the start of the clip, by keyframe 2 about a third of

the way in, and by keyframe 3 at the end. The values
change smoothly over intermediate frames.

Most effects support keyframing. A few do not, either
because they have no parameters or because, as with
the Speed effect, keyframing doesn’t readily apply.

Keyframing scenarios

For each applied effect, a clip may theoretically have as
many keyframes as it has frames. In practice, you
usually need only a few.
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Two keyframes are enough to smoothly vary parameter
values from one setting to another throughout the clip.

100
Z
50
v
0
H

Keyframing gives you sensitive control over the way
the effect is applied to the clip. It becomes a simple
matter to ease an effect in and out, for example.

L2 @@
With a set of four keyframes you can ease in one or

more parameter values at the start of a clip and ease
them out again at the end.

100
z

50
Vv

D @3 @

A pan-and-zoom slideshow like that described in
under “Editing image clip properties” (page 154)
can be created using the Pan-and-Zoom effect on a
single still-image clip. Two keyframes with identical
parameters define the start and end of each view —
however many are required — within the show.
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Using keyframing

In the parameters window for any effect that supports
keyframing, locate and check the Use keyframes box.
Until you do this, the effect maintains a single set of
parameter values throughout the clip.

6 Fan And Zoom Presets: hd
Zoom f L) 10.00
Harizontal Position F L} -5.00
“ertical Position F L} 0.00

[ Use keyitames Reset )

When you switch on keyframing for an effect, two
keyframes are created automatically. One is anchored
to the start of the clip, and the other to its end. The
parameters for both are set to the non-keyframed value.
On the Movie Window timeline, a keyframe appears as
a numbered flag on the video clip. The keyframe flags
are displayed as long as the effect’s parameter window
remains open.

IDD.DD ; . D:DD:ID4.,F‘”

Keyframes for the effect currently open in the effect
parameters window are shown as numbered flags
over a vertical line. The current keyframe, if any, has
a highlighted flag, like that of keyframe 3 here.

Pinnacle Studio 10 Plus



At the same time, additional controls are displayed at
the bottom of the parameters window: the Add and
Delete buttons, the Current keyframe indicator with
forward and back arrows, and the Keyframe time
counter with jog arrows.

W Use keyframes Reset )

New controls appear at the bottom of the parameters
window when keyframes are enabled.

The Current keyframe indicator shows the 43 »
number of the keyframe attached to the

frame you are viewing in the Movie Window. Use the
arrows to advance from keyframe to keyframe. As you
click, the Movie Window scrubber jumps to the next
keyframe position.

When you are viewing frames of your movie for which
no keyframe has been defined, the indicator shows a
dash. The displayed parameter values are those that
will apply to the current frame during playback.

To create a keyframe at any such point, click the Add
button, or simply start to adjust the parameters: when
you do, Studio adds a keyframe automatically.

add ) Delete 4[— |» [0:00:03 00

v Use keyframes ( Resat )

Keyframes are numbered in sequence from the start of
the clip. When a new keyframe is inserted, or an old
one is deleted, those that come after are renumbered to
correct the sequence.

-~

Add { Delete ) 44 b [0:00:03.00 2

% Use keyframes Reset M
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The Delete button is available whenever the current
frame has a keyframe; that is, whenever the Current
keyframe indicator shows a number rather than a dash.

The Keyframe time counter shows the time offset
within the clip of the current movie time — the frame
showing in the Player. The first keyframe is therefore at
time zero, and the last is at an offset equal to one frame
less than the duration of the clip.

When the current frame has a keyframe, its time offset
can be changed with the counter’s jog arrows. The
positions of the first and last keyframes cannot be
adjusted. Others can move freely between the current
positions of their neighboring keyframes.

Add ( _Deete. ) 4[3 | [0:00:02.16 eL\\s
W Use keyirames '( Reset J

Setting the time of keyframe 3.

Previewing and rendering

While you are working with the Video effects tool,
choosing effects and adjusting parameter settings, the
Player gives a dynamically-updated preview of the
current frame in your movie. Previewing a single frame
may not be very revealing when you are working with
effects that evolve over the duration of the clip (like the
Water drop effect, page 118).In those cases, you will
need to play back the clip to see the full impact of the
effect you are applying.

Because many effects require intensive calculation, a
fully smooth and detailed preview of the full clip won’t
be instantaneously available in most cases. Each time
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effects are added or removed, or settings are changed,
Studio commences “rendering” the clip — recalculating
its final appearance — in the background without
interrupting your workflow. A colored bar appears in
the Timescale above the clip while background
rendering is in progress.

Background rendering is optional. You can disable it, if
required, in the Project preferences options panel
(Setup » Project Preferences).

”0 VIDEO EFFECTS LIBRARY

4

The plug-in video effects installed with Studio are
divided into six categories, each symbolized by an
icon:

e Cleaning effects help correct defects in the &y
source video, such as noise and camera shake.

e Time effects, like Speed in Studio Plus, change &
the tempo of playback without affecting the
appearance of the video frames themselves.

o Style effects like Emboss and Old film let you &2
apply distinctive visual styles for added impact.

e Overlay effects support the overlay features of (o
Studio Plus, such as Picture-in-picture and Chroma
key.

e Fun effects like Water drop and Lens flare &
provide extra scope for creativity and fun in your
movies.

e Color effects let you modify the coloration of a ©»
clip, whether subtly or dramatically.
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Plug-in effects are organized into packs of one or more
effects each. In this manual, we cover the five effects in
the Standard RTFX pack (see page 111), which is
included with all versions of Studio. Further on, we
briefly describe each of the more than 20 additional
effects in the Plus RTFX pack (page 114), which is
included with Studio Plus.Full documentation of the
parameters for the Plus effects is included in their
context-sensitive on-line help, which can be viewed by
clicking the help button (@ at the top left of the
parameters panel for each effect, or by pressing the F1
key when the panel is open.

Building your effects library

Studio’s plug-in architecture means that you can
continue to add new effects to your video effects
library as they become available. Expansion packs of
effects from Pinnacle and other vendors will integrate
seamlessly with the program.

Some expansion effects are shipped with Studio as
locked, premium content. These include Pinnacle’s
RTFX Volume 1 and 2 packs. Such effects can be
previewed in Studio as usual, but are “watermarked”
with a special graphic during playback.

Purchasing an activation key will remove the
watermark. This can be done without leaving Studio.
For more information about obtaining premium content
for Studio, see “Expanding Studio” on page 11.

Warning: Studio’s plug-in video effects are computer
programs. They are theoretically capable of actions
with the potential to damage or disrupt your system,
such as modifying or deleting files and editing the
system registry. Pinnacle advises against installing
third-party plug-ins except those from trusted vendors.
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€ STANDARD EFFECTS

This section describes four of the five effects included
in the Standard RTFX group at the top the Studio
effects browser. The fifth, Pan and zoom, is covered
under “The pan-and-zoom effect interface” on page
160.

Auto color correction, Noise reduction and Stabilize are
classified as cleaning effects, which help correct
defects in the source video, such as noise and camera
shake.

Note: Studio’s video cleaning effects are general-
purpose filters designed to reduce the most common
problems found on a wide range of material. They are
not a panacea. Your results will vary depending on the
original material and the severity and nature of the
problems.

Auto color correction

This effect compensates for incorrect color balance in
your video. The idea is similar to the “white balance”
setting on a camcorder.

Brightness: Color correction may affect the brightness
of the image. You can apply a manual correction, if
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needed, with this slider. (Technically, the control
modifies the “contrast gamma” of the image rather than
its actual brightness.)

Note: The Auto color correction effect may introduce
video noise into the clip as a side-effect of processing.
If this happens to a troublesome degree, add on the
Noise reduction effect described below.

Noise reduction

This plug-in applies a noise-reduction algorithm that
may improve the appearance of noisy video. In order to
minimize artifacts (image defects caused as a side-
effect of image processing), noise reduction is only
performed in areas of the frame where the amount of
motion falls beneath a certain threshold value.

Motion threshold: This slider governs the threshold
value. Moving the slider rightwards increases the
amount of motion the effect will tolerate, thus tending
to increase the proportion of the image that will be
affected. At the same time, the danger of introducing
unacceptable artifacts into the video is also increased.

Stabilize

Like the electronic image stabilization feature in many
digital camcorders, this effect minimizes any jerkiness
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or jitter caused by camera movement. The edge areas of
the image are discarded, and the central portion is
magnified by about 20% to fill the frame.

By adjusting the boundaries of the selected region on a

frame-by-frame basis, Studio is able to compensate for
the unwanted camera motion.

IR A i

Studio’s Stabilize effect works by expanding a
selected area (inner lines) to full-frame size. The
area is adjusted from frame to frame to compensate
for slight aiming differences caused by camera
shake.

I——————
Speed

This sophisticated effect allows you to set the speed of
any video clip over a continuous range from 10 to 500
percent of normal, in either forward or reverse motion.
The length of the clip changes as you vary its speed.

If the clip contains audio, that too is sped up or slowed
down. The option of maintaining the original pitch lets
you avoid the sudden introduction of cartoon voices
into your soundtrack.
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€ PLUS EFFECTS

The Studio Plus RTFX pack of video effects is
included with Studio Plus. Users of other Studio
versions can obtain them by upgrading to Studio Plus.

This section gives a brief description of each effect in
the group, except:

e Two of the Overlay effects are covered elsewhere
(Chroma key on page 137, and Picture-in-picture on
page 132).

e The HFX Filter effect, which allows you to create
and edit animated 3D transitions with Pinnacle’s
Hollywood FX software, opens externally to &
Studio, and provides its own on-line help. HFX
Filter uses a special Pinnacle category icon.

The effects appear here in the same order as they do in
the effects browser, where they are sorted by category
(see page 109). Full descriptions, including all
parameters, are available in the context-sensitive help
when the effect parameters window is open.

Blur

Adding blur to your video produces a result similar to
shooting out of focus. Studio’s Blur effect allows you
to add separate intensities of horizontal and vertical
blurring over the whole frame or any rectangular region
within it. You can easily blur out only a selected
portion of the image, such as a person’s face, an effect
familiar from TV news coverage.
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Emboss

This specialized effect simulates the look of an
embossed or bas-relief sculpture. The strength of the
effect is controlled by the Amount slider.

ed by adjusting contrast
and brightness with the Color Correction effect (right).

Old film

Old movies have a number of traits that are usually
considered undesirable: grainy images caused by early
photographic development processes, spots and streaks
from dust and lint adhering to the film, and intermittent
vertical lines where the film has been scratched.

The OId film effect lets you simulate these defects to
lend your pristine video the appearance of movies that
have suffered the ravages of time.
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The Soften effect applies a gentle blurring to your
video. This can be helpful for anything from adding a
romantic haze to minimizing wrinkles. A slider controls
the strength of the effect.

Stained glass

This effect simulates the appearance of viewing the
video through a pane of irregular polygons arranged
into a mosaic.

Sliders let you control the average dimensions of the
polygonal “tiles” in the image and the width of the dark
edging between neighboring tiles from zero (no edging)
to the maximum value.

"
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Three variations of the Stained Glass effect
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Luma key

This overlay effect works very similarly to Chroma
Key (page 137), but in this case the transparent areas of
the foreground image are defined by luminance rather
than color information.
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2D Editor

Use this effect to enlarge the image and set which
portion of it will be displayed, or to shrink the image
and optionally add a border and shadow.

Earthquake

The Studio Plus Earthquake effect jiggles the video
frame to simulate a seismic event, whose severity you
control with sliders for speed and intensity.

Lens flare

This effect simulates the flaring seen when direct bright
light overexposes an area of a film or video image.

You can set the orientation, size and type of the main
light. The first option of those shown below lets you
remove the light, though its secondary effects — rays
and reflections — are still generated.

The eight Type options.

B
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Magnify

This effect lets you apply a virtual magnifying lens to a
selected portion of the video frame. You can position
the lens in three dimensions, moving it horizontally and
vertically within the frame, and nearer to or further

from the image.

Motion blur

This effect simulates the blurring that results when a
camera is moved rapidly during exposure. Both the
angle and the amount of blurring can be set.

Unblurred image (L) and horizontally (C) and
diagonally (R) blurred versions.

Water drop

This effect simulates the impact of a drop falling onto
the surface of water, producing expanding, concentric
ripples.
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Water wave

This effect adds distortion to simulate a series of ocean
waves passing across the video frame as the clip
progresses. Parameters allow you to adjust the number,
spacing, direction and depth of the waves.

Black and white

This effect subtracts some or all of the color
information from the source video, with results ranging
from partly desaturated (the *“Faded” preset) to fully
monochrome (“Black and white”). The Amount slider
controls the strength of the effect.

Color correction

The four sliders in the parameters panel for this effect
control the coloration of the current clip in terms of:

Brightness: The intensity of light
Contrast: The range of light and dark values
Hue: The location of light on the spectrum

Saturation: The quantity of pure color, from gray to
fully saturated
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Invert

Despite its name, the Invert effect doesn’t turn the
display upside-down. Rather than the image itself, it is
the color values in the image that are inverted: each
pixel is redrawn in its complementary light intensity
and/or color, producing a readily recognizable but
recolored image.

This effect uses the YCrCb color model, which has one
channel for luminance (brightness information) and two
for chrominance (color information). The YCrCb
model is often used in digital video applications.

Lighting

The Lighting tool enables correction and enhancement
of existing video shot with poor or insufficient lighting.
It is particularly suitable for fixing backlit outdoor
sequences where the subject’s features are in shadow.

Posterize

This Studio Plus effect lets you control the number of
colors used to render each frame of the clip, all the way
from the full original palette down to two colors (black
and white) as you drag the Amount slider from left to
right. Regions of similar color are coalesced into larger
flat areas as the palette shrinks.
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RGB color balance

RGB Color Balance in Studio Plus serves a dual role.
On the one hand, you can use it to correct video that
suffers from unwanted coloration. On the other, you
can apply a color bias to achieve a particular effect. For
example, night scenes can often be heightened by
adding blue and reducing brightness. You can even
make video shot in daylight look like a night scene.

Sepia

This Studio Plus effect imparts the appearance of
antique photography to the clip by rendering it in sepia
tones rather than full color. The strength of the effect is
controlled with the Amount slider.

White balance

Most video cameras have a “white balance” option for
automatically adjusting their color response to ambient
lighting conditions. If this option is switched off or not
fully effective, the video image coloration will suffer.

Studio’s White balance effect corrects the problem by
allowing you to specify which color should be taken as
“white” in this image. The adjustment needed to make
that reference color white is then applied to every pixel
of the image. If the reference white is well chosen, this
can make the coloration seem more natural.
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¢ THE SMARTMOVIE MUSIC VIDEO TOOL

Creating a music video seems like a big job, even with
the convenient editing features of Studio. Dozens of
brief clips must be carefully aligned to the beat of the
soundtrack, in order that the music and video are
properly coordinated.

With Studio’s SmartMovie tool, however, you ‘
can construct a dynamic, beat-synchronized

music video almost instantly, in your choice of styles
and using any combination of video footage and music.

You can make slideshows, too. SmartMovie can create
an instant slideshow from any set of still images, in a
choice of styles and with synchronized music.

In order to create a music video The SmartMOVie tOOI Walks
iii'fome music to the music you through the creation
o process with simple step-by-
step instructions. To begin,
use the Album to locate the
video scenes or still images
you want to include, and drag them onto the Movie
Window.

Click here to add music to your
project.

Tip: The Timeline view of the Movie Window is
recommended when working with audio clips.

With the visuals in place, add a SmartSound, CD audio
or digital music (wav, mp3) clip to the background
music track. The duration of this clip — and not the
amount of visual material you supply — determines the
length of your music video.
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SmartMovie styles

Select a style from the dropdown list at the top of the
SmartMovie tool window. A variety of styles is offered
for both music video and slideshow projects.

e —

8 Mutic Videa Sayla

| Relalme Yohums

An amusing style that will fum
e virien ano o ssbent-Sien-ps
comedy ghot.

—"—'—“n"'-
3

hdethow  Sving

e - Elegark
e thow - Documentsey H —_—
fedeskon - Montnge:
Shdeshon - Nostaipa
= lidethow - Dreamy

A brief description of each style is displayed in the
status balloon as you scroll through the style list.

For video styles, you will get the best results if the

starting duration of your video footage is about double

the length of the soundtrack. Each of the slideshow

styles has its own ideal ratio between the

For 13 slides, this style works number of pictures and the length of the
Soct with < L he“"ee”J song. The status balloon provides
Vs guidance for getting the proportions

right.

SmartMovie options

The Use clips in random order option lets you mix up
the wvisual material without regard to its initial
sequence. This option is the default with some styles. It
tends to give a finished product with a relatively
uniform texture, but sacrifices narrative continuity.

|Music widen - Fast Paced j

* Usge clips in random order
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The Relative volume slider adjusts the prominence of
the background music track relative to the other audio
tracks. Move the slider all the way to the right if you
want to hear only the music track in the finished video.

Relative Volume

Ul

The last configuration step is to enter the text to use for
the opening and closing titles. Each text line consists of
two edit fields. Use Tab and Shift+Tab to jump
between the left and right fields.

Opening Title

Tim escapes

Clasing Credits

Director Luc de Gruyére ~
Producer haxine Thrax
Created with Finnacle Stoudio

The big moment...

Finally, click the Create SmartMovie button and sit
back while Studio generates your movie.

Create Smarthovie

Using SmartMovie from Capture mode

Studio lets you jump directly from capturing your
video right into the SmartMovie tool. To use this
option, simply initiate your capture as usual, then check
the applicable box on the Start Capture dialog.

v Create "SmartMovie" automatically after capture
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CHAPTER 6.

Two-track editing
with Studio Plus

Studio Plus brings the power of multitrack video
editing to Studio with the addition of an auxiliary video
track on the Movie Window Timeline called the
overlay track. Now you can use advanced picture-in-
picture and chroma-key effects while retaining the
convenience of Studio’s streamlined and intuitive user
interface.

|
Introducing the overlay track

Upon installation, the Timeline displays the five tracks
familiar to long-time Studio users: the video track with
its original audio track, and the title, sound effect and
music tracks.

To open the new overlay track, drag a video clip from
the Album © into the Movie Window and drop it on
the title track ®. The overlay track instantly appears
with the clip properly positioned upon it ©.
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Drop video on the title track to open the overlay track.

Along with the overlay track, Studio adds an overlay
audio track to accommodate the video clip’s original
audio information.

Once the overlay video and audio tracks have been
opened, Studio no longer accepts video clips on the title
track. Drag clips from the Album directly onto either
the video or overlay track as required.

Video clips on the video and overlay tracks.

Displaying and hiding the overlay track

As we have just seen, the overlay video and audio
tracks are displayed when you add your first overlay
clip. Similarly, when you remove the last clip from
these tracks, Studio again hides them from view.

This default behavior help keep the Movie Window
uncluttered, but if you are making frequent use of
overlay video, you might prefer to have the track
visible at all times. This can be achieved by activating
the Always show overlay track command on the pop-up
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“context” menu that appears when you click on the
Movie Window with your right mouse button.

v Clip Properties
30 ko Title/Menu Editar
Always show overlay brack. .

Pl L

00|
A/B editing

The second video track in Studio Plus often simplifies
the editing tasks — insert edits, L-cuts and J-cuts —
discussed under “Advanced Timeline editing” on page
90.

An insert edit, for instance, becomes a trivial operation:
simply drag the clip to be inserted onto the overlay
track, and trim it as desired. (See “The Picture-in-
picture tool” below if you want the second video to
appear at reduced size so that only part of the main
video is obscured.)

& off My Movie 14 %
pooo . | 0000400 ‘ . 0000300

An insert edit on the overlay track. The main video is
obscured while the B clip is playing.

In the J-cut and the L-cut, the audio portion of a clip
begins a little before (J) or a little after (L) the video.
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They are often used together to soften the start and end
of an inserted clip.

B ollE My Movie 14

Split editing on the overlay track. The overlay video
track has been locked, allowing the B clip’s audio to
be trimmed. The main audio can be reduced or
muted as needed.

The Picture-in-picture tool

128

Picture-in-picture (often abbreviated to “PIP”) — the
inclusion of an additional video frame within the main
video — is a versatile effect familiar from its use in
professional TV productions.

Picture-in-picture with optional border, shadow and
rounded corners (left). Split-screen effects, like the
vertical split at right, are among the variations that
show off the versatility of the PIP tool.
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To use picture-in-picture, start in the usual way by
dragging some video clips onto the Movie Window
Timeline. Drop the clips you want for background
video onto the video track. Put the foreground clip — the
PIP clip — on the overlay track under the main clip.

Note: If you are planning a split-screen effect, like the
one shown at right in the illustration above, it doesn’t
matter which of the two clips goes on which track.

Now select the foreground clip and open the
Picture-in-picture and Chroma key (PIP/CK)

tool, the sixth in the Movie Window’s video toolbox.
We usually refer to the two aspects of the tool separ-
ately as the Picture-in-picture and Chroma key tools.

( T Pioumingicun | Chuma by
o] Presets:
® Scale T Coop ]
T Border Shadow
& Calor Calor eCe
m m* cfic
w s
Lo - Wty Duslance
&8 =] Cj =l ] Cj
& = T o
I O} al I =l
- Selness
.‘";‘.“ Tranaparency | ~ Enabié picture-n picture
' | *Reunded comers Apply to new clis

The Picture-in-picture and Chroma key (PIP/CK)
tool is really two tools in one. Because they are used
independently, we treat them as separate tools. This
illustration shows the PIP side of the tool. Click the
Chroma Key tab at the top of the tool to switch.

Picture-in-picture tool controls

Most of the left-hand side of the PIP tool is taken up
with an interactive layout area where you can both
view and modify the dimensions, placement and
cropping of the overlay video. The adjustments you
make are reflected in the Player preview as you work.
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The layout area has two modes, selected by the Scale
and Crop radio buttons.

Scale mode: The gray, checked region in the layout
area represents the transparent portion of the overlay
frame, through which any underlying video can be
seen. In typical PIP usage, this accounts for most of the
screen, the overlay being sized small enough that the
main video is not unnecessarily obscured. You can
modify the PIP frame in three ways:

e Click on the PIP frame and drag it within the layout
area to reposition it within the main video frame.

e Use the center control points on the edges of the PIP
frame to change its dimensions arbitrarily.

e Use the control points at the corners of the PIP frame
to change its size but not its proportions (“aspect
ratio”).

Crop mode: In this mode the layout area represents the
entire overlay frame, regardless of its actual dimensions
as set in Scale mode. The rectangle defined by the
control points shows which portion of the frame is
visible. Outside the visible area, the frame is semi-
transparent, letting the checked pattern show through.

As in Scale mode, the side control points allow for free
adjustment of the crop rectangle, whereas the corner
control points preserve its aspect ratio.

® Scale © Crap © Scale ® Crop

The PIP tool in Scale (L) and Crop (R) modes.
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Presets: Choose a preset name to set up all the PIP
controls at once to the predetermined values associated
with that name. You can choose a preset as a first
approximation to your desired settings, then adjust
them manually until you get exactly what you want.

Transparency: Use this slider if you want the
underlying video to show through the overlay itself.
Moving the slider to the right makes the overlay, with
its border and shadow, increasingly transparent.

Border: These controls set the |- Boser
color, width and transparency of the "%
border that will be drawn around
the overlay frame. Set the widthto = =7 &
zero (slider all the way to the left) if  Tansparency
’ )| >
you don’t want a border at all. See
page 140 for informationon howto @ & o &

use the color controls. ROt Comers

The Softness slider controls the

amount of blurring on the outside edge of the border.
Move the slider left for a hard edge, or right to blend
the border with the background video. Check the
Rounded corners box if you want to round off the
corners of the PIP rectangle.

Shadow: These controls set the - Shadow -
color, width, angle and trans- g% ¢
parency of the drop shadow effect =~ ©c€
that gives the illusion of the overlay = = »)
frame  floating above  the  Tansparency
background video. Set the width -~
(using the Distance slider) to zero if

you don’t want a shadow to appear.

The dial-shaped shadow-angle control gives you eight
choices for the placement of the shadow relative to the
frame.
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Enable picture-in-picture: This checkbox allows you
to turn the PIP effect on and off.

Apply to new clips: This option is handy when you
want to set up the same PIP settings for a number of
different clips. As long the option is checked, PIP will
automatically be applied to each new clip that you drag
onto the overlay track, using the same settings that
were displayed the last time the tool was open.

The PIP effect interface

If you prefer to enter your PIP parameter settings
numerically rather than graphically, you can turn to an
alternative interface provided by the Video effects tool.
You can also combine the two methods, using the PIP
tool’s graphical interface to specify the initial settings,
then fine tuning them with the numerical effect
parameters.

The available parameter settings of the Picture-in-
picture effect are almost identical to those offered by
the PIP tool:

(2 Picture-in-Picture Presets: ad
Position

Horizontal f L] 13

“ertical f L] 11
Size

Width ; L] 67

Height L] &7 J
Cropping

Top L 2

Bottom . [ =]
[ Use keylrames - Reset

Parameter settings for the Picture-in-picture effect.

Position: The Horizontal and Vertical sliders set the
offset of the center of the PIP frame from the center of
the background frame.
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Size: The Width and Height sliders set the size of the
PIP frame as a percentage of its original dimensions.
Cropping, if used, can further reduce the final size of
the PIP frame on the screen.

Cropping: The four sliders in this group trim away a
percentage of the original PIP video frame, allowing
you to remove unnecessary portions of the image and
focus on the main subject.

Video: The Transparency slider lets the background
video show through the PIP overlay to any desired
degree.

Border: The parameters in this group are equivalent to
the Border settings on the PIP tool, allowing you to set
the overlay border’s color, thickness, transparency and
edge softness, and to select the rounded corners option
if desired. One bonus of the effect interface is that there
are separate Width and Height controls to control the
border thickness, rather than the single setting provided
by the tool.

Shadow: As with the Border group, these parameters
are essentially the same as those on the PIP tool, except
that the Horizontal offset and Vertical offset parameters
afford slightly more flexibility in positioning the
shadow than do the tool’s Distance and Angle settings.

|
The Chroma key tool

Chroma key is a widely-used technique that allows
foreground objects to appear in a video scene even
though they were not present — and often could not
have been present — when the scene was shot. When an
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action star tumbles into a volcano, or battles a giant
cockroach, or saves the crew with a daring space-walk,
the chances are that chroma key or a related technology
was involved in the scene.

Chroma key effects are often called “blue-screen” or
“green-screen” effects because the foreground action is
shot in front of a uniform blue or green background.
The background is then electronically removed, leaving
only the foreground action to be superimposed on the
actual background of the final scene, which has been
separately prepared.

Creatlng a scene Wlth chroma key A clip on the
video track (L) is chosen as the background for a
green-screen clip on the overlay track (C). Chroma
keying removes the green to complete the scene (R).

Blue and green are the generally-preferred colors for
chroma key use because their removal from an image
will not affect human skin tones, but in principle any
hue can be used with Studio’s chroma key tool.

J Fu uriins g Luri: Chrams kay

Hoy channdl
wa rance

Minimeen Satusation
]

Setness =
ET] I
9N| Suppressan

a_@m&au&

mo Transparancy " Enabils chroms keying

Apply 10 mew clips

The chroma key side of the PIP/CK tool.
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As with picture-in-picture, the first step in using
chroma key is to drag some video clips onto the
Timeline. Drop the clips you want for background
video onto the video track. The foreground clip, which
should have a uniform, highly-saturated background
like the center clip in the illustration above, goes on the
overlay track below the main clip.

With the clips in place, select the foreground clip | g
and open the Picture-in-picture and Chroma key
(PIP/CK) tool. It is the sixth tool in the Movie
Window’s video toolbox. Select the Chroma key tab to
display the controls you will need.

Chroma-key tool controls

The chroma key tool constructs a “mask”, shown in the
Key channel graphic on the left side of the tool, where
the transparent part of the frame is drawn in black, and
the opaque part — the part you will see in the final video
— is drawn in white. Most of the remaining controls are
used to define exactly which areas of the frame will be
included in the transparent part of the mask by setting
the “key color” and related properties.

Transparency: Use this slider if you want the
underlying video to show through the normally opaque
overlay. Moving the slider to the right makes the
overlay, with its border and shadow, increasingly
transparent.

Presets: The tool provides two presets, called “Green
screen key” and “Blue screen key”. These provide good
starting points for setting up the tool if you are using
one of the standard chroma key colors.

Key color: Use the color swatch or eye dropper buttons
to select the color that will be removed from the video
frame leaving only the desired foreground. See page
140 for information on how to use the color controls.
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Rather than an actual color, you are really selecting
only a hue, without regard to the other properties —
saturation and intensity — that in combination with hue
make a complete color specification. The chosen hue is
shown by the position of the highlighted region on the
circumference of the color circle display.

The color circle on the Chroma key tool highlights a
range of hues (around the circumference) and color
saturation values (along the radius). Any pixel in the
overlay frame whose hue and saturation fall within
the highlighted region will be treated as transparent.

Color tolerance: This slider controls the width of the
range of hues that will be recognized as belonging to
the “key color”. Moving the slider to the right increases
the angle of the arc covered by the highlighted region
on the color circle.

Saturation minimum: Saturation is the amount of hue
in a color. A pixel with zero saturation (corresponding
to the center of the color circle) has no hue: it falls on
the “gray scale”, whose extremes are white and black.
Chroma key works most effectively when the
background is highly and uniformly saturated, allowing
a high setting of this slider. In the real world, vagaries
of lighting and apparatus often result in a background
that falls short of the ideal. Moving the slider left
allows a wider range of saturation values to be
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matched, indicated by a highlighted region that extends
farther towards the center of the color circle.

Softness: This slider controls the density of the
underlying video. When it is positioned all the way to
the left, the main video is entirely black. As you move
the slider to the right, the main video is brought up to
full density.

Spill suppression: Adjusting this slider may help
suppress video noise or fringing along the edges of the
foreground object.

Enable chroma keying: This checkbox allows you to
turn the chroma key effect on and off.

Apply to new clips: This option is handy when you
want to set up the same chroma key settings for a
number of different clips. As long as the option is
checked, chroma key will automatically be applied to
each new clip that you drag onto the overlay track,
using the same settings that were displayed the last
time the tool was open.

The chroma key effect interface

If you prefer to enter your chroma key parameter
settings numerically rather than graphically, you can
turn to an alternative interface provided by the Video
effects tool. You can also combine the two methods,
using the chroma key tool’s graphical interface to
specify the initial settings, then fine tuning them with
the numerical effect parameters.

The Studio Plus Chroma key plug-in provides
parameter settings almost identical to those offered by
the chroma key tool, but provides one more option,
Invert Key. When this option is activated, the normally
opaque parts of the key are treated as transparent, and
the transparent parts as opaque, so that the underlying
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video shows through everywhere except for the area
masked by the colored screen.

" Chroma Keyer Presgets: I—LJ
Key Caolor || &
Caolor Tolerance f J £3.00
Saturation Minimum '] 0.00
Softness f J 79.00
Transparency '] 0.00
Spill Suppression f ] 59.00
Invert Key L
Show Keay L

Parameter settings for the Chroma key effect.

The chroma key tool provides a special view of the
transparency key it has generated. To get this view in
the Player while working with the effect parameters,
click the Show Key checkbox.

[ ]
l Show Kay ~
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Using Show Key: At left thlehkey, at right the real thi‘ng

Chroma key tips

No matter how good your software may be, successful
use of chroma key depends on carefully setting up your
shot, and may require experimentation to get the details
just right. Here are some tips to get you started:

Light the backdrop as evenly as possible: Very often,
background coloring that looks flat to the naked eye
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will prove on playback to have areas that are too dark
or too washed out to work well for chroma keying,
which favors even, saturated color. Use multiple lights
on the backdrop to ensure that it is well-lit across its
whole area and without hotspots. Diffuse sunlight, as
produced by a light overcast sky, can work well when
shooting out of doors is an option.

Note: A professional background cloth for chroma key
work is available as an inexpensive purchase at the
Pinnacle web-site.

Don’t let the subject shadow the screen: Arrange
your subject and foreground lighting so that no
shadows fall upon the backdrop. The subject should be
at least a meter (three feet) in front of the backdrop.

| BLUE OR GREEN BACKDROP |

Subject's
Minimum shadow

3ft/1m doesn't
l reach
————— backdrop
£,

Setting up a chroma key shot. The backdrop is well
and evenly lit, and positioned well behind the subject
so that shadows do not interfere. The lighting of the
subject should be arranged to suit the background
that will be keyed into the shot.

Choose foreground colors carefully: Don’t have your
subject wear green if you are shooting on a green
screen, or blue for a blue screen; those areas will be
removed if they are taken to match the key color. You
have to be especially careful about this when working
with less even backdrops that require you to set a wider
color tolerance in the chroma keyer.
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Make a smooth profile: Chroma keyers do better with
a smooth edge than a jagged or complex one, so try to
have your subject present a smooth profile to the
camera. Hair is particularly tricky, and should be
slicked down if possible. If the subject can wear a hat,
so much the better.

Use tight framing: The wider your frame, the larger
your background needs to be, and the more difficult it
is to control your shot. One way to keep things simple
is to shoot your subject from the waist up rather than in
full view.

Selecting colors

] & To select colors in tools and effects that

provide a color parameter, click either on the
color swatch (left) or the eye dropper button. The first
opens a standard color picker dialog; the second lets
you choose a color by clicking anywhere on the screen.
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Two ways to set colors: The Windows color picker
dialog (L) opens when you click the color swatch
button provided in some tools and effects. Click the
eye-dropper button to select a color from the Player
preview window or elsewhere using a mouse pointer
in the form of an eye-dropper (R).
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CHAPTER 7:

Transitions

A transition is an animated effect that eases — or
emphasizes — the passage from one clip to the next.
Fades, wipes and dissolves are common types of
transition. Others are more exotic, and may even
involve sophisticated 3-D graphics.

Transitions are stored in their own section of the
Album (see “The Transitions section” on page 51). To
use a transition, drag it from the Album into the Movie
Window and drop it beside any video clip or still
image.

A series of transitions (the icons between the video
clips) in Storyboard view.

In Timeline view, you can drop the transition on either
the main video track, the overlay track, or the title
track. On the video track, the transition provides a
bridge between two full-screen clips (or between one
clip and blackness if the transition has only one
neighbor, as at the beginning of the movie). On the
overlay and title tracks, the transition bridges two
neighboring clips (or one clip and transparency).
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0.0s 0.5s 1.0s 1.5s 2.0s
L r
Diagram: Five snapshots from the life of a 2-second
diagonal wipe transition.

If a transition is to last for two seconds (the default
transition duration in a fresh Studio installation), the
second clip begins to run two seconds before the first
clip is finished. At the outset, only the first clip is
visible; by the end, the second clip has completely
replaced the first. The details of what happens in
between, as the first clip is gradually removed and the
second gradually appears, depend on the transition
type. Since the video clips overlap, the total duration of
the pair of clips is reduced by the duration of the
transition.

0.0s

Here is the same transition as above, this time using
actual video. For clarity, the transition boundary in
the three center frames has been emphasized in
white. Both clips keep running during the transition.

Transition types and their uses

Like all effects, transitions should be used not for their
own sake but to serve the overall needs of your movie.
Well-chosen transitions can subtly reinforce the
meaning of the movie and how it plays without
drawing attention to themselves. Observing the way
transitions are used in professionally-produced video
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on television will suggest many ways to improve your
own movies. Generally, it is advisable to refrain from
overusing transitions that cause abrupt changes or
otherwise draw attention to themselves: there’s a big
difference between a subtle dissolve and a heart-shaped
wipe.

The basic transitions discussed below - fades,
dissolves, wipes, slides and pushes — are all among the
first group of standard transitions (the “2D transitions”)
in the Album.

A set of more elaborate transitions is found in the
Alpha Magic group, which is the second entry in the
dropdown list of transition groups in the Album.

The many other groups on the list all belong to the
Hollywood FX, a large set of complex transitions
featuring three-dimensional graphics. The Hollywood
FX transitions are discussed at the end of this section
(page 144).

Cut: A cut is the minimal transition — an instantaneous
shift from one scene to the next. In Studio, it is the
default transition. A cut is appropriate when there is a
strong inherent connection between one clip and the
next; for instance, when the camera changes position or
angle within a scene.

Fade: This transition fades into the beginning of ‘i/
a video clip from a black screen, or from the end

of a clip to a black screen. A fade dropped between two
clips creates a fade down followed by a fade up. The
fade transition is the first transition icon in the Album.

A fade is usually used at the beginning and end of a
movie, or when there is a large break in continuity, as
when a new section begins. For example, a movie of a
play might benefit from inserting a fade between acts.
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Dissolve: A dissolve is similar to a fade, except ‘Z/
that the new scene begins to fade up even while

the old one is fading down. The visual overlap this
produces is less dramatic than a fade, but less abrupt
than a cut. A short dissolve can take the edge off a cut,
while a long dissolve is useful to suggest the passage of
time.

Wipe, slide and push: In each of

these standard transition types, the ‘E“H‘ﬂ/
incoming video is gradually revealed behind an edge
that moves across the frame in a certain direction. The
Album icons shown with this paragraph represent a

leftward wipe, a down-and-left slide and a rightward
push respectively.

In a wipe transition, both the old and new video occupy
their normal position in the frame throughout the
transition. The new video comes into view as the
transition edge crosses the frame, rather like new
wallpaper being rolled on over old.

A slide is similar to a wipe, but in this case the frame of
the new video slides across the screen until it reaches
its home position. The effect is reminiscent of a blind
being pulled down over a window.

A push is similar to a slide, except that the old video is
pushed out of the frame as the new video enters, like
advancing a filmstrip from one frame to the next.

Hollywood FX for Studio

Pinnacle Systems’ Hollywood FX includes a
large number of dramatic 3-D transitions and
effects. These are ideal for opening sequences, sports
and action footage, or music videos. Hollywood FX
satisfies professional expectations for quality without
sacrificing ease of use.

u.xl
"%
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A basic set of fully-functional Hollywood FX is
included with Studio, along with “watermarked” demo
versions of many others. Apart from the watermark (a
special graphic superimposed on part of the video), the
demo effects can be previewed normally within Studio.
If you like the demo versions, you can purchase them
in the same way as other premium content in Studio.
For more information, see “Expanding Studio” on page
11.

Also available for purchase on-line is the HFX Creator
editing tool for Hollywood FX. This software lets you
customize your Hollywood FX, or create new ones
from scratch. HFX Creator includes advanced
keyframe editing for flight paths and all parameters,
powerful warp plug-ins, and a 3D text generator. You
can also create a wide range of 3D
8. Multiwindow Effects using external video
/] sources, and add real-life 3D objects and

~ Roverss lighting.

To initiate the purchase of HFX Creator,

powws  click the Edit button in the Clip properties
w9 ool for any Hollywood FX transition.

Previewing transitions in your movie

Studio lets you preview transitions in the Player. Just
drag and drop a transition into the Movie Window,
click the Play button (or hit [Space]) and see how the
transition works with your material.

You can also preview transitions by scrubbing through
them in the Player or on the Timeline of the Movie
Window.
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Background rendering of Hollywood FX

Background rendering is an optional feature in which
the computation needed to create a detailed preview of
Hollywood FX transitions and other effects is carried
out as a “background task” with no interruption of your
workflow. You can configure background rendering on
the Video and audio preferences options panel (Setup
» Video and Audio Preferences). See “Video and audio
preferences” on page 253 for details.

Until the rendering of a transition is complete, the
Player will preview it at reduced resolution and frame
rate. A colored bar appears in the Timescale above the
clip while background rendering is in progress.

Audio transitions

Video clips in the Movie Window normally have
synchronous audio. In the absence of a transition, both
video and audio cut from one clip to the next. When a
transition is placed between two clips, the audio cross-
fades (the audio equivalent of a dissolve).

The only exception to this rule is the Fade transition,
which takes the audio completely out then back in
again.

Normal transitions cause a cross-fade in

W I3 the audio (left). In a Fade transition
(right), the audio fades down then up

along with the video.
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The Ripple Transition command

This Studio feature is especially useful for creating a
quick slideshow from a set of still images, or a video
pictorial from a set of short clips. Such a presentation is
more interesting if you connect each pair of clips with a
transition. Ripple Transition gives you a quick and easy
way of achieving that.

Begin with a set of a clips on the Timeline, then add a
transition of the desired type between the first two
clips.

0:00: ;II] on " 0 I]D"ZEI on , I]'I]IJ"BD on .

Now select all the clips except the first, click on any of
them with the right mouse-button, and select Ripple
Transition from the pop-up menu.

0:00: ;II] on " 0 I]D"ZEI on | I]'I]IJ"BD on '

v Clip Properties
Go o TitlefMenu Editar
Always show overlay track

Play Spacebar
Delete Delete
Delete (leave gap) ChriDelete |

it Chrbet
| f Copy ke

Eind Scene in Album

Rippls Transition [%
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Studio inserts a duplicate of the original transition
between each pair of selected clips.

0:00: ;II] on " 0 I]D"ZEI on , I]'I]IJ"BD on '

“‘ TRIMMING TRANSITIONS

¢

Although transitions are not true clips, they are handled
very similarly to clips within Studio’s editing
environment. Like clips, you can trim transitions either
directly on the Movie Window Timeline, or by using
the Clip properties tool.

See “Trimming on the Timeline using handles” on page
81 for a discussion of the first method. The maximum
allowed duration of a transition is one frame less than
the shorter of the neighboring clips.

Trimming with the Clip properties tool

The Toolbox » Modify Clip Properties menu D
command invokes the Clip properties tool for the
selected clip. For all transition types, this tool provides
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previewing controls, and the ability to set two
properties:

e To set the duration of the transition, change the value
in the Duration counter. A transition’s duration must
always be less — if only by a single frame — than the
shorter of its neighboring clips.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
The Name field is provided on the Clip properties
tool for all clip types. Clip names are used by the
Movie Window’s List view, and can also be viewed
as fly-by labels when your mouse hovers over clips
in the Storyboard view.

Many transition effects also support a “reverse
direction” option, which causes the transition animation
to run backwards, allowing a rotary wipe, for example,
to be either clockwise or counterclockwise. The
Reverse checkbox is enabled when the current
transition supports this option.

If you have purchased the HFX Creator application,
you can open it within Studio by clicking the Edit
button on the Clip properties tool for Hollywood FX
transitions. HFX Creator is an external editing program
with many options, whose use is described in its
accompanying documentation.

Previewing in the Clip properties tool

The Clip properties tool provides previewing controls
for transitions similar to those for video clips. See
“Trimming with the Clip properties tool” on page 86
for more information.

The preview areas show the last full frame of the
outgoing clip and the first full frame of the incoming
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one. The preview frames update as you edit the
Duration field.

The transport controls let you preview the transition
effect in the Player either frame by frame or at full
speed. The Loop play/Pause button € cycles through
the transition repeatedly at normal playback speed.

Both the counter (with its associated jog buttons) and
the scrubber give you direct access to any desired point
within the transition.

Name field Duration field

M S v .
Click to reverse

m—E"d frame

R ————————J)
[e——

Start L
frame

f [ 38

Trim scrubberJ Transport controls “-End frame preview
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CHAPTER 8:

Still images

Video usually means images in motion, but most
productions also include stationary titles or graphics,
and may include other types of still image as well. The
still images you can use in your movies include:

e All types of text captions and graphics, including
scrolling credits and “crawled” messages.

e Photos or drawings stored in disk-based image files.

o Individual video frames obtained with the Frame
grabber tool.

e “Disc menus” for DVD and VCD authoring. These
are covered in Chapter 9: Disc menus.

Any of these still image types can be treated in either of
two ways, depending on which track you drop them
onto in the Movie Window Timeline:

e To add a full-screen image with a solid background,
add the image to the video track.

e To add an image so that it appears in your movie
with a transparent background, superimposed over
the clips on the video track, place it on the title track.
The color of the top-left pixel of the image will be
treated as transparent when the image is placed on
this track. For best results, you may need to prepare
the image in an image-editing application.
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Note: Studio Plus users have an additional option, the
overlay track, for adding their images to the Timeline.
See Chapter 6: Two-track editing with Studio Plus, for
details.

The Album has separate sections for titles, bitmapped
images and disc menus. All these resources are stored
as separate files on your hard drive. You can also create
titles and disc menus of your own in Studio’s Title
Editor and add them directly to your movie without
first saving them as separate files (see Chapter 10: The
Title Editor). Similarly, still video frames can be added
directly from the Frame grabber tool (see “The Frame
Grabber” on page 161).

Full-screen images

A full-screen image is one that is placed on the video
track. It fills the entire screen, replacing the video.
When the preceding video clip ends, Studio plays the
still image clip. The visual effect is that the video ends,
and is replaced by the graphic until the next clip begins.

Overlay images

An overlay image is one that is placed on the title track.
It is superimposed on the current video clip, without
replacing the video.
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Controlling transparency in overlay images

Viewed in the Album, or in a graphics editor, an
overlay image appears to have a solid background.
When you place it on the title track, however, the
background disappears, allowing the video to show
through.

Studio uses the color of the top-left pixel of the image
to determine which areas will be transparent. Pixels
that match this color are not drawn when the image is
rendered over video.

This scheme works well for still images that have
consistent solid background colors. Sometimes, you
may have to edit the top-left pixel of a bitmapped
image to get the transparency effect you want. Any
image-editing program — even the Windows Paint
accessory — will do the job.

The automatic transparency feature applies to images
that are imported into Studio via the Title Editor as
well as those that are accessed through the Album.

Making a slideshow

If you would like to assemble a quick slideshow of still
images or video clips, you may want to take advantage
of Studio’s Ripple Transition feature to quickly insert a
chosen transition between each pair of clips or images.
See page 147 for details.

Applying effects

Most of Studio’s plug-in video effects can be applied to
still images. (The exceptions are effects like Speed that
only make sense for moving video.) See “Using video
effects” on page 98 for detailed information.
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® EDITING STILL IMAGES

As with other types of clip, you can trim still images
directly on the Movie Window Timeline, or by using
the Clip properties tool.

See “Trimming on the Timeline using handles” on page
81 for a discussion of the first method. The difference
with a still image clip is that you can extend it to any
duration you choose, whereas a video clip can be no
longer than the original Album scene.

Effects like Blur, Posterize and Color correction can be
applied to still image clips of all types in the same way
as to video clips. See “Video effects — the basic set” on
page 109.

Editing image clip properties

The Toolbox » Modify Clip Properties menu @
command opens a version of the Clip properties

tool appropriate for the type of the currently-selected
clip. The topmost tool icon in the video toolbox can
also be used.

With bitmapped images, including ordinary photos and
image files, and with disc menus, double-click the clip
for a third way to access the tool. Double-clicking a
title, however, opens it directly into the Title Editor
instead.
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All versions of the Clip properties tool allow you to set
the duration and name of the current clip, as follows:

e To set the length of time the still image is displayed,
change the value in the Duration counter.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
Clip names are used by the Movie Window’s Text
view, and can also be viewed on the fly-by labels
that appear when your mouse hovers over clips in the
Storyboard view.

The Clip properties tool for disc menus is described in
Chapter 9: Disc menus. See Chapter 10: The Title
Editor for details about editing the properties of titles.

Editing photos and graphics

The Clip properties tool for editing bitmapped images
allows you to perform several important image-
processing tasks:

e Zoom in on your pictures and photos in order to crop
away unneeded material and focus on only the
essential part of the image;

¢ Rotate the image in 90-degree increments to permit
the use of photos taken in “portrait” mode;

o Remove the “red-eye” effect that can occur when the
subject of a photograph looks directly into the
camera when the flash goes off;

e In Studio Plus, put together “pan-and-zoom”
animations in which a high-resolution image is
viewed as a succession of smoothly-connected close-
ups at various degrees of magnification. This
technique is closely associated with the well-known
documentary filmmaker Ken Burns.
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( _h Iame: Hogsth - An election entetsnment - 24 Duration; [0:00:04.00 & “

Pan and Zoom

Click and driag below to set pan posilon
2 I Animate from start to end
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Reset
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Hotate Red eye
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The Clip properties tool for photos has pan-and-
zoom controls for focusing on an area of interest. In
Studio Plus, pan-and-zoom can be animated to
create the effect of traversing the image from one
focus to another. Animated pan-and-zoom can be
obtained in other versions by upgrading to Studio
Plus.

If an image needs rotating by 90 degrees to ~ <°tt®

bring it into “landscape” mode (wider than @ @
high), start by clicking one of the image

rotation buttons. If needed, click the button more than
once until the clip is properly oriented.

If you want to reframe the image, click directly on
the tool’s preview window and, while holding the left
mouse-button down, drag the image in any direction
until it is properly positioned. Release the button to
complete the operation. Next, use the Zoom slider to
magnify or reduce the image size as desired. Adjust the
position and magnification with these controls until the
image is cropped and framed to your satisfaction.

The Reset button removes all your position and zoom
changes, restoring the original framing of the image.

The red-eye reduction feature helps Redeye

restore a natural appearance to photos in @[:ﬁ_i
which the subject’s eyes are tinged with red.
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(This problem is caused by light from the flash unit
bouncing off the retina of the eye when the subject is
looking directly into the camera.)

To activate red-eye reduction, click the left button in
the red eye group. The button stays down when clicked.
Now click the image preview with the left mouse-
button above and to the left of the area in which red-
eye reduction should be applied. While holding the
button down, drag down and to the right until the area
is fully enclosed. When you release the mouse-button,
the red-eye reduction effect is instantly applied within
the rectangle you have outlined.

It is usually not necessary to be highly precise when
marking out the red-eye reduction area. In fact, a larger
rectangle may even yield a better result than a smaller
one that encloses the eyes and no more. If the red-eye
reduction does not clear up the problem entirely on the
first attempt, try again with a different rectangle size.

Studio’s red-eye reduction algorithm provides excellent
results with a wide variety of photos. However, some
photos are better-suited to the process than others.

To remove red-eye reduction once applied, click the
right-hand button in the red eye group.

Animating Pan-and-zoom in Studio Plus

If you own Studio Plus, or purchase an activation key
by clicking the activate button on the pan-and-zoom
controls, you can create effective animations from your
photos and graphic images. Use the highest-resolution
images available with this technique, since they allow
greater magnification levels before there is perceptible
loss of quality.
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Start Creating a pan-and- [ Animate fram start to end
zoom animation by clicking
the Animate from start to end
checkbox to activate the animation feature for the
current clip. This enables the Set start and Set end radio
buttons, with Set start initially selected.

® Setstat © Setend

Use the pan-and-zoom controls to set the framing you
want to see at the start of the clip. Finally, click the Set
end button, then use the controls to set up the framing
you want for the end of the clip.

When the clip is played back, Studio will generate the
intervening frames to connect your start and end views
in a smooth animation.

The procedure above describes the simplest form of
pan-and-zoom animation. Effective uses include:

e Moving from a full-frame photograph to a detail
view of a person or thing somewhere in the image.
This gives a similar result to zooming in while
shooting video.

This might be used to prepare the viewer for a
sequence of shots exploring the same close-up
subject in multiple views, or providing further close-
ups of different parts of the same scene.

e Moving out from a detail to the full-frame view, as
though zooming out with the video camera. In the
above scenario, this returns the viewer to the original
context, perhaps closing a chapter or episode within
your movie.

e Panning across a wide scene to absorb its details one
by one. This technique can be used to impart a sense
of discovery when a dramatic or humorous detail
finally comes into view.
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Complex pan-and-zoom animations

When you apply pan-and-zoom to a number of copies
of the same image in succession, it is as though you are
taking your viewer on a guided tour. In effect you are
telling a story, one that gradually unfolds as you draw
attention to one detail after another.

Story-telling may be difficult or not, but implementing
your story in Studio is very simple. Once you have set
up the first clip, with the first pan-and-zoom “camera
move”, simply copy it as often as necessary, and
change the end setting for each clip.

The pan-and-zoom controls are used here to focus in
turn on four vignettes in the satirical painting “An
Election Entertainment” by English artist William
Hogarth. A fifth view pulls back to show as much of
the entire canvas as will fit in a wide-screen frame
without black sidebars. The tool automatically
generates smooth motion from one view to the next,
panning and zooming simultaneously as needed.
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You almost always want the start framing of a new clip
in the sequence to match the end framing of the
previous clip, in order that the sequence of moves will
be smoothly connected. On the second clip, and all
those that follow, click the Match previous clip button
wherever you want continuity.

In order to allow the movie to dwell on each detail for a
while after you pan to it, insert a non-animated copy of
the image between each move. Connect these static
clips into the sequence as usual with the Match
previous clip button.

Animating pan-and-zoom with keyframes

Studio Plus users have another option for animating
their pan-and-zoom productions: keyframing. The use
of this feature enables a string of pan-and-zoom
movements to be associated with a single clip, instead
of having a single movement on each of a series of
clips. See “Keyframing” on page 103.

The pan-and-zoom effect interface

As an alternative to pan-and-zoom with the Clip
properties tool, you can enter the framing properties
numerically with the Pan and zoom video effect. This
alternative interface is provided by the Video effects
tool. You can also combine the two methods, using the
tool’s graphical interface to specify the initial settings,
then fine tuning them with the numerical effect
parameters.

Tip: Studio Plus users can use keyframing to create
Pan and zoom slideshows using the effect parameters.

The Pan and zoom effect is found in the Fun Effects
group. The parameters for pan-and-zoom are parallel to
those offered by the tool interface: you can use the
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sliders to set Zoom, Horizontal position and Vertical
position. The “red-eye reduction” controls of the tool
interface do not have equivalent parameters, however.

(’;' Pan And Zoom Presets: ’m
Static Presets
¥ 1
Zoom j Pan And Zoom
Haorizantal Position : L} Keyiramed Presets
ertical Position f [}

Parameter settings for the Pan-and-zoom effect.

0’0 THE FRAME GRABBER

4

The Frame Grabber can capture a still image from any
video capture source supported by Studio, or extract a
single frame from any video clip in your current
project. The grabbed frame can be added directly to
your movie or saved out to disk in any of a number of
standard graphics formats.

Once you have saved a grabbed frame to disk, you can:

e Use it in other software applications.
e Manipulate it in image-editing software.

e Import it back into your movies as a still image via
the Album or the Title Editor.

The Frame grabber tool

Use the Frame grabber tool in conjunction with
the Player. To access it, open the Toolbox and
click the Frame grabber button.
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Play the movie or source video until the frame you
want is displayed in the Player, then click the Grab
button. The grabbed frame appears in the tool’s
preview area, ready to be added to your movie or saved
as a file on disk.

( _h Grah from: ¥ Mavie — Camcarder

tlample » &

!/Grab Add to Movie.

g

e o Disk )

The Frame grabber in grab-from-movie mode. When
you grab from an external source (e.g. a camcorder),
the Camcorder Controller is displayed. With DV
equipment, you can navigate the source tape from
within the tool.

Grab from: Select a source for the frame grabber by
clicking either the Movie or the Camcorder button at
the top of the tool. Choosing Camcorder means that the
frame grabber will use your current video source, as
configured in the Capture source options panel (page
246) and the Capture format options panel (page 250).

Note: Grabbing a frame from the camcorder is not
supported for HDV equipment.

Transport controls: If your source video is a digital
camcorder or VCR connected to a 1394 port, Studio
provides convenient on-screen transport controls for
locating the frame you wish to grab. For a description
of these controls see “The Camcorder Controller” on
page 22.
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Reduce flicker: If the source video of the frame grab
contains a large amount of motion, the grabbed frame
may show flickering, which can be reduced or
eliminated by checking the Reduce flicker option.
Because Reduce flicker also reduces resolution
somewhat, you should not use the option if the overall
result is undesirable for a particular image.

Grab: Click the Grab button when you have located
the frame you want to grab in the Player and configured
the Reduce flicker option. The grabbed frame is
displayed in the tool’s preview area, and the two output
buttons (Add to Movie and Save to Disk) are enabled.

Add to movie: This button inserts the grabbed frame
into the Movie Window video track ahead of the
currently-selected clip.

Save to disk: This button opens a Save As dialog so
that you can select a folder, file name and image format
for the file in which the grabbed frame will be stored.
The dialog also provides controls that let you set the
resolution of the saved image to any of several standard
sizes, to the original size of the grabbed frame, or to a
custom size that you enter.

If the “aspect ratio” (the ratio of the width to the
height) of the size you choose is different from that of
the grabbed frame, the image is stretched as necessary.
This can introduce visible distortion of shapes; for
instance, people may appear either unnaturally thin or
unnaturally squat.
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CHAPTER 9:

Disc menus

With the advent of the DVD, VCD and S-VCD disc
formats, video has become an interactive medium, with
new possibilities for both videographer and audience.

Developing — “authoring” — a disc in one of these
formats means going beyond the old idea of creating a
movie to be viewed in strict sequence from beginning
to end. Now the audience can decide which parts of the
movie to view, and in what order.

The essential new feature that makes disc authoring
possible is the menu. A particular disc may have one, a
few or many menus, each consisting of a still image or
short video sequence. Areas within the menus, called
buttons, can be selected by the viewer to activate links
to other content on the disc. Activating a link causes an
immediate transfer to any of:

e A normal video sequence, which in this context is
called a “chapter”. Chapter buttons often show a
thumbnail frame from the video to which they link.

o Another page of the same menu. Multiple pages, with
the same page design but different chapter buttons,
are used when a menu has too many buttons to fit on
a single page.

o A different menu.
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Unlike any other kind of clip, menus automatically
loop. When the end of a menu clip is reached during
disc preview or playback, it is immediately restarted.
This produces a jJump in the playback position affecting
all clips that run simultaneously with the menu,
regardless of type — video (if the menu is an overlay),
audio or still image.

Menu title Links to "chapters"

Link to previous Link to Link to next
menu page another menu menu page

The following diagram is patterned after the Movie
Window storyboard. It shows how the menu pictured
above, which appears in the diagram as M1, might fit
into the overall scheme of a simple movie with two
menus.

| |
Each menu is followed in the movie by several
chapters, all but one consisting of a single clip. Our
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menu, M1, has links to five chapters. Our menu is
designed to display two chapter links per page, so three
pages are required to accommodate all the links. (The
second page is the one appearing in the illustration.)
We’ve also given each page a link to the M2 menu.

The simple layout of this short movie can easily be
extended to organize large numbers of clips. Much
more complex movies are also constructed from the
same elements: multi-page menus with links to
chapters and to other menus.

Availability: Discs with multiple menus are supported in Studio Plus
only.

|
Disc authoring in Studio

For the purposes of editing in Studio, a disc menu is
just one more type of clip. As with titles, you can use or
adapt the menus provided in the Album, or construct
your own from scratch in the Title Editor (see Chapter
3: The Album and Chapter 10: The Title Editor).

To get a feeling for what is involved, try creating the
pair of “instant” projects described below. You don’t
have to go as far as making discs, but you can preview
your movie using the DVD playback controls on the
Player (see “The DVD Player Control” on page 171).

Instant video scene catalog: In an empty project,
multi-select a good number of scenes from the Album
and drag them onto the video track. Now switch to the
Disc Menu section of the Album (the bottom tab) and
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drag any of the menus to the beginning of the Timeline.
When Studio asks if you would like it to “create
chapters at the start of each video clip”, click Yes (see
“Using menus from the Album” on page 169). A new
track appears at the top of the Timeline, and a small
“flag” appears over each of your clips. These represent
links from the menu you just added. And that’s it — sit
back and watch the show.

Instant slideshow: This time, start in the Still Images
section of the Album. Drag as many images as you like
onto the video track of an empty project, then drag in
any disc menu as the first clip on the Timeline, and
again click Yes when asked if you want links
automatically created. Turn next to the Transitions
section of the Album, pick any transition, and drag it
between the menu and the first of your still images.
Finally, select all of the still images (click the first,
then shift-click the last), click with the right mouse
button, and choose Ripple Transition from the pop-up
menu. Instant slideshow!

Menus and titles

The similarity noted on page 167 between titles and
disc menus is not just on the surface: a menu is
essentially “a title with buttons”. In fact, any still image
type can be used as the basis for creating a menu within
the Title Editor.

Like titles, menus can be used either in full-screen
mode on the video track or as overlays on the title
track. When a menu is used as an overlay, its
background image is suppressed: only buttons, captions
and graphics are displayed. This allows the menu to
have a moving video background.
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Using menus from the Album

The Disc Menus section of the Album contains

a collection of menus that have been designed
for particular occasions, authoring styles and chapter
counts. Each menu provides a background picture, a
title, a set of chapter buttons (generally with spaces for
thumbnail frames), and a pair of Next page and
Previous page buttons.

The number of chapter buttons per page varies from
one menu design to another, so one criterion for
selecting a menu is the number of clips you want it to
handle. It is generally more convenient for the viewer
to browse a few menu pages with many buttons per
page than many pages of a few buttons each.

During editing, you see all the buttons that the menu
provides. During playback, the only buttons visible are
those to which you have assigned links.

Menus with fewer buttons have more space for
captions; those with many buttons will have abbrevi-
ated captions or none at all. Whether you need
captions, and if so whether they should be simple
(“Chapter 1) or descriptive (“Cutting the cake”) is a
matter of your authoring style and the content of your
movie.

In the VCD and S-VCD formats, the viewer must select
chapters numerically (by keying numbers on the remote
control), so it is usual to provide button captions that
include the chapter number when authoring for these
formats.
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Dropping menus on the Timeline

When you drag a menu from the Album and drop it
onto the video track or the title track, Studio gives you
the option of automatically generating links to all video
clips to the right of the menu on the Timeline. Multiple
clips are combined into chapters if necessary to achieve
the minimum chapter length you specify.

Adding Menu to Movie

—Would vou like Studio to create chapters at the start of each video clip?
&+ Yes, with a minimurn chapter lenath of a0 seconds

" Mo, Twill create chapters manually

|~ Automatically return to menu after chapter finishes playing

I Don't ask me this again

Ok

This is the quickest, easiest way to link in a disc menu,
but may not be what you want in a particular authoring
situation. If you check the Don’t ask me again
checkbox, your choice of Yes or No becomes the
default action when you drag in a menu in future. You
can also set the default action, or reinstate the
confirmation window, in the When adding a disc menu
area of the Project preferences options panel (see
“Project preferences” on page 253).

To create your chapter links manually, rather than
using the automatic linking feature, use the Set disc
chapter command on the pop-up context menu for each
video clip you want to add, or use the Set chapter
button on the Clip properties tool for disc menus.
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The DVD Player Control

@ - T Studio’s  Player  provides a
specialized set of controls for
previewing movies that contain menus, patterned after
the button layout on a typical DVD remote control.
Switch the Player to DVD mode by clicking the DVD
toggle button at the bottom right corner of the Player.

A grouping of DVD controls appears and activates
below the Player preview screen:

4

- SR

Here are the functions of the individual DVD controls:

Main menu: Jumps to the first menu in your &
movie and begins (or continues) playing.

Previous menu: Jumps to the most recently (<
active menu and begins (or continues) playing.
Clicking the button again jumps back from the menu to
the most recent clip.

Previous chapter, Next chapter: Clicking the (i
Previous chapter button takes you to the start of
the current chapter if you aren’t there already.

Click again to move on to the previous chapter. The
Next chapter button takes you forward to the next
chapter in the movie. Within a menu, these buttons step
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backwards and forwards respectively through the menu
pages.

Button selection: The four arrow

controls in this cluster move the on-

screen cursor within a disc menu to

select one of its buttons. The oval button

in the middle of the cluster activates the currently-
selected on-screen button, which is indicated by
highlighting.

Activating menu buttons directly

One feature of the Player that set-top DVDs don’t have
is the ability to click the buttons directly on the screen.
Whenever a button is visible in the Player preview area
in DVD mode, you can click it to follow the button
link.

Editing menus on the Timeline

Menus can be trimmed on the Timeline just like any
other still image clip (see “Trimming on the Timeline
using handles” on page 81).

Setting the clip duration is generally less crucial for
menu clips than for other types, since menus cycle
during playback while waiting for user input. If you
want a looping video background or looping audio with
your menus, though, you will want to match the menu’s
duration to that of the clips involved.

Pinnacle Studio 10 Plus



The menu track

Menu buttons link to particular points within your

movie. Those points are marked by flags on the
menu track, which materializes above the video track
the first time a menu is added to your movie (and
vanishes again if all menus are removed).

The menu itself is marked by a colored rectangle in the
menu track (M1 and M2 in the illustration above). Each
link to a chapter is shown by a “C” flag. Here is a
close-up of the first part of the Timescale, showing the
rectangle identifying the first menu, and the chapter
flags for three of the clips it links to.

: UI:DU:I'I U.UIEI :

The next part of the Timescale in the overview
illustration above includes the fourth chapter link from
M1, and a link (the left-pointing arrow) from the end of
the previous clip back to the menu. A result of setting
this link is that the C4 clip can only be reached from
the menu. The C4 clip is followed by menu M2, which
— along with the flags that belong to it — is
automatically drawn in a new color.

0:00: i?D. ] EII:DEI:?EI.DIEI

Availability: Multiple-menu discs are supported in Studio Plus only.

Chapter 9: Disc menus 173



Editing on the menu track

Flags on the menu track can be moved by dragging
them with the mouse, thereby changing the location at
which the link takes effect in the movie. When a video
clip is moved, any flags attached to the clip are moved
along with it.

To create a link:

Right-click the menu track or the video track and
choose either Set Disc Chapter or Set Return to Menu,
depending on the kind of link you want to create.

Return to menu links are always created at the end of
the current clip, rather than at the exact point where
you click. You’ll rarely want to return from the middle
of a clip, but you can drag the link flag to a new
position if the occasion arises.

To reposition a link:

Click the flag for the link and drag it along the menu
track to its new position.

To delete a link:

o Right-click the link flag and choose Delete from the
pop-up menu; or,

e Select the flag, highlighting it, then press the Delete
key.

Editing with the Clip properties tool

The Clip properties tool for disc menus allows ?E
you to create, edit and fine-tune chapter links, | ™= |
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and provides access to the Title Editor for adjusting the
visual content of the menu.

Like the Clip properties tool for other clip types, this
tool lets you set a custom name for the menu by editing
the Name field and trim the clip by editing the
Duration field.

( j Name: 2004 Duration; [0:00:12.00 & “
b Mend type: _Edi Munu_
T & Auto scone index  Manual
8

d 43 b |Crepier
[}
& [B2] st thumbrail T otion thumbeais
=
£

% Retuen afler every chapter
[j [E Set chapler Iﬂ Set retum
(LR 13

The Edit menu button at the top right of the tool opens
the menu in the Title Editor. There you can change
every visual aspect of the menu: its background and
button images, the appearance and contents of its
captions, and more. For full information about the
many capabilities of the Title Editor, see Chapter 10:
The Title Editor.

The preview area on the left side of the tool shows how
the menu looks and also has interactive features you
can use when establishing chapter links. (These are
described on page 178 under “Chapter-editing
controls”.)

The other controls are in four groups:

e Menu-previewing controls
e The Menu type options

e Link property controls

o Chapter-editing controls
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Menu-previewing controls

These controls are located below the preview area.

Page selector: For menus with multiple @42 »
pages (those with more links than fit on a

single page) the arrow buttons let you select which
page is active in the preview area. You can select any
page in the menu for which links have been defined.

Alternative methods of selecting menu pages:

e Step through the pages by clicking the page link
buttons in the preview area.

e Use the Button selector control (described on page
177) to choose a button on any page of the menu.

Show link numbers checkbox: Check this box @« e
to cause link numbers to be displayed in the
preview area over every button in the menu. The link
numbers match the format and color of the chapter
flags on the menu track.

The Menu type options

This pair of options determines whether you or Studio
will organize the chapter links for this menu.

hlenu type:

® Auto scene index © Manual

If you choose Auto scene index, Studio will ensure that
your chapter links are in the same order on the menu as
they are in the movie itself, seven if you shuffle the
order of the clips in the Movie Window. With the
Manual setting, the order in which chapters are shown
on the menu is up to you.

Tip: If you want to sort your chapter links yet still
retain future control of their order, you can click Auto
scene index first (to sort the links), then Manual.
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Link property controls

The controls in this area set the display properties of
the chapter links on the menu.

Button selector: Every link button in your I
menu, no matter which page it is on, has a

unique sequence number. Use the arrow buttons on this
control to select the menu button you want to work on.
The selected button is highlighted in the preview area.
You can also select a button by clicking on it in the
preview area.

Button caption text field: Edit the text for |chapers
the current button without going to the Title

Editor. The “#” character in button captions has a
special meaning: Studio replaces it with the button’s
sequence number. Use this feature to ensure that your
buttons are correctly numbered regardless of changes in
the layout of the menu. To edit other characteristics of
a button caption — its position, font, and styling — click
the Edit menu button to invoke the Title Editor.

Set thumbnail button: By default, the @
thumbnail frame displayed on a menu button is

the frame to which the button links. You can choose
any frame in your movie to be the thumbnail, however.
Just move the Timeline scrubber to the exact frame you
want (as shown in the Player), and click the set
thumbnail button.

Motion thumbnails checkbox: Check - Mation

this option if you would like your menu’s — thumbnails
buttons to show moving video from their target
chapters rather than a static thumbnail frame. Because
this feature requires that the moving thumbnails be pre-
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rendered, the results won’t appear immediately when
you preview your movie in the Player. Instead you will
typically see a colored bar appear in the Timescale over
the menu clip. This bar indicates that the clip is being
rendered in the background, without interrupting your
session.

Background rendering is optional. You can disable it, if
required, in the Video and audio preferences options
panel (Setup > Video and Audio Preferences). See
page 253 for more information.

Chapter-editing controls

The controls in this area select or modify the individual
chapter buttons within a menu.

The Set chapter buttons: These [ | Set chan
buttons set or sever the link 2] 3] st chapter

between the currently-selected chapter button on the
menu and its target clip.

To set a link: Position the Timeline scrubber within a
menu, video or still image clip, and click the Create
chapter [&] button. For video and still image clips, the
chapter point is set to the exact location of the scrubber
within the clip.

To clear a link: Click the Delete chapter [ button.

Set return button: This creates a “return-to- [:]
menu” link at the end of the current clip, which

is where you almost always want it. During playback,
the link causes an immediate jump to its menu. To
create a return-to-menu link in the Clip properties tool,
position the Timeline scrubber in the clip where you
want the link, and click Set return to menu.
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The Return after every chapter checkbox: Set this
option to add a return-to-menu link after every chapter
in this menu. Clearing the checkbox removes all the
return-to-menu links for this menu, whether they were
added manually or automatically.

Creating links with drag-and-drop

The Clip properties tool for disc menus supports drag-
and-drop as a quick and convenient way to establish
links for menu buttons.

To create a link using drag-and-drop:

e Click the clip in the Movie Window that you want to
link to, and drag it onto a button in the Clip
properties tool preview area. The button is linked to
the first frame of the clip. Or,

o Click the button for which you want to create a link,
and drag it onto a clip in the Movie Window. In this
case you are linking to the point within the clip at
which you “drop” the button — generally not the first
frame.

]
The Disc menu tool

If you open this tool while a menu is selected, it
is equivalent to opening the Clip properties tool; |~
otherwise, it provides a Create Menu button that takes
you into the Title Editor to begin the process of
creating a new disc menu.

Chapter 9: Disc menus 179



180

Because developing a menu is a relatively intricate
operation, Studio takes the opportunity to remind you
that pre-built menus are available in the Album.

Create Menu

“Y'ou can drag a menu from the benu Album inta pour project, or
you can create a mend from goratch in the Menu Editor.

What would you like to do?

+ Open the Menu Album
" Open the Menu Editor

. oK Cancel

When you decide that this reminder is no longer
needed, check the Don’t ask me this again box before
clicking the OK button.
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CHAPTER 10:

The Title Editor

Studio’s built-in Title Editor is a powerful facility for
creating and editing titles and other graphics. Its battery
of text and image effects and tools provides endless
possibilities for the visual design of your movie.

The Title Editor is not limited to creating passive titles.
For disc projects, you can also add and edit the special
buttons needed for handling viewer interaction with the
menus of VCD, S-VCD and DVD movies.
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Creating a title in the Studio Title Editor tool. The
large area containing the picture and the text is the
Edit Window, while the panel occupying most of the
right-hand side is the Title Editor Album. Other
controls are in clusters around the Edit Window.

Chapter 10: The Title Editor 181



00|
Launching the Title Editor

Reflecting the versatility of the Title Editor is the
variety of ways of accessing it from Studio’s Edit
mode, using either one of the tools in the Video toolbox
(see page 69) or a mouse command on one of the
Timeline tracks (see page 63).

e To create a full-screen title or menu: Select Go to
Title/Menu Editor from the right-button context
menu in the Timeline video track.

e To create an overlay title or menu: Double-click
the Timeline title track.

e To create a title or menu from the toolbox: Open
the Create title tool and click Title Overlay or Full
Screen Title.

e To edit a full-screen title: Double-click the title in
any Movie Window view, or right-click the title and
select Go to Title/Menu Editor.

e To edit a full-screen menu: Double-click the menu
in any view and click the Edit Menu button, or right-
click the menu and select Go to Title/Menu Editor.

e To edit an overlay title or menu: Double-click the
clip on the title track or in List View, or right-click it
in any view and select Go to Title/Menu Editor.

e To edit a title or menu from the toolbox: With the
clip open in the Clip properties tool, click the Edit
Menu or the Edit Title button.

If the list seems overwhelming, don’t let it concern
you. In practice, getting to the Title Editor by the
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nearest available means will give the result you want. If
you do accidentally create an overlay when you want a
full-screen title or menu, or vice versa, just drag it onto
the other Timeline track. If you find yourself creating a
title when you wanted a disc menu, you can easily
switch over in the Title Editor.

0‘0 THE TITLE EDITOR CONTROLS

®

The main Title Editor controls are laid out in clusters
around the Edit Window (see the picture on page 181).

|
Title-type buttons

] The four buttons in this cluster sit on

the left side of the screen above the
Title Editor’s Edit Window. Only one of them can be
selected at a time. Choose the first button if you are
creating a still title. The second creates a roll, in which
the title text and graphics travel upwards on the screen
as the title displays, like the credits at the end of a
move. The third creates a crawl, in which the title is
displayed as a single line of text moving from right to
left across the screen like the bulletins on a TV news
show.

Availability: Rolls and crawls are supported in Studio Plus only.
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The fourth button is for creating disc menus, which you
can usefully think of as “titles with buttons”. In fact, a
menu is just like any other title except for two
attributes:

e A menu has at least one button. A title has none.
Adding a button to a title turns it into a menu, and
deleting the last button on a menu turns it into a title.
By the same token, if you click the Menu button
while editing a title, Studio automatically adds a
button to the title.

e A menu cannot have rolling or crawling text. The

Title Editor does not allow you to add menu buttons
to a rolled or crawled title.

Object toolbox

x T O [OJ This cluster of four Title Editor tool
buttons is located at left below the Edit Window.

The first tool (the arrow) is used for
all editing operations upon the
currently selected object. A selected
object is surrounded by a number of
control points with which you can
change its size, position, proportions, and other
geometrical features.

The other three tools are for creating objects in the Edit
Window — text boxes, ellipses and rectangles.

Each is used in the same general way.
Click one of the three tools, then click
the Edit Window at the point where
one corner of the object should be.
Drag the mouse to outline the new
object as indicated by the dotted line.
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When the object has the size and proportions you want,

release the mouse. Whatever its type, the object is

created with the specified dimensions. Its other
attributes — color, shading, shadow,
etc. — are determined by the currently
selected look in the Title Editor
Album. All attributes can later be
changed at will.

After the object is created, the object tool you used
deselects, and the selection arrow again becomes
active. The object itself is selected — shown in the usual
way by its control points — and can now be manipulated
with the mouse.

Reordering objects in three dimensions

123 =1 ] Because objects can overlap

45 one another, it is easy to get
into situations where an object
that should be completely
visible is partly or wholly
obscured by one or more other
objects. In such cases, use the four reordering
commands on the Title Editor’s Layers menu. These
commands affect the currently-selected object,

symbolized by rectangle “3” in the diagram.

e Bring to Front: The object is moved out in front of
all other objects. In the diagram, object 3 is now in
front of object 1.

e Send to Back: The object moves behind all other
objects. Object 3 is now behind object 5.

e Bring Forward One Layer: Object 3 now lies in
front of objects 2, 4 and 5, but still behind object 1.

e Send Back One Layer: Object 3 is now behind
objects 1, 2 and 4, but is still in front of object 5.
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About text objects

Selecting a text object is different in one important way
from selecting a rectangle or ellipse: the object’s text
field is put into a “ready” state in which any keyboard
activity will cause the field to activate and start
displaying the input text.

The activation of the text field is indicated by a text
insertion cursor, the changed appearance of the object
frame, and the disappearance of the control points.

When a text object is not selected, you can activate its
text field directly by clicking in the middle of the
object. If you want the selection frame and control
points to appear, you must click on the edges of the
object. With other types of object, you can click
anywhere in an object to select it.

To deactivate a text field, click anywhere in the Edit
Window outside the text object.

Because text plays a central role in most titles and
menus, the Text Editor will automatically create and
activate a text object in the center of the Edit Window
if you simply begin typing at a time when no text
object already exists.
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Advanced text editing features

As in a word processing program, the Title Editor
allows you to format a selected range of characters.
Simply mark an adjacent set of characters with the
mouse and apply the formatting you desire.

Supported operations on character ranges include text
styling (font, style and look), clipboard operations (cut,
copy, paste), delete, and a number of special
positioning, spacing and scaling commands that are
accessible only from the keyboard. For details on these,
please consult Appendix G: Keyboard Shortcuts.

Editing-mode selection buttons

g These two buttons form the second cluster
along the bottom of the Title Editor’s Edit
Window. Their function is to govern which of two sets
of editing operations is available for the currently-
selected object.

e The first button is on by default when an object is
newly created. It enables the move, scale and rotate
operations with a selection frame containing nine
control points:

Top control point
allows rotation

Corner control point resizes
without changing proportions

Edge control point changes
Hold down mouse the width or height only

button and drag to
move object when the

"drag" cursor is visible,
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e Clicking the second button enables the skew
operation, which requires only a single control point.

Drag this control point to
rp—skew (tilt) the object

With text objects, the second button provides two
further operations, kern and change leading, accessed
by control points in the center of each edge of the text
frame:

Kern (L) and Change leading (R)
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Object layout buttons

w r: =3 @ The two left buttons in this cluster are

for grouping and ungrouping Title
Editor objects. The first button is available when
multiple objects are selected. Its action is to link the
objects into a group — a composite object that is treated
as a single entity by editing operations. When a group
is selected, all its control points are visible
simultaneously, and any of them may be used to
manipulate the group.

A grouping of three objects

The second button, which is available whenever a
group object is selected, separates the group into its
constituent objects.

Although it is possible to “group groups”, grouping is
always just one level deep, so ungrouping a supergroup
will result in all the constituent objects being
individuals again.

The next button opens a pop-out menu of 11 operations
that apply only to groups. The first six let you align a
set of objects along any one of their four edges or either
of their two mid-lines. The next pair of commands
provides for spacing the objects at equal intervals in
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either the vertical or horizontal directions, and the final
three resize the objects so that they have equal width,
equal height, or both. All of these commands are
particularly useful in menu creation, since you
generally want menu buttons to be laid out in a regular
fashion.

A The final object layout button opens another

B | | pop-out menu, this one concerned with

| object justification. The nine options here are

in a graphical form resembling a tic-tac-toe

board. Clicking one of the nine areas moves the object

to the corresponding corner of the screen (as defined by

the “text-safe” area delimited by red dashed lines), or to
the center.

Multiple selection of objects

The first step in making a group is to select the multiple
objects that will comprise it. This can be accomplished
in either of two ways:

e By clicking and dragging with the mouse to mark out
a selection rectangle (a “marquee”) that encloses all
the objects you want to group; or,

e By clicking the first object you want to group, then
Ctrl-clicking each of the others.

Temporary groups

Any selection of multiple objects functions as a
temporary group, and can be moved, aligned, rotated,
colored etc. as a unit. The temporary grouping loses its
identity as soon as you click elsewhere in the Edit
Window, however, whereas a group created with the
group button persists until explicitly ungrouped.
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Clipboard and delete buttons

M Oy & fif The buttons in this cluster provide the

familiar editing operations Cut, Copy,
Paste and Delete, all of which operate on groups,
individual objects, or on selected text within a Title
Editor text object. The first three work with the
Windows Clipboard, while the fourth simply deletes
the chosen material without affecting the Clipboard.

Text-styling controls

B 7~ U E |Naturalbam - |52. :

The controls in this cluster at the top right of the Title
Editor’s Edit Window should look familiar to anyone
who has used word-processing software. The controls
apply both to currently-selected text and to any new
text that may be entered until the settings are changed
again.

At the left are three font style buttons, which select the
bold, italic or underlined styles respectively.

Perhaps surprisingly, the underlined style button -
alone among these controls — can be applied to any type
of object, not just text (try it!). This makes it possible to
use the underlined highlighting style with buttons
created from graphic objects: rectangles, ellipses and
pictures.
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A The fourth button opens a pop-out

Let menu of text-formatting options.
Center Unlike the other controls in the
Right cluster, which govern the appearance
of individual characters, the options

%ﬁhm to fit on this menu apply to all the text in a

cale to fit given text box.

Wordwreg an The three justification options — Left,
(& Wadwapof Center and Right — affect the

placement of the text within its box (and not the
placement of the box itself within the Edit Window,
which is the function of the object justification menu

D

Shrink to fit, Scale to fit, Word wrap on and Word wrap
off are options that determine how your text is treated
when you resize a text box. With Word wrap on, which
is the default for a new text box, resizing the box
results in the text being reformatted — word-wrapped —
to the new box width (while the resulting new height of
the text in turn governs the height of the box). Word
wrap off removes all “soft” line breaks (line breaks
added for word wrapping), then makes the box as wide
as necessary to contain the text. Word wrap mode is
automatically turned on again if you type further
characters into the text box.

With Scale to fit, the text is stretched during resizing to
follow both box dimensions. With Shrink to fit, the text
remains its original size unless the box is made smaller,
in which case the text is resized as in Scale to fit.
Neither to fit command changes the line divisions of
the text.

The font dropdown list and the font-size selector
complete the text-styling controls group.
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€ THE TITLE EDITOR ALBUM

The Title Editor Album is the rectangular panel on the
right-hand side of the Title Editor screen. It contains
resources for building menus and titles in the same way
that the main Studio Album contains resources for
creating movies.

2%a The Title Editor Album is controlled by the four
__ buttons shown at left, which are located between
] the Edit Window and the Album itself. Each
ig9) button opens one of the four Album sections: the

Looks Browser, the Backgrounds section, the
== Pictures section and the Buttons section.

The Looks Browser

@]| This section of the Title Editor Album has three
subsections, accessed by the Standard, Custom
and Favorites tabs across the top.

The Standard tab is a collection of styles that can be
applied to the text and other objects you use in your
titles. Each style consists of a color (or color gradient,
or transparency) for each of the “face” (surface), edge
and shadow of the object to which it applies, plus a
separate blurring parameter for each. A final parameter
is shadow direction, for which there are eight
possibilities.
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To change the look of an existing object, simply click
on the look you want while the object is selected. New
objects are created with the most recently selected look.

LZ]%]
E|B)5|E

Selecting a look in the Looks Browser: Each button
in the Standard tab is available in eight styles, which
are presented to you as a submenu. Each look has a
numeric ID that displays as a tool-tip under your
mouse. Above, the mouse is on look 23-3.

The Custom tab lets you customize the supplied looks
or create your own by adjusting the parameters listed
above. Three identical sets of controls adjust the
parameters for face, edge and shadow respectively.
Here are the face controls:

Face

cH &M [
B aSSSS—— |

The three option buttons across the top select a solid
color, a gradient, or no color (transparency). Clicking
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the color swatch beside the first button invokes an
otherwise standard Windows color-picker dialog to
which an Opacity slider (0-100%) has been added.

The swatch beside the second button pops
up a gradient designer that lets you define
a gradient by assigning the starting colors
to each corner of a square surface. Click
the color swatches in the corners of the
gradient window to set the color for that corner in a
color-picker dialog.

Note: Some of the more elaborate supplied looks em-
ploy special internal features and so cannot be edited.

fii The Favorites tab lets you save particular

custom looks that you may want to re-use in
the future, to spare you from having to remember or
record the parameters you used. Click the left-hand
button to save the current look as one of your favorites.
Click the right-hand button to delete the currently-
selected “favorite”.

The Backgrounds section

A title or menu can have four types of
background: a solid color, a gradient,

transparency (no background at all) or an image file

(such as a drawing, photograph or saved video frame).

Solid calor_l Graqient rTransparency
“H T H

Picture— @ [i2] ] —Select folder
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The color and gradient options in the Backgrounds
section of the Title Editor work in just the same way as
those described above for the Looks Browser (page
193), except that the color or gradient you select is
instantly applied to the background of the title you are
editing.

If you are working on an overlay title, you may find
interesting ways to use the Opacity setting on the color-
picker dialogs for these buttons, especially when the
overlay is coupled with transitions. Normally, though,
you’ll use a transparent background for titles, and
transparency is the default background selection for a
new title or menu.

The final option for backgrounds is picture — an image
file in any standard format. As with many of the
sections of Studio’s main Album, the backgrounds are
drawn from a source folder that may be changed using
the folder button. The image file you select with the
folder button becomes the new background, and the
image files in the folder are displayed as thumbnails on
the Album panel.

If necessary, the Title Editor stretches the background
image until it fills the width or height of screen but
does not change its proportions.

Adding a motion background

In Studio Plus, disc menus can have a background of
moving video, not just a static image. To create such a
motion background, or replace one, simply click the
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folder button and browse for a movie file in AVI,
MPEG or WMV format.

TIFF tles (*.4f)
wiindowes Metafiles [© wnif]
A Files [ awi]

MPEG Files [* mpdssmpd,”.mod,” 3op)

b Files [~ varmy) |

All Files [%.7] v

To see movie files listed while browsing for a folder
on your hard drive, select the desired movie type (or

“All Files™) in the “Files of type™ box.

The following rules apply when you add or change a
motion menu clip:

e The length of the movie you add as a background
does not affect the length of the menu clip in the
Movie Window. If the movie is shorter than the clip,
it is simply repeated as necessary to fill out the
required time; if longer, it is truncated. You can
adjust the length of the menu by trimming on the
timeline or in the Clip properties tool as usual.

e If you add a widescreen movie as a menu
background in a project in standard format, or a
standard movie to a widescreen project, the movie is
stretched or squeezed as required to match the
project format.

The Pictures section

As with the background pictures just discussed,

the images in the Pictures section of the Title
Editor Album can be of any standard type. Instead of
being stretched to fill the Edit Window, however, these
pictures are added to the title as picture objects and
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displayed at normal size with eight control points that
allow them to be repositioned and resized (though not
rotated or skewed).

Picture objects behave just like text objects and the two
types of graphic object with respect to grouping,
alignment and similar controls.

The Buttons section

E:ul Since buttons are the magic ingredient that turns

titles into interactive menus, this section of the
Title Editor Album is mainly of interest for DVD, VCD
and S-VCD authoring.

Broadly speaking, a button is an area of the screen with
which the user can interact in some way. Buttons are
classified according to the action they produce when
the user activates them, and not by their appearance,
which generally should be chosen to give a strong clue
to their behavior, but is not required to. The four types
of button are:

e Normal: Clicking the button causes playback to
jump to a chapter (that is, ordinary video) or another
menu. The link between the button and its target is
created in the Clip properties tool, not in the Title
Editor.

e Thumbnail: This special form of the normal button
type displays a thumbnail frame (or a moving
thumbnail preview) from the part of the movie to
which it links.

e Previous: This button appears on the second and
later pages of multi-page menus (menus with more
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links from normal or thumbnail buttons than will fit
on one page). It links to the previous menu page.

e Next: This button appears on all but the last page of
multi-page menus; it links to the following page.

The button art supplied with Studio includes several
examples of each type. Each button is an image file in
Targa (tga) format. Examination of the files in an art
program like Adobe PhotoShop or Paint Shop Pro will
show that the transparent portion of the button image,
and the special area for the display of thumbnails
(where applicable), are defined by an alpha channel
included with the image.

As usual, a folder button lets you select the disk
directory from which the displayed images are
obtained.

To use a supplied button, simply drag it from the
Album into the Edit Window, where it becomes a
button object — essentially an identical twin of the
picture object.

IPrevious button =] The default action of the supplied
Mat a buttan buttons is determined by their file

Mormal button

Thumbnallbutton% names, but a new action can be
Previous buthon .

Next button assigned to the currently-selected
Flool bulton button object from the dropdown list
in the Buttons section of the Title Editor Album. The
first choice on this list, “Not a button”, removes the
action from the object — now it is merely a graphic. The
other choices correspond to the button types listed

above.

Tip: Remember, it’s not the button’s appearance that
determines its behavior, but the button type you select
from the menu.
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Button highlighting

R Highlight style DVD menus (but not VCD and S-VCD
[0 &g ¢ _— menus), give visual feedback by high-

lighting the current button as the user

L] aetive [ | selected  scrolls around the menu. Special active
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highlighting distinguishes a button that is
in the process of being actuated, just before the action
is performed. (You can preview this highlighting effect
in the Player, and interact with the menu using either
the mouse or the Player’s DVD controls.)

The Title Editor lets you assign the color that will be
used for each type of highlight, and a style option that
governs how the highlights will be drawn. The controls
for these settings are located below the button-type list.

Click the Active and Selected color swatches to set the
highlight colors that work best with your menu. It may
help to make your menus clearer if you use consistent
highlighting colors for all the menus on a disc.

The three highlight style options, from left to right, are:
e Box: The highlighting is drawn as a rectangle
enclosing the button.

o Follow shape: The highlighting covers the visible
area of the button, whatever its shape.

¢ Underline: The button is underlined.

These highlight options can be applied to any type of
button made from any type of object, not just the button
images brought in from the Album. Clear the Highlight
style checkbox if you want to disable button
highlighting while working in the Title Editor.
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CHAPTER 11:

Sound effects and music

Video may be thought of as primarily a visual medium,
but the role of sound in your movies is often no less
important than that of the images on the screen.
Feature film and television productions include
numerous types of audio, beginning with the dialog and
other sounds created during live action. In your movies,
that raw soundtrack is brought in along with the video
during Capture mode. It appears in the Movie Window
Timeline view on the original audio track below the
video track. In Studio Plus, original audio may also
appear on the overlay audio track.
Most commercial productions also require sound
effects — slamming doors, crashing cars, barking dogs,
etc. — and incidental music, which may consist of music
created especially for the production, songs taken from
recordings, or both. Voice-overs and other customized
audio are also often needed.

You can use all these types of add-on sound in your

own movies:

e A good starter set of effects in wav format is
installed with Studio, and others are available from
many sources.

e The SmartSound tool automatically creates a music
track of any desired duration in a variety of styles.
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e You can drop mp3 files from the Album onto the
Timeline or import audio or MP3 tracks from a CD
with the CD audio tool.

e The Voice-over tool lets you add narration or
commentary as you preview your edited video.

Audio, whatever its type, is added to your production
as clips in the Movie Window. These can be moved
around, trimmed and edited in much the same way as
video clips and still images.

Once a sound clip is part of your movie, you can
modify it with fades and other volume adjustments.
You can adjust the positioning of your clips within a
stereo or surround mix, and even change that
positioning arbitrarily within the clip. You can also
apply Studio’s audio effects, including noise reduction
and reverb among others.

Availability: Surround sound is supported in Studio Plus only.

About surround sound

A “surround” mix goes beyond the two channels of
stereo to provide a theater-style enveloping sound field
for your DVD productions. Studio lets you set the
apparent position of each audio track independently
within the mix, and to “pan” the track (reposition it,
whether smoothly or abruptly) in any desired direction
as often as necessary over the course of your movie.

To preview surround sound while editing in Studio,
you need a sound card that support 5.1 channel output.

Note: Even if you cannot hear your surround mix when
previewing, it will still appear on your DVDs, but a
surround preview allows more accurate mixing.

Pinnacle Studio 10 Plus



A surround soundtrack can be output to the DVD in
either of two forms:

 In Dolby Digital 5.1 format, each of the six surround
channels is stored discretely on the disc and will be
routed directly to the corresponding speaker when
played back on a full 5.1 surround playback system.

e In Dolby Digital 2.0 format, the surround mix is
encoded onto two channels. When your DVD is
played back on systems with a Pro Logic or Pro
Logic 2 decoder, and a 5.1 or better speaker layout,
the original surround information is recreated. On
other systems, the encoded soundtrack will be heard
as conventional stereo.

The Timeline audio tracks

The Movie Window’s Timeline view contains several
audio tracks:

Original audio track: This contains the audio captured
along with your video clips. It is sometimes called
“synchronous” audio because it is recorded
simultaneously with the video track.

Overlay audio track: The original audio for video
clips on the overlay track.

Sound effect and voice-over track: Sound effects and
voice-overs are the typical content on this track. Sound
effects are brought into your project from the Sound
Effects section of the Album (see “The Sound Effects
section” on page 57). Voice-overs are created with the
Voice-over tool (described on page 208).
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Background music track: Use this track to include
mp3 or wav audio files, SmartSound background
music generated by Studio, and music (or other
content) from audio compact disks (CDs). Audio files
are imported via the Music section of the Album (see
page 58). Create SmartSound clips with the
SmartSound tool, and CD audio clips with the CD
audio tool (see “The SmartSound tool” on page 206
and “The CD audio tool” on page 205).

Audio |

Title ‘
Sound effect |« ==

Music | ¢ .

n ol

The Timeline audio tracks: original audio, sound
effect and voice-over, and background music. A
fourth audio track appears when the overlay track is
visible; it contains the original audio for video on
that track.

Switching audio tracks

Although the audio tracks do have their specialized
roles, as described above, these mainly control the
choice of track where new clips will appear.

Original audio will always be placed on the original
audio track when a new video clip is brought in; new
voice-overs will always be created on the sound effects
and voice-overs track; and new CD audio and
SmartSound clips will be added to the background
music track.
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Once a clip has been created, however, you can move it
to a different audio track if it is convenient to do so:
each track is actually able to accommodate any type of
audio clip. This gives you the flexibility to use two
sound effects simultaneously, for example, simply by
placing one of them on the background music track.

The only audio track with special status is original
audio, either for the main video track or, when it’s in
use, the overlay track. By default, audio clips on this
track are edited in parallel with the contents of the
video track at the same time index. To treat the audio as
a separate clip, lock the video track (by clicking the
padlock icon on the right side of the Movie Window).
See “Advanced Timeline editing” for details (page 90).

The CD audio tool

Use this tool to create an audio clip from a CD
track. You can preview tracks within the tool,
and select either a whole track or an excerpt to add to

your movie.
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If there is a CD in the drive that you have not
previously used in a Studio project, Studio will ask you
to enter its name before continuing. The controls on the
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tool will become available only when Studio can offer
at least one entry on the CD Title dropdown list.

Select the CD from which you wish to capture audio in
the CD Title dropdown list, and a track on that CD
from the Track list. Since CD Title is also an editable
text field, you can change the name by which Studio
refers to this CD, if desired. The name change applies
to both the current and future sessions.

Having selected the CD and track, you can now
optionally trim the clip and give it a custom name using
the other controls on the tool. These controls are
common to most audio clip types, and are used for
editing as well as creating clips. They are covered in
“Trimming with the Clip properties tool” (page 211).

Finally, click the Add to Movie button. Studio captures
the music clip from the CD drive and adds it to the
background music track beginning at the current time
index (as shown by the Timeline scrubber and the
preview frame in the Player).

The SmartSound tool

SmartSound automatically creates background JE|
music in the style of your choice. Within that
style, you select one of several songs, and within that
song, any of a number of versions. The list of versions
available also depends on the duration of background
music you specify.

To create music for a particular set of clips, select those
clips before opening the SmartSound tool. (To select
your whole movie, use Edit > Select All or press
Ctrl+A.) The total length of the selected clips will
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determine the initial setting for the music duration,
though you can modify the value at any time by
trimming on the Timeline or directly editing the
Duration counter in the tool.

|8 Name: Duration:(0:03:19.11 | = Eﬁ'
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In the SmartSound tool, choose a style, song and
version from the lists provided. Each style offers its
own selection of songs, and each song its own selection
of versions. Use the Preview button to audition the
song while the tool is open.

Enter a name for the clip in the Name field and adjust
its duration with the Duration counter, if desired. The
music clip you create will be adjusted to fit exactly the
duration you select.

If you would rather work with SmartSound sound
effects instead of songs, select Sound effects rather than
Music on the Type dropdown list.

You can change the selection of songs available to you
by choosing a different option on the Scope dropdown
list. Choosing All will give you access to the entire
SmartSound catalog, if you have an Internet
connection. You can preview any of the songs, and
purchase any that your movie may require.

When you have made your choice, click the Add to
Movie button. Studio creates the new clip on the
background music track beginning at the current time
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index (as shown by the Timeline scrubber and the
preview frame in the Player).

The SmartSound button at the bottom right of the tool
opens a dialog with options and tools for maintaining
your SmartSound library.

The Voice-over tool

Recording a voice-over in Studio is as easy as
making a telephone call. Just open the Voice- ——
over tool, click Record and speak into the microphone.
You can narrate as you watch the movie play so your
words match the action on the screen. You can also use
the tool as a quick way of capturing ambient music or
home-made sound effects via your microphone.

Record

Before you can record audio using the Voice-over tool,
you need to connect a microphone to the input jack of
your PC sound board. You must also have at least one
video clip in the Movie Window.

Review the video scenes in your movie and decide
where you want the voice-over to begin and end. When
you are ready, open the Voice-over tool. Note that the
recording lamp — the dark rectangle in the upper left of
the above illustration — is not lit.
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Select your starting point on the Movie Window
Timeline. You may do this by selecting a clip, playing
the movie and stopping it at the desired point, or by
moving the Timeline scrubber.

Position the microphone for use and try speaking a test
phrase to check your recording level (see “Voice-over
level” below). When you are satisfied, click the Record
button (which toggles to a Stop button). Wait for a few
moments as the recording lamp first signals STAND BY
then steps through a 3-2-1 countdown.

[svano e |- [N ~ (T2 0 - (120 1)

When the recording lamp signals RECORDING, and the
movie begins to play back in the Player, perform your
narration.

RECORDING

Finally, click the Stop button. The lamp goes out, and
the voice-over clip is automatically placed on the sound
effects and voice-overs track. Review the clip by
selecting it then clicking the Play button.

Voice-over level

The record level for a voice-over clip is set .~ &g
when you create the voice-over and cannot & | ©F
be changed thereafter. However, you can J g
adjust the playback volume at any time. <3—==
The record level is set with the Recording 1 o8
level slider and its accompanying level [i—32

meter on the Voice-over tool.

Watch this meter to make sure your recording levels
don’t get too high or low. The indicator changes color
from blue (0-70% modulation), through yellow, to red.
Generally, you should try to keep your audio peaking in
the yellow (71-90%) and out of the red (91-100%).
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Voice-over recording options

The Studio setup dialogs include several settings that
affect your recording configuration and quality. This
section provides a brief summary. See “Video and
audio preferences” on page 257 for detailed
information.

To access these options select Setup > Video and audio
preferences from the main menu bar.

Voice-over recording
Microphaone:
|Microphone - NYIDIA{R) nForce(TM}) P.udj

hannels: Sample rate;
[tebicmone w|  [zzoske |

The Microphone dropdown list on this dialog lists the
multiple ways a microphone can be connected to your
particular sound card. The entries on the list should
look something like the following, from a system with
an NVIDIA® sound card:

IMicrophone:
Microphone - MYIDIAR) nForcelTr) nudj

Line In - MWIDIA(R) nForcelTH) Audio

D Audio - MYIDIAR) nForce{TM) Audio
Video - NVIDIA(R) nForce(TM) Audio

A - NYIDIA(R) nForce(TM) Audio hd

Choose from this list, then connect your microphone in
the manner indicated (e.g. Microphone or Line In).

The Channels and Sample rate adjustments on the
options dialog control the quality of voice-overs or
other recorded audio. Set them at the highest quality
level you anticipate needing, but keep in mind that
increasing quality requires more disk space.
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® TRIMMING AUDIO CLIPS

As with other clip types, you can trim audio clips either
directly on the Timeline or by using the Clip properties
tool. See “Trimming on the Timeline using handles” on
page 81 for a discussion of the first method.

Most types of audio clip can be trimmed from a
minimum of one frame up to the full original length of
the clip content. SmartSound clips can be trimmed on
the Timeline down to as little as one second, and
upward without limit.

Trimming with the Clip properties tool

The Toolbox » Modify Clip Properties menu @
command invokes the Clip properties tool for the
selected clip. You can also access the tool by double-
clicking any audio clip.

To begin with, the tool provides controls that let you
view or edit two properties shared by all clips:

e To set the duration of the clip, change the value in
the Duration counter.

e The Name text field lets you assign a custom name to
the clip to replace the default one assigned by Studio.
The clip name is used by the Movie Window’s List
view, and can also be viewed as a fly-by label when
your mouse hovers over the clip in the Storyboard
view.

The other controls provided by the tool depend on the
type of audio clip you give it.
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Original audio, sound effects and voice-overs

The Clip properties tool provides the same kind of
trimming controls for sound-effect and voice-over clips
as for video clips, but displays a graph of the audio
waveform instead of visual preview areas.

To learn how to trim with these controls, see
“Trimming with the Clip properties tool”” on page 86.

Remember that clips on the original audio and the
overlay audio tracks can only be edited independently
when the corresponding video track is locked. See
“Advanced Timeline editing” on page 90.
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CD Audio

For CD Audio clips, the Clip properties tool uses the
same trimming controls as above, but additionally
provides dropdown selectors for CD Title and Track.
You can use these to change the source of the clip at
any time. CD Title is also an editable text field, so you
can enter the actual title of the CD.

SmartSound®

SmartSound clips can be edited to almost any length,
except that very short clips at some particular durations
may not be available in every combination of Style and
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Song. This tool is essentially identical to the tool for
creating SmartSound clips (described under “The
SmartSound tool” on page 206), except that the Add to
movie button is replaced by the Accept changes button.

€ AUDIO VOLUME AND MIXING

The audio levels and stereo positioning of individual
clips can be adjusted either directly on the Timeline, or
with the Volume and balance tool. Each technique
offers its own advantages. Adjusting on the Timeline
gives you a good sense of time versus volume or
balance, whereas the Volume and balance tool
facilitates mixing — separately adjusting the volume and
stereo balance of each of the audio tracks.

For disc authoring, the Volume and balance tool lets
you choose to create a surround soundtrack, rather than
stereo. The tool lets you dynamically position any of
the audio tracks from front to rear as well as left to
right.

Availability: Surround sound is supported in Studio Plus only.

Anatomy of an audio clip

An audio clip icon on the Timeline has several parts.
The boundaries of each clip are denoted by vertical
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bars. The actual content of the audio is indicated by a
waveform graph:

Waveform graph excerpt from three neighboring clips.

The appearance of the waveform graph tells you
something about the character of the sound. A quiet
sound has a narrow waveform, close to the centerline of
the clip. A loud sound has a waveform with larger
peaks and troughs, reaching almost to the borders of the
clip. A continuous sound, such as a car engine, has
many pulses packed closely together. A staccato sound
has brief pulses separated by silences where the
waveform is a horizontal line.

Adjustment lines

The blue volume line graphically models the volume
changes you have made to the track and clip. If you
have not adjusted the volume at all, the line runs
straight along the clip at about three-quarters of the clip
height. This is the “zero gain” (0 dB) level, where the
clip’s original volume has been neither increased nor
decreased.

If you raise or lower the volume of the entire track, the
volume line remains horizontal, but is now higher or
lower than the zero-gain base level.

Finally, if you make volume adjustments within the
clip, the line consists of sloping segments that meet at
volume adjustment handles.

Clip length — Adjusted audio level
1

L S0 —Base (0dB) level
5 i

|_Symbo|ir.: waveform |_Adjustment
representing sound  handle
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Unlike the waveform graph, or the adjustment lines for
balance and fade (see below), the volume adjustment
line is scaled logarithmically. Perceived volume varies
logarithmically with the strength of an audio signal, so
this feature allows the adjustment line to model more
accurately what you really hear. For instance, an
upward-sloping line segment will produce a smooth,
steady fade up from the starting to the ending level.

The green stereo balance line and the red front-back
balance (“fade”) line work similarly to the volume
line, except that in both cases the neutral position is the
vertical center of the clip, and the adjustment scale is
linear.

Raising the stereo balance line positions the audio
clip’s output further to the listener’s left, while
lowering it positions the clip further to the listener’s
right. Similarly, raising the fade line moves the clip
away from the listener, and lowering it brings the clip
towards the listener.

Note: You can only view and edit a clip’s fade line
when the Volume and balance tool is in surround
mode. The effect of adjusting the line can be previewed
only on systems where surround-sound playback is
available.

To select which of the three adjustment lines is
currently displayed, use the audio clip’s right-button
context menu:

Select Yolurme Display
v Select Balance Display %
Select Fade Display

Availability: Surround sound is supported in Studio Plus only.
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Adjusting audio on the Timeline

Audio levels can be adjusted directly within a clip on
the Timeline. Use the mouse pointer to adjust the blue
volume line or either of the balance lines (see
“Anatomy of an audio clip” on page 213).

When you add a new audio clip to the Timeline:

e The volume adjustment line of the newly-created
clip connects the lines from the preceding and
following clips if any are present.

e If no volume adjustments have been made to other
clips on the track, the volume line through the new
clip is horizontal. Its height reflects the overall track
volume as set in the Volume and balance tool.

e If no volume adjustments have been made either to
other clips or to the overall track volume, the volume
line through the new clip is at three-quarters height.

To adjust the volume of a clip on the Timeline, select it
(by left clicking), then move your mouse pointer close
to the line. The volume adjustment cursor will appear:

—E—iﬁlﬂﬁe—,\j

m— |

Click the left mouse button, and drag up or down
within the clip. The volume line follows the mouse.

we\r
PP
LR
When you release the mouse, Studio creates an
adjustment handle on the volume line.

~Biplane
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When your mouse pointer is positioned over an
adjustment handle on a selected clip, a highlighted
version of the volume adjustment cursor appears. With
this cursor, you can click and drag the adjustment
handle both vertically and horizontally.

ipl
MEE\

il

Right-click an adjustment handle to access the context
menu command Delete volume setting. This command
removes one adjustment handle. Use Remove volume
changes to remove all the handles from the clip.

Adjusting balance and fade

The left-right and front-back balance lines have the
same editing features as the volume line just discussed,
except that with them the neutral setting is at half the
clip height, instead of three-quarters as it is for volume.

In the case of left-right (stereo) balance, adjusting the
line upwards from the center positions the audio further
to the left. With front-back balance (“fade™), adjusting
the line upwards moves the apparent source of the
audio away from the listener, while adjusting the line
downwards brings the audio closer (towards the rear
speakers).

Removing changes

Audio adjustment handles can be removed either
individually or for an entire audio clip at once. Select
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the appropriate command on the clip’s right-button
pop-up menu:

Remaove Yolume Changes
Remaove BalancefFade Changes
Delete Yolume Setting

Delete Balance/Fade Setting

The Volume and balance tool

Compared to adjusting audio on the Timeline, | ¢
the Volume and balance tool offers a greater
degree of adjustment functionality organized into one
convenient location. It also provides both left-right and
surround-sound balance controls. The tool operates in a
similar way to a traditional audio mixer.

UMD

The Volume and balance tool provides individual level
controls for each of the audio tracks: original
audio (left in illustration), overlay audio, sound effect
and voice-over, and background music (right). The
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overlay audio controls are displayed only when the
overlay video and audio tracks are open in the Movie
Window.

The balance control, located in the right-hand part of
the tool, can position the audio of any clip — or part of
one — in stereo (one-dimensional) or either of two
surround (two-dimensional) modes. The mode is
selected in the dropdown list above the control.

Each audio track has its own set of level

@Qﬁ Q@ controls. The set for the original audio track

®)

- _g"‘ in its down position, no audio clips from the

is shown at left.

. The individual controls and displays include
5 a track mute button @. When this button is

track will be used in your movie. The track
mute button’s icon has a second purpose: it
identifies which track the level controls
apply to. This is the only visible point of
difference amongst the three sets of controls.

Illl|"|||||||||||||ll|||||||||p|l|||ll|1|||. I

‘©L The track level knob @ raises or lowers the

overall volume for the track. It therefore
affects the vertical position of the volume adjustment
lines on all clips on the track, but does not change their
contour. Click on the knob and drag it with a clockwise
rotation (up to the 2 o’clock maximum position) to
increase the volume. Use a counterclockwise rotation
(down to the 6 o’clock minimum) to lower the volume.

Q@ Q@

Level knobs, full off (L), default (C) and full on (R).
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The track’s relative level scale ©, with its associated
fader @, are calibrated in decibels (dB). The 0 dB mark
corresponds to the level at which the clip was recorded.

The position of the fader knob shows the volume level
at the current playback position in your movie, relative
to the level at which the current clip was recorded.
Drag the knob up or down to modify the level. The
knob is “grayed” (disabled) if there is no clip on the
track at the current time index. If the track is muted, the
knob is grayed and set to the bottom of its range.
Adjusting the fader results in a volume adjustment
handle being added to the track as described above.

A track’s playback volume contour, or envelope,
combines the overall track level with the relative level
at each point on the track. This combined level, which
is shown graphically by the volume adjustment lines on
audio clips, is applied to the actual audio data to
produce the track’s output level, as represented on the
level meter ©, which illuminates during playback to
show the level at the current time index. To avoid audio
“clipping” - the unpleasant sound produced by
attempting to set volume levels outside the range of a
digital signal — ensure that the meter level never quite
reaches the top of the bar.

The fade buttons ® produce a fade-in from or a fade-
out to the current position of the movie. For a visual
confirmation of their effect, watch the behavior of the
clip’s volume adjustment line when the fade buttons are
clicked. The fade duration is variable from zero to fifty-
nine seconds. Adjust it in the Project preferences
options panel (Setup > Project Preferences) under
Volume fades. Fades are not available too close to the
beginning or end of a clip.
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The balance control

This control has three modes, stereo, surround and
dialog, which you select from the dropdown list above
the control. The mode can be changed whenever
desired — even within an individual audio clip.

Surround
Dialog
T

E—A

Availability: Surround sound is supported in Studio Plus only.

In any mode, the position of each track at each point in
the movie is shown by its speaker icon, or “puck”. The
icon matches the one on the muting indicator for the
corresponding track.

In stereo mode, you set the position of the track by
dragging its puck left and right between a pair of main
speakers:

|9tere0 j

e
Positioning the original audio in the middle of a
stereo mix with the sound effects track (L) and the
overlay track (R) on opposite sides. The music track
is shown as a gray outline (right of center),

indicating either that the track has been muted or
that there is no clip on the track at this time index.

In surround mode, you can position each track from
front to back (“fade”) as well as from left to right
(“balance”). Each track can be independently placed
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anywhere within the rectangular listening area defined
by the four corner speakers.

Dialog mode is similar in concept, but includes the
center speaker at the front of the listening area. Sending
a portion of a clip’s audio through the center helps
stabilize the apparent location of the sound within the
shifting surround mix. At the same time, the placement
of the sound source can be freely varied in two
dimensions as with the standard surround mode.

JSurround j JDiang LJ

o B

o g Y g

Surround and Dialog modes: At left, the music track,
in Surround Mode, is positioned at the rear of the
listening field. The original audio track at the same
time index is in Dialog Mode, shown at right. The
Dialog mode focuses the original audio by including
the center speaker in the mix.

There are two ways to set the position of a track’s icon
in the balance control. Either click on any track’s icon
and drag it to the desired position, or move it by
dragging the triangular locator knobs below and to the
right of the control. The locator knob below the balance
control adjusts the left-right positioning of the audio
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output from the currently-selected clip, while the knob
on the right adjusts the front-back positioning.

Drag track icon directly (L) or with locator knob (R).

Viewing volume and balance contours

Each audio clip in your project displays a contour line
showing one of its volume, left-right balance or front-
back balance. To select which of the three types of line
is displayed, use the commands on an audio clip’s
right-button context menu (see “Anatomy of an audio
clip” on page 213).

The contour lines can be modified directly on the
Timeline using adjustment handles. For details, see
“Adjusting audio on the Timeline” on page 216.

0‘0 AUDIO EFFECTS

¢

You can modify any audio clip in your project | g
using Studio’s plug-in audio effects, which are
accessed with the Audio effects tool, the sixth tool in
the Audio toolbox. The operation of this tool is
identical to that of the Video effects tool. See “Using
video effects” (page 98) for a complete description.
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As with video effects, your library of audio plug-ins is
expandable. Any audio effect using the popular VST
standard can be used in Studio just like effects supplied
with the program.

Icons for audio effects

In Timeline mode, any special effects
you have applied to an audio or video
clip are indicated by small icons along
the bottom of the clip. These correspond
to the categories shown by the Add new
effect browser in the Audio effects and
Video effects tools. Those categories are
explained under “Video Effects Library”
wasee — ON page  109.You can open the
& appropriate tool for parameter editing by
double-clicking any of the icons.

In the illustration, the Noise reduction effect has been
applied to both audio clips. The star icon below the
video clip shows that one or more of the effects in the
Fun category has been applied to it.

About the effects

The powerful Noise Reduction filter is provided in all
versions of Studio. It is covered immediately below.

Studio Plus includes an extra group of audio effects.
These are each briefly described starting on page 226.
Full documentation of the parameters for the Plus
effects is included in their context-sensitive on-line
help which can be viewed by clicking the help
button (2 at the top left of the parameters panel for
each effect, or by pressing the F1 key when the panel is
open.
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In a special category is the Studio Plus Speed effect,
which is currently unique in that it operates on video
and audio simultaneously. It is covered on page 113.

Noise reduction

This advanced filter suppresses unwanted noise in any
audio clip. The filter responds dynamically to the
changing noise conditions within the clip. The preset
you choose provides the starting point from which the
adaptive algorithm proceeds.

You can often further improve your results by adjusting
the Noise reduction and Fine tuning parameters. There
is a lag of about a second before any new setting has an
audible effect, so you should make small changes then
pause to check if there is an improvement.

(2 HNoiss Reduction Presets:] =]

Moige reduction F L} 073
Auto adapt v
Fine tuning L] 0.00

Remove wind L

Noise reduction: When a camcorder is used outdoors
with the actors distant from the microphone, the
“source noise” may be very high, and to make matters
worse the internal noise of the camcorder may be
amplified to intrusive levels. If a lapel microphone
connected to the line input of the camcorder were used
when taping the scene, however, the source noise could
be quite low. Adjust this control to match the noise
conditions of the actual signal.

Fine tuning: This controls the amount of cleaning to
be used. It is only needed when the Noise reduction
level is low, since at higher levels the noise has already
been eliminated.
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Auto adapt: When this option is checked, the filter
automatically adjusts to changes in the type or amount
of noise in the clip. The Fine tuning is not used when
Auto adapt is active.

Remove wind: This checkbox engages a filter that
reduces wind noise and similar unwanted background
sounds in the audio clip.

Note: The Noise reduction filter will help with a wide
range of material, but it is not a panacea. Your results
will vary depending on the original material and the
severity and nature of the problems.

0‘0 PLUS EFFECTS

¢

The Studio Plus pack of audio effects is included with
Studio Plus only. Users of other Studio versions can
obtain these effects by upgrading to Studio Plus.

This section briefly introduces each effect in the group.
Full descriptions, including all parameters, are
available in the context-sensitive help when the effect
parameters window is open in Studio Plus.

The effects appear below in the same order as they do
in the effects browser.

ChannelTool

The basic action of this Studio Plus effect is to route
your stereo audio signal. It allows you to connect either
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or both of the left and right input channels to either or
both of the output channels. In addition, ChannelTool
offers special-purpose presets, including Phase reverse
and Voice removal — the “karaoke” effect.

Chorus

The Studio Plus Chorus creates a richer sound by
repeatedly reintroducing “echoes” into the audio
stream. By controlling properties like the frequency
with which the echoes recur, and the decay in volume
from one repetition to the next, a variety of results is
possible, including flanger-like sounds and other
special effects.

DeEsser

This Studio Plus audio filter unobtrusively removes
excessive sibilance from recorded speech. Parameters
allow you to fine-tune the effect to the particular
recording you need to correct.

Equalizer

Graphic equalizers like this one in Studio Plus are
similar in concept to the treble and bass “tone” controls
on audio equipment, but provides a much finer degree
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of adjustment. Studio’s equalizer divides the audio
spectrum into ten bands, each centered on a different
sound frequency.

Note: In musical terms, each equalization band covers
one octave, and the center frequency is close in pitch to
the note B.

The sliders let you increase or decrease the contribution
of each band’s frequencies to the total sound over a
range of 48 dB (-24 to +24). The adjustment to a band

is applied full strength at the center frequency, and
tapers to zero in either direction.

The display above the slider shows the activity across
the audio spectrum as your project is played back.

|
Grungelizer

The Studio Plus Grungelizer adds noise and static to
your recordings. It can make your clips sound as
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though you were hearing them on a radio with bad
reception or a worn and scratched vinyl record.

TODAY 1900

Leveler

This Studio Plus effect helps compensate for a common
problem in recording audio for video productions: the
imbalance in the recorded volume of different elements
in the original audio. For instance, your commentary as
you shoot the video may be recorded at such a high
level that it overwhelms other sounds at the location.

The trick in using the Leveler is to find a target volume
somewhere between that of the loud and soft audio in
the original clip. Below that volume, Leveler acts as an
expander, increasing the original level by a fixed ratio.
Above the target volume, Leveler acts as a compressor,
reducing the original level. With careful adjustment of
the parameters, the internal balance of the audio can be
significantly improved.
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Reverb

The Studio Plus Reverb effect simulates the effect of
playing back the source sound in a room of a given size
and sound reflectivity. The interval between the arrival
of the original sound at the listener’s ears and the first
echoes is greater for a large room than a small one. The
rate at which the echoes die away depends on both the
room size and the reflectivity of the walls.

The presets for Reverb are named for the type of room
they simulate — from the passenger cabin of a car all the
way up to a huge underground cavern.

Stereo Echo

The Stereo Echo effect, available in Studio Plus, allows
you to set separate delays on each of the left and right
channels, with feedback and balance controls to
provide a variety of interesting sounds.

Stereo Spread

This Studio Plus effect allows you to decrease or
increase the apparent width of the stereo listening field
in an audio clip. Most often it is used to create a mix
that sounds more open and spacious.
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CHAPTER 12:

Making your movie

One of the great things about digital video is the large
and growing number of devices that can make use of it.
Studio lets you create versions of your movie for
whatever video viewers your audience will be using,
from hand-held DivX players to HDTV home theaters.

When you have finished editing your project, switch to
Make Movie mode by clicking the Make Movie button
at the top of the screen.

‘ 1 Capture H 2 Edit ” 3 Make Mavie

This opens the Output Browser, which lets you tell
Studio with a few clicks everything it needs to know to
output your movie in the form you want.

Begin by selecting the media type of your finished
movie from the three tabs at the left side of the
window: Disc, File or Tape.

Disc output lets you copy a movie onto a disc in
your computer’s CD or DVD recorder. See page
233 for more information.

File output creates files that can be viewed from
your hard drive, your web-site, your portable
movie player — even your mobile phone. See page 237.
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[3] Tape output records your movie onto tape in a
camcorder or VCR. This tab also lets you output
the movie to your monitor screen. See page 242.

[F ﬁé»

\'\deoﬁmftmuu E: i)
r“ Acstor aality
=)

Taem Click the Cieste buson below 10
begn making yeur proinct

SVCD | 700 MB |
Availabile: 7 mres
Used: 41 seconds

Queatay; 100y

" Crestedisc | | Setlings.

The Output Browser. The tabs at left let you save to
disc, file or tape. Other controls let you set output
options as needed for the chosen media type. On the
right is a graphical display of disc usage.

Output can be configured quickly within each media
type using the dropdown lists in the Output Browser.

Dizc Type

]

File

=]

Tape

|ovD
Video Quality £ Disc Uszage

[

| Best Quality

[

Autamatic Quality

Best Cuality I

Most¥ideo On Disc "
Custom

If you need hands-on control, click the Settings button
to open the correct panel of options for your chosen
media type. When you have confirmed your settings,
click the Create button to begin output.

O Create dise [ Settings. .
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Preparing your movie for output

Before your movie is completely ready for output some
preprocessing will usually be required. In general,
Studio will need to “render” (generate video frames in
the output format for) any transitions, titles, disc menus
and video effects you’ve added to your movie.

0‘0 OUTPUT TO DISC MEDIA

¢

Studio can output movies directly onto DVD, VCD
(VideoCD) and SVCD (Super VideoCD) discs, if the
required disc burning hardware is available on your
system.

If your system is equipped with a CD burner, Studio
can create VCD or S-VCD discs on either CD-R or
CD-RW media.

Your VCD discs can be played back:

e OnaVCD or S-VCD player.

e On some DVD players. Most DVD players can
handle CD-RW media, but many will not reliably
read CD-R. A majority of DVD players can handle
the VCD format.

e On a computer with a CD or DVD drive and
MPEG-1 playback software (such as Windows
Media Player).

Your S-VCD discs can be played back:
e Onan S-VCD player.
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e On some DVD players. Most DVD players can
handle CD-RW media, but many will not reliably
read CD-R. DVD players sold in Europe and North
America usually cannot read S-VCD discs; players
sold in Asia often can.

e On a computer with a CD or DVD drive and MPEG-
2 playback software.

If your system has a DVD burner, Studio can create (in
addition to the above) DVD discs on any recordable
DVD media supported by the drive.

Your DVD discs can be played back:

e On any DVD player that can handle the recordable
DVD format your burner creates. Most players can
handle the common formats.

e On a computer with a DVD drive and playback
software.

Whether or not you have a DVD burner on your
system, Studio also lets you save a DVD image — a set
of files containing the same information that would be
stored onto a DVD disc — to a directory on your hard
drive. The DVD image can later be burned to disc.

Studio creates your disc or disc image in three steps.

1. First the entire movie must be rendered to generate
the MPEG-encoded information to store on the
disc.

2. Next, the disc must be compiled. In this phase,
Studio creates the actual files and directory
structure that will be used on the disc.

3. Finally, the disc must be burned. (This step is
skipped if you are generating a DVD image rather
than an actual disc.)
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To output your movie to disc, or to a DVD image:

1. Click the Disc tab to bring up this display:

v [
From

Used:

i)
160 ME
277IMD

504 M

© Create e

DV (4.7 G )
Available: 11 mnuees
Ut &1 smcondt

Dusabty. 1008

Settings.

The two circular displays summarize your disc
usage. The upper one shows the amount of hard
drive storage that will be required during the
making of your movie, and the other shows an
estimate of the time the movie will occupy on your

writable CD or DVD.

Use the folder button |3 to change the hard drive
location Studio uses for storing auxiliary files. If
you are creating a DVD image, it will also be stored

in that folder.

2. Select the Format — that is, disc type — you are
using, then whichever Preset best matches your

Intent.
o Disc Type
| ovo 7]
D Yideo Quality / Disc Usage
[|__Fie |Best uality -
Automatic Guality
Tape Best Quality I,

MostVideo On Disc "%
Custom
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If you wish to fine-tune your output settings,
choose the Custom preset then click the Settings
button to bring up the Make Disc options panel (see
“Make disc settings” on page 262).

3. Click the green Create disc button. Studio goes
through the steps described above (render, compile,
and if necessary burn) to create the disc or disc
image you have specified in the Make Disc options
panel.

4. When Studio has finished the burning operation, it
ejects the disc.

Quality and capacity of disc formats

The differences amongst the DVD, VCD and S-VCD
disc formats can be boiled down to these rules of thumb
regarding the video quality and capacity of each
format:

e VVCD: Each disc holds about 60 minutes of MPEG-1
video, with about half the quality of DVD.

e S-VCD: Each disc holds about 20 minutes of
MPEG-2 video, with about two-thirds the quality of
DVD.

e DVD: Each disc holds about 60 minutes of full-

quality MPEG-2 video (120 minutes if the disc
recorder supports dual-layer recording).
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0’0 OUTPUT TO FILE

4

Studio can create movie files in all of these formats:

e AVI

e DivX

e iPod compatible

e MPEG-1, MPEG-2, MPEG-4
e Real Media

e Sony PSP compatible

¢ Windows Media

Choose whichever format matches the needs of your
audience and the details of their viewing hardware.

The size of the output file depends on both the file
format and the compression parameters set within the
format. Although compression settings can easily be
adjusted to produce small files, heavy compression
comes at the expense of quality.

The detailed settings for most formats can be adjusted
by choosing the Custom preset and clicking the
Settings button. Other presets load settings designed for
typical situations. See Appendix A: Setup options for
information about options in Studio.

When your output options are in place, click the Create
file button. A file browser opens to let you specify a
name and location for the video file you are creating.

As a convenience, the Output Browser @ @
also provides buttons for launching any
desired media file in Windows Media Player or Real
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Player, so you can view your output file in an external
player as soon as you have created it.

@ Femad
Deiss |MPEG-4 |
= e
] | 1 GaF
=]

Taem

Freu: 16307 M

Usnd ZTTaME

i 15 EME

Settrgn

ti Video: FE088, 2997 Frames/sec

Click: the Cieate busion below 10
begn making yeur proinct

Audio: MPEG, 16Dk Sleveo, 40 kHz

Create fe... Satlings. |-‘.§'

The File tab of the Output Browser

AVI

Although the AVI file type for digital video is itself
widely supported, the actual coding and decoding of
video and audio data in an AVI file is performed by
separate codec software.

Studio supplies a DV and an MJPEG codec. If you
wish to output your movie as an AVI in some other
format, you can use any DirectShow-compatible codec
installed on your PC, as long as that codec is also
installed on the PC that will play your movie.

@ Farmat
G | |avl =

Preset
|Mediurn -

@ Full screen (D)

Tape Full screen (MIPEG)
Medium I
Srnall by
Custom

Click the preset that best meets your needs; or choose
Custom, then click the Settings button to open the Make
File options panel (see page 265).
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DivX

This file format, based on MPEG-4 video compression
technology, is popular for video files disseminated over
the Internet. It is also supported by a range of DivX-
compatible hardware devices, from DVD players to
portable and handheld units.

@ Format
Disc |Di\l'}( j
Preset
| smail |
@ Small
Tape Medium
Full screen I
High Definition by
Custom

Click whichever of the quality presets matches your
needs; or choose Custom, then click the Settings button
to open the Make File options panel (see page 265).

iPod compatible

Like DivX, this file format is based on MPEG-4 video
compression technology. The combination of powerful
compression with a small 320x240 frame size produces
very small output files relative to the more expansive
formats. The generated files are compatible with the
popular Video iPod devices, and may work with some
other devices types as well.

@ File Type
Dec | |iPod Compatible -]
Preset
|8mall File Size -
= Small File Size
Tape Gaod Quality »\[\g ...........
High Quality

The three quality presets select different data rates,
each providing a different balance of quality and file
size.
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MPEG

MPEG-1 is the original MPEG file format. MPEG-1
video compression is used on VideoCDs, but in other
contexts it has given way to newer standards.

@ Format
Die [MPEG-1 -
PIESEt
|video CD Compatible -
Wideo CD Compatible
WHE Quality
Tape  pETIEl=EAlL ™
Small b
Custom

MPEG-2 is the successor format to MPEG-1. Whereas
the MPEG-1 file format is supported on all Windows
95 and later PCs, MPEG-2 and MPEG-4 files can only
be played on PCs with appropriate decoder software
installed. Two of the MPEG-2 presets support HD
(High Definition) playback equipment.

@ Format
Dize |MPEG-2 =

Preset
|DvD Compatible |

DD Compatible

SVCD Compatible

HD 720p

HD'Z 1080i o
HD 10801

Custom

g
El

MPEG-4 is another member of the MPEG family. It
offers image quality similar to MPEG-2 but with even
greater compression. It is particularly suitable for
Internet use. Two of the MPEG-4 presets (QCIF and
QSIF) create “quarter-frame” video sized for cell-
phones; two others (CIF and SIF) create “full-frame”
video suitable for handheld viewers.

Custom presets. With all MPEG variants, Custom lets
you configure movie output in detail by clicking the
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Settings button to open the Make File options panel

(see page 265).
@ Format
DEe | |MPEG-4 -
Freset

|Medium  CIF |
Wery Small

g Small f QSIF
Srmall/ QCIF N
Medium f SIF by
Medium i CIF
Large size {(good guality)
Full size {best quality)
High Definition
Custom

Real Media

Real Media movie files are designed for playback on
the Internet. Real Media movies can be played back by
anyone around the world who has the RealNetworks®
RealPlayer® software, which is a free download from
www.real.com. See page 270 for information about
configuring your output with the Make File — Real
Media options panel.

Sony PSP compatible

This is another file format based on MPEG-4 video
compression technology. As with the iPod-compatible
type, the combination of powerful compression with a
small 320x240 frame size produces very small output
files relative to the more expansive formats. The
generated files are compatible with the popular Sony
PlayStation Portable devices, and may work with some
other devices types as well.

(& | Felee
Dso | [SonyPSP Compatible B
Prezet
High Gluality j
=] Small File Size =~
Tape Good Cuality by
High Quality
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Windows Media

The Windows Media file format is also designed for
streaming Internet playback. The files can be played on
any computer where the Windows Media player — a
free program from Microsoft — is installed. See page
273 for information about configuring your output with
the Make File — Real Media options panel.

0‘0 OUTPUT TO TAPE

¢

Choose the Tape tab on the Output Browser when you
want to send your output to an external video device —
a television, camcorder or VCR - or to “VGA”, for
viewing on your monitor screen.

I——————
Configuring the camera or recorder...

Make sure your recording device is properly connected
before you begin to generate the movie.

Output via IEEE-1394 cable

If your recording device has a DV input, just connect it
to your digital video hardware with an IEEE-1394 (or
“I.LINK”) cable. The connector at the camcorder end
should be labeled DV IN/OUT.

Note: On machines that don’t support recording back
to the camcorder, including many PAL devices, the DV
connector is called simply DV OUT.
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Output with analog audio / video cables

If you have a Studio product with an analog (TV or
video) output, such as Studio DVplus or DC10plus,
connect the video outputs of the capture card to the
inputs of the video recorder and the audio outputs of
the sound card (or the capture card, if it has them) to
the audio inputs of the video recorder.

Connecting a TV set or video monitor

Many camcorders have an integrated display, making it
unnecessary to attach a video monitor.

Otherwise, to view your movie as it is recorded, a TV
set or a video monitor must be attached to the video
outputs of your recorder. Video outputs are not always
available on DV camcorders.

Computer (CPU)

TV or monitor
(optional)

<
[l
o]~
-l >
|
wle
L
[Tn]
—

DV Camcorder k=t k=t
.E o o
= P o
=111 g ¢
[— << >

| Audio out + D —

Video out coco TOOOE
Analog VCR
(optional)

Output your movie to videotape

Verify that the camcorder/VCR is powered on and
configured, and that you have inserted a tape cued to
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where you wish to begin recording. You now have two
options:

1. If you are recording your movie onto a DV tape,
Studio gives you the option to control the DV
device automatically. Click the Settings button then
activate the check box in the Output options area.

With most DV devices there is a small delay
between receiving the command to record and the
actual start of recording. Since it varies from one
device to another, you may need to experiment with
the Record delay time value for best results with
your particular device.

2. If you are recording onto analog tape, start your
VCR recording now.

Finally, click Play in the Player.
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APPENDIX A:

Setup options

Settings are provided to adjust various aspects of
Studio’s operation. The default values have been
chosen to work well for the majority of situations and
hardware. However, you may wish to modify them to
suit either your work style or your specific equipment
configuration.

About Studio setup options

Studio’s setup options are divided between two tabbed
dialog boxes, both with several panels.

The Main Options dialog box has four panels covering
options relating to Capture mode and Edit mode. Open
this dialog box to the panel of your choice by selecting
one of the commands in the first group on the Setup
menu.

Pinnacle Studio Plus Setup Options

| Capture source ] Capture format ] Project preferences ] Video and audio preferences ] ‘

The Make Movie Options dialog box has three panels,
one for each of three media types: disc, file and tape.
Access this dialog box by selecting one of the
commands in the second group on the Setup menu.
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Pinnacle Studio Plus Setup Options

| Make Disc | ake File| Make Taps| |

Option settings in Studio apply to both the current and
future Studio sessions. There is no master reset.

Capture source settings

Remember that any changes you make on this panel
affect all future captures. If you want to configure only
one capture session, make sure you restore the old
values before the next session.

The settings are grouped into three areas: Capture
devices, Scene detection during video capture and Data
rate.

Capture devices

Studio senses which capture hardware you have
installed on your system for both video and audio. If
you have more than one available capture device in
either category, choose the one you want to use for the
current capture session.

Capture devices

Video T¥ Standard Aspect Ratio
|Pinnacle Studio Deluxe ﬂ | J | J
Audio ™ Use Overlay

|Pinnacle Studio Deluxe j IV Capture preview

Video: The devices listed here may include both digital
equipment connected via an IEEE-1394 cable and
various types of analog video source (Studio DC10plus,
TV tuner card, USB-connected camera, etc). Your
selection determines the availability of some other
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Capture source settings, and of many settings on the
Capture format panel.

Audio: Your choice of audio devices is constrained by
which video device is selected. With most analog
devices, for instance, you can choose any of your sound
card inputs; your equipment configuration determines
which one you should use.

TV standard: Choose the standard that is compatible
with your capture device and your TV or video monitor
(NTSC or PAL). NTSC is the standard used in North
America and Japan. PAL is the standard used in most
other places. With some capture devices you may have
an additional choice: the SECAM standard used in
Russia, France and some other countries. If you
purchased your Studio product in North America, the
option is permanently set to NTSC.

Use overlay: If you are performing an analog capture
with Studio AV/DV, you will have the option of using
the *“overlay” capability of your graphics hardware
when previewing the capture. This may make the
preview smoother, but is not supported by all graphics
cards. Turn off this option only if it causes problems.

VCR input: This option, which is available with some
analog capture devices, should be checked if your
source device is a VCR. When the option activated,
capture will be more tolerant of A/V synchronization
problems in the incoming signal.

Capture preview: This option controls whether the
incoming video will be previewed in the Player during
capture. Because generating the preview uses a
significant amount of processor time, previewing may
cause dropped frames during capture on some systems.
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Only turn off the option if you are having a problem
with dropped frames.

Aspect ratio: This dropdown list specifies whether the
video source for future analog captures should be
interpreted as having normal (4:3) or widescreen (16:9)
format.

Scene detection during video capture

The effect of these scene detection options is described
under “Automatic scene detection” on page 27. The
options that are actually available depend on the
capture device being used: not all devices support all
modes.

Scene detection during video capture
{+ Automatic based on shooting time and date
" Automatic based on video conkent
(™ Create new scene every ’T seconds

" Mo auto scene detection -- press space bar ko create scene

The first option, “Automatic scene detection based on
shooting time and date”, is available only if you are
capturing from a DV source.

Your DV camcorder records not only images and
sound, but also the time, date, and various camera
exposure settings (see your camcorder manual for more
detail). This information is termed data code, and is
transferred through the IEEE-1394 link along with the
video and audio.

Under the default setting, Studio uses the data code
information to determine when each new scene begins.
It grabs the first frame of each new scene to use as an
icon for display in the Album.

Data code does not work if the tape:

e includes one or more blank (unrecorded) sections
e is unreadable due to tape damage or electronic noise
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o was recorded without the camcorder time or date set
e is acopy of another tape

e was shot on an 8mm or Hi8 camcorder, and is now
being played back on a Digital8 camcorder.

Under the final option — “No auto scene detection” — a
new scene is created each time you press the [Space]
key.

Data rate

The DV format uses a fixed 5:1 compression ratio,
which implies a data transfer rate for real-time capture
of approximately 3.6 megabytes per second (MB/sec).
The transfer rate of your capture drive must be at least
4 MB/sec to allow for any variations across the drive.

Test data rate: Click this button to °#ar

test the data rate of your current " 5
. . . Read: 14588 Khyte/sec
capture drive. Studio writeS and e a5 kbotersec
reads a file of known length, and
gives you a read-out of the results

in KB/sec (4000 KB/sec equals 4 MB/sec).

. Test Data Rate

If you have attempted to capture DV scenes and your
capture drive can’t accept the DV data rate, a dialog
box will inform you of the problem. You have the
options of choosing another drive or adding one that
meets the data rate requirement.

Folder browser: This button |3/ sets the disk directory
(and thus the drive) in which your captures will be
saved, and lets you specify a default file name for
captures. The Test Data Rate button will perform its
test on the drive where this capture directory is located.
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Capture format settings

The options available here depend on the capture
device you are using (from the Capture source tab).
You will not see all the settings described below
displayed at once.

Presets

The settings in the other areas on the Capture format
panel depend on your choice in this Presets area. The
available presets depend in turn on your capture
hardware.

Presets

|MPEG | |High quality (ovD) | DvD compatible

For a DV capture source, the main capture options are
selected in the first of two dropdown lists. (The other
list provides any applicable sub-options.) The choices
are:

e DV: Full quality DV capture, which uses about 200
MB of disk space per minute of video. There are no
sub-options with this setting. DV capture is
recommended over MPEG if outputting your project
to videotape is a possibility.

e MPEG: Capturing to MPEG takes less space than
DV but more time — both when capturing and later,
when you output your movie. The quality presets
(High, Medium and Low) are available as sub-
options, plus a Custom preset that lets you configure
the video settings manually. The best preset to use is
the lowest one that meets the requirements of all the
devices on which your movie will be played. Use
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Low if you are outputting only for VCD; Medium if
you need to accommodate S-VCD; and High if your
movie will be output for DVD.

Other types of capture device provide a single list of
quality options — generally Good, Better, Best and
Custom.

Presets

|Better | wHs videa

Studio AV/DV Analog captures use fixed capture
settings with no further options.

Video settings

The settings available in this area depend on both the
capture device and the options selected for it in the
Presets area. Only applicable settings are shown. The
settings are editable only if you are using a Custom
preset.

Options: This button gives you access to any setup
options offered by the codec (compression/decom-
pression software) you have chosen.

Compression: Use this dropdown list to select the
codec you want to use.

Width, Height: These fields control the dimensions of
the captured video.

Frame rate: The number of frames per second you
wish to capture. The two numerical options represent
full-speed and half-speed video respectively. The lower
number (14.985 for NTSC, 12.50 for PAL or SECAM)
saves disk space at the expense of smoothness.

Quality, Data rate: Some codecs present quality
options in terms of a compression percentage (Quality),
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and others in terms of the required data transfer rate in
KB/sec (Data rate).

MPEG type: Select one of the two flavors of MPEG
encoding: MPEG1 or MPEG2. The former is almost
universally supported on Windows computers; the
latter gives better quality for a given compression ratio.

Resolution: This is a dropdown list giving the
resolutions available with the capture options you have
picked. Increasing both the width (the first figure) and
the height by a factor of two increases the amount of
data to be processed by a factor of four.

Fast encode: This option speeds up the encoding
process with some reduction in quality when capturing
to an MPEG file. You may want to evaluate the effect
of this option in your production using a short test
capture.

Audio settings

These audio capture settings are editable only if you are
using a Custom preset.

Audio settings
W

Compressian:

| |

Channels Sample rate

[16-bit more | |16 kHz -]

Options...

Include audio: Clear this checkbox if you are not
planning to use the captured audio in your production.

Options: This button gives you access to any setup
options offered by the codec (compression/
decompression software) you have chosen.

Pinnacle Studio 10 Plus



Compression: This dropdown shows the codec that
will be used to compress the incoming audio data.

Channels, Sample rate: These settings control audio
quality. “CD quality” is 16-bit stereo, 44.1 kHz.

MPEG capture

This area is visible only when an MPEG preset for the
capture format has been selected.

The three options on the dropdown list control whether
MPEG encoding is performed during capture, or as a
separate step when capture is complete.

o Use default encoding mode lets Studio decide which
of the other two choices to use given the speed of
your computer.

e Encode in real time means that capture and encoding
occur in one step. This will produce good results
only on a fast enough machine.

e Encode after capturing means that encoding will not
be performed until the capture itself is complete.
This takes longer but is more reliable if you have a
slower CPU.

|
Project preferences

These settings are split into five areas, which are
covered in the subtopics below. Hardware settings
relating to editing are on the Video and audio
preferences panel (see page 257).
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Editing environment

Automatically save and load my projects: If this
option is checked, Studio will continually update your
stored project while you work without you having to
save your changes explicitly. If you would prefer to
look after your own loads and saves, leave this option
unchecked.

Show large storyboard thumbnails: Check this box
to get more detail in the thumbnail frames shown by
Storyboard view in the Movie Window.

Show premium content, Show premium features:
Premium content and features allow you to expand
Studio easily and conveniently when you need more
resources or more power to enhance your movies.
Premium content refers to add-on effects, transitions,
titles, menus and sound effects. Premium features
refers to pan and zoom, chroma key, and other
advanced capabilities.

Check the boxes if you would like the premium items
to be listed in the Album and other appropriate places
in Studio.

In general, when you click on a premium item you will
be offered the chance to purchase and install it
immediately, without leaving Studio, if you have an
Internet connection available. See “Expanding Studio”
on page 11 for further information.

Project format

By default, your Studio movie project is in the same
video format as the first clip you add to it. If you want
to force new projects to a different format, click Use
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this format for new projects, and select your desired
format from the dropdown list.

Project format

(™ Set From First clip added to project
(% Use this Format For new projects:

NTSC Widescreen ﬂ
A

MTSC Skandard

CUbTSC WWidescresn, .

MTSC Progressive b

MTSC Progressive Widescreen
PAL Skandard

PaL widescreen

PAL Progressive

PAL Progressive Widescreen
HDW 720250

HOY 720/30p

HDW 1 0E0/50i

HOY 10807600

HD 10&0)50i bl

Default durations

These duration times are measured in seconds and
frames. The seconds counter advances every 30 frames
for NTSC, or 25 frames for PAL.

Default durations

Transitions: TitlesStills: Yaolume Fades:
02.00 5 = =

= (0400 5 (02.00 5

The three settings here control the initial duration value
for transitions, still images and volume fades when
added to your movie. The durations can be trimmed to
custom values during editing. The default values upon
installation are as shown in the illustration above.

When adding a disc menu

When you place a disc menu on the Timeline, Studio
inquires whether you want to generate chapter links
from the menu to all the clips that follow it (at least
until the next menu). The choices on this dropdown list
let you avoid the confirmation dialog by specifying that
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you always don’t or always do want the links to be
created, or that you want Studio to create links from a
new menu to its chapters and also return links back to
the menu from the end of each chapter. A final option,
“Ask if chapters should be created”, enables the
confirmation dialog, restoring the factory default.

when adding a disc menu. ..

Ask if chapters should be created ﬂ
Dor't create chapters

Create chapters and returns [
sk if chapters should be created W

Minimum chapter length: If you have specified that
Studio should create chapter links automatically when
you add a menu, multiple clips are combined into
chapters if necessary to achieve this minimum duration.

Folder for auxiliary files

Studio generates auxiliary files in many circumstances
as you edit and output your project. These are all stored
under the disk folder specified here. Click the Folder
button to change the auxiliary files’ location — usually
because you need to save space on a particular drive.

Folder For auxiliary files
[ | H:\PontiachRendsr

Delete. ..

Delete: This button opens the Delete Auxiliary Files
dialog, which lets you recover hard drive space by
deleting files created while your project was being
rendered.
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I——————
Video and audio preferences

The five areas on this panel provide hardware and
previewing settings.

Video preview

Because of the central role of previewing during
interactive video editing, Studio provides a number of
settings that affect preview behavior.

Video preview

|~ Enable full-resolution prewview:

|v Enable hardware acceleration

Show full-screen preview on:
|Se-:0nd WiEA monitar j

External:

|N0ne j

For previewing on a computer monitor, the default
preview, at quarter-frame resolution, is probably quite
good enough. If you have exacting requirements for the
preview, and particularly if you are targeting an
external output device for preview (by selecting it on
the External dropdown list), you may need to check
Enable full-resolution preview. On some machines
there may be a noticeable performance cost to this
option.

Enable hardware acceleration takes advantage of the
advanced capabilities of your graphics card where
applicable. The option should be checked unless you
are having display problems during preview.

The Show full screen preview on dropdown list lets you
specify how Studio should preview when you click the
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full-screen button on the Player. The options available
on the list depend on your display hardware.

On a single monitor system, a full-screen preview
(other than external) must obviously use the same
screen as Studio’s own interface. This is the Main VGA
monitor option. In this special instance, full-screen
playback begins from the current play position when
you click the full-screen button, and ends either at the
end of the movie or when you press the Esc key.

|SaFe mode second YGA, small preview j

IMain WG&A monitar
Second WA monitor

Safe mode second Vi&a, small preview

With a dual-monitor computer system, you would
normally use your second screen as a full-size preview
monitor and leave Studio unobscured on your main
screen. The display on the second monitor is controlled
entirely by the full-screen button, independently of
whether your movie is playing back or paused.

The most straightforward option for full-screen preview
is Second VGA monitor. In this mode, the preview is
scaled to use as much as possible of the monitor display
(without disturbing the aspect ratio of the video). The
Player preview on the main screen remains blank,
conserving processing power.

The remaining two options are special modes that are
offered only if your dual-output video card is one of the
following types:

e ATI Radeon 9600 (or better) with version 5.8
(minimum) of the Catalyst™ display driver.

In order to use the additional preview modes, you
must deactivate the second monitor in the Display
Properties dialog (or the Catalyst control center)
before launching Studio.
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e nVidia GeForce Fx5xxx or better, or an equivalent
card in the Quadro series. The minimum driver
versions are 81.85 (GeForce) and 81.64 (Quadro).

Before launching Studio, the second monitor must be
activated as a Windows desktop extension (not in the
Span or Clone modes).

Studio checks on start-up to see if the above conditions
have been met. If they are, the remaining options are
made available:

Second VGA, small preview on main VGA: This option
goes beyond the other full-screen modes by
reconfiguring the monitor display to match the exact
format of your project’s video specifications for frame
format and refresh rate. For instance, if your project
format is 720x480 with the NTSC refresh rate of 60
Hz, the monitor will be put into that mode for the most
accurate possible preview. At the same time, the usual
small Player preview is displayed on the main screen.

Note: Even if you have the correct graphics card, the
desired format may still not be supported by a
particular monitor. If Studio determines that to be the
case, it falls back to the final preview mode (next
paragraph).

Safe mode second VGA, small preview: In this mode,
Studio matches your project video format as well as
possible to the formats supported by the monitor. For
instance, if the 720x480 frame format is unavailable,
Studio will set the display to 800x600 and center the
frame on the monitor screen. Similarly, if the monitor
does not support 50 Hz (PAL) output at a particular
screen size, it will display at 60 Hz instead.
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Voice-over recording

Microphone: A dropdown list of choices for attaching
a microphone to your hardware.

Channels, Sample rate: These settings control audio
quality. A typical setting for voice-overs is 16-bit mono
at 22.05 kHz.

Vaoice-over recording
Microphone:
|Micr0phone - NYIDIA(R) nForce(TM) P.udj

hannels: Sample rate;
[tebicmone »|  [ezoske |

Background rendering

Rendering is the process of generating video for
footage that uses HFX transitions, effects or other
computationally demanding features of Studio. Until
such video has been rendered, it may not display
smoothly and with full detail during preview.

Studio is able to carry out rendering behind the scenes
while you work, a feature called background rendering.

Background rendering

Iv Enable background rendering

" Set codec autornatically
{+ Lse this codec For background rendering:
DV best For output to DY tape j

Current: DY

Enable background rendering: Uncheck this box if
you do not want to use background rendering at all.
One might do this on a slower computer if intensive
rendering were causing other operations to become
sluggish.

Set codec automatically: Let Studio decide which
codec to use for encoding your rendered video.
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Use this codec for background rendering: If you
know that your project is going to DV tape, choosing
DV as your background rendering format may reduce
the rendering time of your final movie. You would
normally choose MPEG for as the rendering codec for
disc-bound movies for the same reason.

Another consideration arises if you are planning to
preview your video on an external device (Studio Plus
only). In such cases you may need to set the project
format and the background rendering codec to suit the
device. For instance, if you are previewing on an
analog monitor plugged into your DV camcorder, you
should do your background rendering in DV.

Surround-sound playback

Check Enable discrete 5.1 playback if the audio system
you use when previewing your Studio project supports
discrete 5.1 audio. Leave it unchecked if you are
previewing in surround-sound with a Pro Logic
compatible system, or in stereo.

Surround sound

I Enable discrete 5.1 surround sound playback

CD drive (for ripping audio files)

If you have used any music from CD in your project,
Studio digitally transfers (“rips”) the audio data from
the disc to the computer. The dropdown list here lets
you select which CD device to use for ripping, if you
have more than one available.

D drive (For ripping audio Files)

_—
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Make Disc settings

These settings allow you to adjust options for creating
VCD, S-VCD or DVD discs, and for creating a DVD
disc image on a hard drive.

To create a VCD or S-VCD requires a CD or DVD
burner; to create a DVD requires a DVD burner.

Format
Disc Type: Select VCD, SVCD or DVD.

Video quality / disc usage: These settings (Automatic,
Best video quality, Most video on disc and Custom) are
available for S-VCD and DVD discs only. The first
three are presets that correspond to particular data rates.
The Custom option lets you set the data rate to another
value. In each case, an estimate is provided of the
amount of video the disc can accommodate at the
current setting.

Kbits/sec: This combination dropdown list and edit
field lets you choose or specify the data rate — and
hence the video quality and maximum duration — of the
disc. Higher values correspond to better quality and
lower capacity.

Audio compression: Choose one of four options for
storing your movie’s soundtrack to DVD:

e PCM encoding for stereo sound is supported by all
DVD players, but takes up more space on the DVD
than MPEG.

e MPEG audio, in MPA (MPEG-1 Layer 2) format, is
always provided on PAL players. On NTSC players
it is broadly supported, but theoretically optional.
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o Dolby ® Digital 2-channel encoding can be used to
compactly store either a stereo or a surround
soundtrack. To hear the surround mix requires
equipment with Dolby Pro Logic compatibility. On
other systems, it will be heard as a normal stereo
mix.

e Dolby ® Digital 5.1-channel encoding stores the
surround channels discretely. To hear the surround
mix on playback requires a surround amplifier and
speaker system.

Use progressive encoding: Each frame of a normal
television picture is displayed as two successive
“fields”, each containing half of the several hundred
horizontal video lines that make up the entire image:
the odd-numbered lines in one field, and the even-
numbered lines in the other. The eye sees the
superimposed fields as a single image.

This system, called “interlaced scanning”, produces
reasonably good results because of the characteristics
of television screens and the human visual system.

However, high-definition TV systems and typical
computer monitors provide “progressive scanning”, in
which the image is drawn from top to bottom at a
higher screen refresh rate, producing a clearer image
with less flicker. If your DVD player and TV support
progressive scanning, or if you are planning to play
back the video only on a computer, checking this box
will provide superior output quality.

Always re-encode entire movie: This option forces
your movie to be completely re-rendered for output. It
is recommended only if you are experiencing problems
with your output movie and want to narrow the
possible sources of error.
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Format

Disc Twpe Yideo quality | disc usage

|DVD j |Aut0matic Cuality j
Audio compression:

| MPA {MPEG-1 Laver 2) j Apprax. 53 minutes of video on disc

Kbitsfsec: I Use progressive encoding

I Always re-encode entire movie

Burn options

Burn directly to disc: Your movie will be burned onto
disc according to the settings in the Format box.

Create disc content but don’t burn: | Bumeetens

This choice is only available when the | @ sundrectytodsc
output format is DVD. Your diSC . crosedsccontent
burner is not used. Instead, the same | ™®m"
files that would normally be saved | © ieasdadcnen
onto a DVD disc are stored to hard
drive as a “disc image”. There are two
formats for disc images. Choose the
one you want in the Media and device options area (see
page 265).

Burn from previously created disc content: This
choice is only available when the output format is
DVD. Instead of using your current project directly to
burn a disc, a previously-created disc image is now sent
to your DVD burner. This lets you divide the work of
creating a disc into two separate steps that can be
performed in separate sessions if desired. It is
particularly useful when you want to make several
copies of the same project, or when you want to
generate the DVD on one computer but burn it on
another.

Iv Eject disc when done

Eject disc when done: Check this box if you would
like Studio to automatically eject the disc after the burn
process has been completed.
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Media and device options

Target media: Choose an entry from this dropdown
list matching the type and capacity of the disc to which
you are burning your project.

Disc writer device: If you have more than one disc
burner on your system, select the one you want Studio
to use.

Copies: Select or enter the number of copies of this
disc that you want to create.

Write speed: Choose one of the available speeds, or
leave this field blank to have the speed auto-selected.

Image type: This dropdown list lets you choose
between the VIDEO_TS folder and ISO file image
types. This choice may be important if you are planning
to access the image with other software.

Media and device options
Current Media:
DWD-R 4.7 GB
Target media: Copies:

|owD 4.7 GB = E =l

Disc writer device: ‘Write speed:
|SONY  DVD R DRU-5104 1.06 | Jae  +|

Irmage bype:

| |
I———
Make File settings

The File Type and Preset lists, which head the Make
File settings panel for all file types, correspond to the
Format and Preset lists in the Output Browser (see
Chapter 12: Making Your Movie). Most file types share
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a common control panel. The Real Media and
Windows Media file types have special-purpose control
panels, covered separately in “Make Real Media file
settings” on page 270 and “Make Windows Media file
settings” on page 273.

The common panel, to be described here, is used by all
the other supported file types: AVI, DivX, MPEG-1,
MPEG-2 and MPEG-4.

The panel lets you manipulate file and compression
settings when the Custom preset has been chosen. Most
of the file types support customization to some degree.

Custom settings may be used to minimize the size of
the output file, to increase its quality, or to prepare it
for a special purpose (such as distribution via the
Internet) where there may be requirements involving
characteristics such as frame size.

Farmat

File Tyvpe: Preset:
|AVI ﬂ |Cust0m ﬂ
Video settings Audio settings
v Include video v Include audio
I List all codecs
Options... Dptions...

Compression: Compression:
|MIPEG | | =
Resolution: Width:  Height: Channels: Sample rate:
Custom | |70 430 |Stereo j |48 kHz ﬂ
Frame Rate: Frames/Sec: Diata rate (Kbitsfsec)
| custom EREES

o+ Quality Percent

+ 4 i)

The common Make File settings panel is shared by all
file types except Real Media and Windows Media. Not
all the options are available for all file types.
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Note: MPEG-2 and MPEG-4 files require special
decoder software. Without a matching decoder
installed on your PC you will not be able to play files
of these types.

Video settings

Include video: This option is on by default. Clearing
the checkbox causes the output file to have audio only.

List all codecs: By default this checkbox is not
checked, so only those codecs are listed that have been
certified by Pinnacle Systems for use with Studio. If
you check the option, all codecs installed on your PC
will be listed, whether certified or not.

Using codecs that have not been certified by Pinnacle
Systems may produce undesirable results. Pinnacle
Systems cannot provide technical support for problems
associated with the use of uncertified codecs.

Options: The Options button opens a codec-specific
option panel if one is available.

Compression: Choose the compressor (codec) that is
most suitable for your intended use. When making an
AVI file, you’ll want to choose your compression
settings for the capabilities of, and codecs supported
by, the intended viewer’s computer platform.

MIPEG |
.

DY

MIPEG

Indeo® video 5,10 Compression Filker
Cinepak Codec by Radius

Intel IndeolR) Yidea R3.2

Inkel Indeo® Yideo 4.5

Indeo® video 5,10

Resolution: This is a dropdown list of presets
providing standard Width and Height options. The
Custom preset lets you set the dimensions directly.
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Width, Height: The frame size is measured in pixels.
The default setting is the resolution at which Studio
captures. Decreasing the width and height greatly
decreases file size.

Resolution: wiidth:  Height:

Custom - | | 720 450

Frame rate: The standard frame rate is 29.97 frames
per second for NTSC, and 25 frames per second for
PAL. You may want to set the frame rate lower for
applications such as Web video. Most computers can
play 352 x 240 at 15 frames per second smoothly, and
many can do much better.

Frame Rate: Frames/Sec:

EREES

Quality, Data rate: Depending on the codec being
used, you can adjust the quality percentage or data rate
with the slider. The higher the percentage or rate you
choose, the larger the resulting file.

(v ;QualityE lﬁ Percent

1 ‘} Q0

Audio settings

If you want to keep file sizes to a minimum, audio for
many digital uses can be set to 8-bit mono at 11 kHz.
As a rule of thumb, try 8-bit 11 kHz for audio that is
mostly speech, and 16-bit stereo at 22 or 44 kHz for
audio that is predominantly music. As a benchmark,
CD-ROM music is 16-bit stereo sampled at 44 kHz.
Another convenient rule of thumb for audio
compression is that 11 kHz is roughly equivalent to
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AM radio quality; 22 kHz equates to FM radio quality;
and 16-bit stereo, 44 kHz is audio CD quality.

Include audio: This option is on by default. Clearing
the checkbox causes the output file to be silent.

List all codecs: By default this checkbox is not
checked: the only codecs listed are those that have been
certified by Pinnacle Systems for use with Studio.
Pinnacle Systems cannot provide technical support for
problems associated with the use of uncertified codecs.

Options: The Options button opens a codec-specific
option panel if one is available.

Compression: The codecs listed here will vary with
the file type. In most cases, you will choose either PCM
(Pulse Code Modulation) or ADPCM (Adaptive Delta
PCM).

Channels: You may choose between 8- and 16-bit
mono and stereo sound. Sound quality and file size
increases when you add a second channel or increase
bit depth.

Sample rate: Digital audio is produced by taking
regular instantaneous samples of the continuous analog
waveform. The more samples, the better the sound. For
example, audio CDs are recorded at 44 kHz, 16-bit
stereo. Audio can be sampled at frequencies as low as
11 kHz for some digital uses, particularly for speech.

Data rate: This dropdown controls the data rate, and
hence the compression ratio, for audio. Higher data
rates yield higher quality at the cost of larger files.

Channels: Sample rate:
|Stereo ﬂ |48 kHz ﬂ

Data rate (Khits{sec)

224 hd
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Force settings to be the same as the project

Click the Same as project button to make your file
output use the same format as the highest resolution
clip in your current project.

Make Real Media file settings

The Make Real Media File options panel allows you to
adjust Real Media file settings. These configure the
creation of files that are to be played back with the
popular RealNetworks® RealPlayer®, free for the
download from www.real.com.

Farmat

File Type: Preset;

Real Media j |Larga j
Data Target audience
Title : Anthor " Dial-up Moderm

Leave it to Thorkney | Tharkney Grilmarket " Single 1SDM
Copytight Keywords : " Dual 150N
| 2005 Tis Productions |comedy, trumpet, fishing trips " Carporate LAN

o

Wideo Quality : Audio Qualiy + 256K DSLCable

Mormal Motion Yideo v |Voice with Background Music j (™ 334K DSLjCable

" 512K DSL{Cable

Wieh server
" Realserver

+ HrTp

Title, Author, Copyright: These three fields are used
to identify each Real Media movie, and are encoded
into it so that they are not visible to the casual viewer.

Keywords: This field accepts up to 256 characters, and
allows you to encode keywords into each movie. It is
typically used to identify the movie for Internet search
engines.
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Video quality: These choices let you balance the rival
requirements of image quality and frame rate.

No video: When this selection is made, the output
file will contain audio only.

Normal motion video: Recommended for mixed
content clips to balance video motion and image
clarity.

Smoothest motion video: Recommended for clips
that contain limited action, such as newscasts or
interviews, to enhance overall video motion.

Sharpest image video: Recommended for high-
action clips to enhance overall image clarity.

Slide show: The video appears as a series of still
photos, providing the best overall image clarity.

Audio quality: This dropdown menu lets you choose
the characteristics of your audio track. Studio uses this
information to select the best audio compression for
your Real Media file. Each successive option provides
better audio quality but a larger resulting file.

No audio: When this selection is made, the output
file will contain video only.

Voice only: This option provides adequate quality
for spoken audio in clips without music.

Voice with background music: This option is
designed for situations where, even though
background music may be present, the spoken audio
predominates.

Music: Use this option for a monaural track in which
music is prominently featured.

Stereo music: Use this option for a stereo music
track.
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Web server: The RealServer option allows you to
create a file that can be streamed from a RealNetworks
RealServer. The RealServer supports a special feature
that senses the connect speed of the viewer’s modem,
and adjusts its transmission rate to suit. The option
allows you to select up to seven Target audience data
rates. Because the file size, and your upload time,
increase with each data rate you add, select only those
target audiences you think are actually needed.

To make use of the RealServer option, the ISP hosting
your web-site must have the RealServer software
installed. If you are unsure, contact your ISP for
confirmation, or use the standard HTTP option, which
allows you to optimize playback for exactly one of the
six Target audience options listed.

Note: GeoCities provides RealServers to their
“homesteaders”.

Target audience: This selects the target audience
modem connect speed. The lower the speed, the lower
the quality of the video. If you wish your viewers to be
able to view your movie as it loads, you should select a
target audience rate that their modems can handle.

When you select a target audience, you are actually
specifying a maximum bandwidth for your RealMedia
stream. Bandwidth, measured in kilobits per second
(Kbps), is the amount of data that can be sent through
an Internet or network connection in a given time span.
Standard modems (those that use ordinary telephone
lines) are classified by the bandwidth they are able to
process. Common values are 28.8 and 56 Kbps.

In addition to these standard audiences, you can record
clips for connection speeds of 100 Kbps, 200 Kbps, or
higher. These higher bandwidths are suitable for
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audiences that use corporate Local Area Networks
(LANs), cable modems or Digital Subscriber Line
(DSL) modems.

Make Windows Media file settings

The Make Windows Media File panel lets you adjust
options for creating Windows Media Player files.

Format

File Type: Preset:
Windows Media j ‘Custom j

Data Markers for Media Player "Go To Batr"
Title: ¢ Author ¢
0=
| Thorkney's Birds | Tharkney Grillmarket Mo markers

" Markers For every dip
Copyright ! Description |

| 32005 TG Productions | The unearthly beauty of (" Markers for pamed clips only
Thorkney's backyard bird
Raking : sanckuary.

o

Profile

windows Media 6 Best Quality based YBR. For Broadband, j

video: 3204240, 30 Frames/sec
Audio:  Whia, 16 bit Stereo, 44.1 kHz

Title, Author, Copyright: These three fields are used
to identify each Windows Media movie, and are
encoded into it so they are not visible to the casual
viewer.

Description: This 256-character field lets you enter
keywords for encoding into the movie. It is typically
used to identify the movie for Internet search engines.

Rating: Entering a rating in this field if it will be
helpful to your viewers.

Profile: Choose the playback quality of your movie
based on the capability of the target platform — the
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computer(s) that will play the movie. The exact audio
and video parameters corresponding to the current
choice are displayed in the space below the list. The
Custom option lets you fine-tune the settings by
selecting from a list of possible combinations.

Prafile
|Wind0ws Media Video & for Broadband (PAL, 700 Kbps) j

‘Windows Media & Best Quality based VBR for Broadband, ~
‘Windows Media 8 Hioh Quality based YBR. for Broadband, I I
‘Windows Media 8§ Fair Quality based VBR for Broadband

‘windows Media Yideo & for Broadband (PAL, 700 Kbps)
windnws Media Yiden 8 For Broadband (PAL, 384 Khns)

Markers for Media Player “Go To” bar: You have
the option of including Windows Media “file markers”
as you compress. These markers allow viewers to go
directly to the beginning of any clip. The markers are
listed by clip name. Clips you have not named get a
Studio default clip name derived from the Project
Name and the clip’s original timecode start point.

Make tape settings

Studio automatically senses the hardware you have
installed, and configures the Make Tape playback
destination accordingly.

Format
Dukput Type Device
DY Camcorder j ‘Sony D Device (DY NTSC) j

Audio

\ [

Dukput options

W Aukomatically stark and stop recording

{Turn this on to automatically send Record
and Stop cammands ko your DY camcorder)

Record delay time:

1 seconds 27 frames
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If you are printing (making tape) to a DV device, you
can choose to have Studio start and stop the device
automatically instead of having to do it yourself.

To control printing automatically:

1.

Click the Make Movie button on the main menu bar.

The upper half of the screen changes to display the
Make Movie window.

Click the Tape tab.

Click the Settings button. The Make tape options
panel opens.

Check the Automatically start and stop recording
box to enable the automatic function.

With most DV devices there is a small delay
between receiving the command to record and the
actual start of recording. In Studio, this is referred
to as the “record delay time”. It varies from device
to device, so you may need to experiment with the
value for best results with your particular device.

Click OK.
Click Create.

Studio renders your movie, then sends the record
command to your DV device. Studio outputs the
first frame of your movie (without audio) for the
duration entered for record delay time, giving the
device time to bring the tape up to speed and begin
recording.

Hint: When you play back your tape, if the first
part of your movie was not recorded, you should
increase the Record delay time setting. On the other
hand, if your movie begins by holding onto the first
frame as though it were a still photograph, you
should decrease the setting.
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Hint: If you wish to send black to your recording
device during its record delay time, place a blank
title in the video track just before the start of your
movie (a blank title is video black). If you wish to
record black at the end of your movie, place a blank
title in the video track following the final frame of
your movie.

Analog output

If you are printing to an analog device, the choice of
Composite or S-Video format may be available if
supported by your hardware.

Output optiohs
Farmat

(+ Composite " Svideo

Output to the screen

One of the options on the Video dropdown in the
Playback devices area is “VGA display”. With this
option, your completed project will be played back
onto your monitor screen rather than to an external
device.
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APPENDIX B:

Tips and tricks

Here are some hints from Pinnacle technical specialists
on choosing, using and maintaining a computer system
with video in mind.

I
Hardware

To use Studio effectively, your hardware should be
optimally prepared and configured.

It is recommended that you use UDMA IDE drives as
they provide reliable video transfer performance with
Studio. We highly recommend you capture to a hard
drive other than the one upon which Windows and the
Studio software are installed.

Since recording video sequences in the DV format
requires a data transfer rate of approximately 3.6 MB
per second, your hard drive should maintain a
performance level of at least 4 MB/s. Higher transfer
rates will ensure reliability and help avoid problems
with output to tape.

You can calculate the amount of hard drive space
you’ll need for your video using the 3.6 MB/sec value.
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For example:

1 hour of video = 3600 seconds (60 x 60)
3600 seconds x 3.6 MB/s = 12,960 MB
Hence 1 hour of video uses 12.9 GB of storage.

Due to their automatic internal calibration, standard
hard drives regularly interrupt the continuous data
stream in order to recalibrate themselves. During
capture, this is not apparent since images are
temporarily stored in memory. But during playback,
only a limited number of images can be temporarily
stored in this manner.

For smooth playback, a continuous, uninterrupted data
stream is required. If not, the image will “jerk” at
regular intervals, even though all frames are present
and even if the hard drive is very fast.

Preparing your hard drive
Prior to capturing video, you should:

o Close background applications. Before opening your
Studio product, hold down the Ctrl and Alt keys on
the keyboard, then hit Delete. This will open the
Close Program window. Click on the individual
applications listed in the Close Program window and
click the End Task button. Do this for all
applications listed in the Close Program except
Explorer and SysTray. Software utilities are
available that can help with this procedure.

e Click on Start » Programs > Accessories » System
Tools » ScanDisk
Make sure Thorough is checked, and click Start (this
may take a while).

e After ScanDisk is done, click on Start » Programs
» Accessories » System Tools » Disk Defragmenter
(this may take a while).
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e Turn off energy-saving features. Point your mouse
on your Desktop, right-click, and select Properties »
Screensaver (under Energy... Settings). Make sure
everything under Settings for... power schemes is set
to Never.

Note: Video-editing programs do not multitask very
well. Do not use any other program while making
movie (videotape or CD) or capturing. You can
multitask while editing.

RAM

The more RAM you have, the easier it is to work with
Studio. You will need at least 512 MB of RAM to work
with the Studio application, and we highly recommend
1 GB (or more).

Motherboard
Intel Pentium or AMD Athlon 1.4 GHz or higher — the
higher the better.
e

Software

Color depth adjustment

1. 16-bit color depth is recommended.

2. Position your mouse over your Desktop, right click,
and select Properties > Settings.

3. Under Colors, choose High Color (16-bit).
The overlay settings affect only the display on the
computer monitor, while recorded sequences will

always appear in full color and resolution at the video
output.
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Increasing the frame rate

If your system is unable to achieve an adequate frame
rate (25 fps for PAL/SECAM, 29.97 fps for NTSC), try
the ideas in the following paragraphs.

Deactivate network driver and applications

Network operations may interrupt recording and
playback. We recommend not working in a network.

Audio recording

Record audio only when you actually need it, because
sound requires a great deal of processor time during
video recording We recommend a PCI soundboard.

Digital video with audio

When recording digital video sequences with audio,
remember that the audio also takes up hard drive space:

e CD quality (44 kHz, 16-bit, stereo) requires about

172 KB/sec.;

e Stereo quality (22 kHz, 16-bit, stereo) about 86
KB/sec., and

e Mono quality (22 kHz, 8-bit, mono) still requires 22
KB/sec.

The better the sound quality, the more space is
consumed. The highest quality (CD) is rarely required.
However, the lowest quality (11 kHz/8-bit, mono)
rarely provides acceptable audio sequences.
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I——————
Studio and computer animation

If you are editing computer animation with Studio or
wish to combine animation with digital video,
remember to create your animations using the same
frame size and image refresh rate as your original

video:
Quality | TV-Cropping | PAL | NTSC | Audio
DV | Yes | 720 x576 | 720 x 480 | 44 kHz 16-bit stereo

Failure to do this will result in unnecessarily long
rendering times and the possibility of visible flaws
when the animation is played back.
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APPENDIX C:

Troubleshooting

Before you begin troubleshooting, take some time to
check your hardware and software installation.

Update your software: We recommend installing the
latest operating system updates for Windows XP. You
can download these updates from:

windowsupdate.microsoft.com/default.htm

Make sure you have the latest version of the Studio
software installed by clicking the Help > Software
Updates menu from within the program. Studio will
use the Internet to check for possible updates.

Check your hardware: Ensure that all installed
hardware is functioning normally with the latest
drivers, and is not flagged as having a problem in the
Windows Device Manager (see below). If any devices
are flagged you should resolve the issue before starting
installation.

Get the latest drivers: We also highly recommend
installing the latest drivers for your sound card and
graphics card. During the Studio software launch
process we do verify that your sound card and video
card support DirectX.

Go to the manufacturers’ web-sites to get the latest
drivers for your sound and graphics cards. Many users
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have NVIDIA or ATI graphics cards, for which the
latest drivers are available at:

www.nvidia.com and www.atitech.com

Those with Sound Blaster audio cards can get updates
here:

us.creative.com

Opening Device Manager

The Windows XP Device Manager, which lets you
configure your system’s hardware, has an important
role in troubleshooting.

The first step in accessing Device Manager is to right-
click on My Computer, then select Properties from the
context menu. This opens the System Properties dialog.
The Device Manager button is on the Hardware tab.

@ TECHNICAL HELP ON-LINE

The Pinnacle Support Knowledge Base is a searchable
archive of thousands of regularly-updated articles about
the most common questions and issues users have
regarding Studio and other Pinnacle products. Use the
knowledge base to find answers to any questions you
may have about installing, using or troubleshooting
Pinnacle Studio.

Access the knowledge base with your web browser by
visiting:

http://www.pcle.com/selfhelp
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The knowledge base home page will appear. You don’t
have to register to browse the knowledge base, but if
you want to send a specific question to technical
support staff you will need to create a knowledge base
account. Please read any knowledge base articles
relevant to your inquiry before contacting technical
support.

Using the knowledge base

In the Product dropdown, select “Studio Version 10”.
If appropriate, you can also select a Sub-Product, a
Category, or both. Selecting a sub-product or category
may reduce the number of irrelevant hits you will get
from your search, but may also eliminate helpful
articles of a more general nature. If you’re not sure
what category to pick, leave the selection at All
Categories.

To search for an article, type a short phrase or group of
keywords in the text box. Don’t get too wordy; the
search works best when given just a few words.

Search example

In the list below of common troubleshooting issues, the
first item is, “Studio crashes or hangs in Edit mode”.

Type “Crash in edit mode” in the search box and click
the Search button. You should get back somewhere
between 60 and 150 hits. The very first one, “Studio
crashes in Edit”, lists the known causes for this issue
and their remedies.

If you search instead on the single keyword “Crash”,
you will get far fewer hits, all relating to crashes in
Studio.
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If one search does not turn up an article that seems
relevant to your problem, try modifying the search by
choosing a different set of keywords. You can also use
the Search by and Sort by options to select for specific
or popular articles.

Searching by Answer ID

If you know the Answer ID number of the answer
you’re looking for, you can access the item directly.
For example, if you are getting a capture error when
you press the Capture button, someone might refer you
to knowledge base article 2687, “I am getting a capture
error with Studio”. In the Search by dropdown, select
“Answer ID”, enter the ID number in the text box, and
click Search.

Top knowledge-base search issues

1. Studio crashes in Edit mode (ID 6786).

2. Capture error appears when attempting to start
capture (ID 2687).

3. Studio hangs when rendering (ID 6386).
4. CD or DVD burner is not detected (ID 1593).

5. Studio hangs on launch or does not launch (ID
1596).

6. HollywoodFX transitions are still watermarked
after upgrading (1D 1804).

7. “Cannot initialize the DV capture device” error
appears in Capture mode (ID 2716).

The information on the following pages is based on
these often-viewed knowledge base articles.
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Studio crashes in Edit mode

Answer ID 6786

If Studio is crashing, the cause is most likely either a
configuration issue or a problem with a project or
content file. This type of issue can often be fixed with
one of the following methods:

e Uninstalling and reinstalling Studio.

e Optimizing the computer.

e Rebuilding a corrupt project.

e Recapturing a corrupt clip.

To help troubleshoot the problem, determine which of
the failure modes listed below best matches the

symptoms you are experiencing, then refer to the
corresponding set of instructions:

e Case 1: Studio crashes randomly. There doesn’t
seem to be any one thing that will cause the crash,
but crashes happen frequently.

o Case 2: Studio crashes every time you click on some
particular tab or button within Edit mode.

e Case 3: Studio crashes each time you carry out some
specific sequence of steps.

Case 1: Studio crashes randomly
Try each of the following solutions in turn:

Get the latest version of Studio: Make sure that you
have the latest version of Studio 10 installed. The latest
version can be found on our website at:

http://www.pinnaclesys.com/support/studiol10
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Be sure to close all other programs before installing a
new version.

Adjust Studio settings: Choose No background
rendering in the Rendering dropdown list, and clear the
Use hardware acceleration checkbox. Both options are
found on the Edit options panel (see page 253).

End background tasks: Close other applications and
unload any background processes before using Studio.

Press Ctrl+Alt+Delete to open the Task Manager. You
probably won’t see much under the Applications tab,
but the Processes tab will show you the software that is
currently running. It can be difficult to be sure which
processes should not be closed, but software utilities
are available that can assist with this procedure.

Defragment your hard drive: Over time, the files on
your hard drive can become fragmented (stored in
multiple parts in different areas of the drive), which
slows down access and may lead to performance
problems. Use a disk defragmenter utility like the one
supplied with Windows to prevent or correct this
problem. Access the built-in defragmenter with the
Disk defragmenter command on your Programs »
Accessories » System tools menu.

Update audio and video drivers: Make sure that you
have obtained the latest drivers for your sound and
video cards from their manufacturers’ web-sites. You
can see what sound and video cards you have in the
Windows Device Manager.

To determine what video card you have, click the plus
sign in front of Display Adapters in the Device
Manager list. The name of your video card is now
displayed. Double-clicking the name opens another
dialog, where you choose the Driver tab. Now you can
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view information about the driver’s manufacturer, and
the names of the driver’s constituent files.

The sound card is displayed in the Sound, video and
game controllers section of Device Manager. Again,
double-clicking the name lets you access the driver
details.

Update Windows: Make sure you have all the latest
Windows updates that are available.

“Adjust for best performance”: Use this system
option to turn off visual extras that consume additional
CPU time. Right-click My Computer, select Properties
from the context menu, then click on the Advanced tab.
Under Performance, click the Settings button to open
the Performance Options dialog. Select the Adjust for
best performance option and click OK.

Update DirectX: Update to the latest version of
DirectX. You can download it from Microsoft here:

www.microsoft.com/windows/directx

Open up space on your boot drive: Make sure you
have 10 GB or more free space on your boot drive for

paging.

Uninstall, reinstall and update Studio: In case your
Studio installation has become corrupted, try this
procedure:

1. Uninstall Studio: Click on Start » Programs >
Studio 10 » Tools > Uninstall Studio 10, then
follow any on-screen instructions until the process
is complete. If the uninstaller asks whether you
want to delete a shared files, click Yes to all.
Disconnect the camera and cable from your DV
board, if you have one.
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2. Reinstall Studio: Insert your Studio CD and
reinstall the software. Make sure you are logged in
as the Administrator (or as a user with Admin
privileges) when installing Studio. It is strongly
recommended that Studio be installed in its default
directory on the main OS drive.

3. Download and install the latest version of Studio:
Click the Help > Software Updates menu
command to check for updates. If a new version of
Studio is detected on our web-site, you will be
asked to download it. Download this patch file to a
location where you can find it easily (such as the
Desktop), then exit Studio. Finally, double-click the
downloaded file to update Studio.

Rebuild corrupt project: Try rebuilding the first few
minutes of your project. If no problems occur,
gradually add to the project, checking periodically to
ensure that system stability is maintained.

Fix corrupt video or audio: Sometimes the instability
may occur only when you manipulate certain audio or
video clips. In such cases, you should recapture the
audio or video. If the audio or video was created by
another application, recapture it with Studio if possible.
While Studio supports many video formats, the
particular clip you have may be corrupt or in an
uncommon format. If you have a wav or mp3 file that
seems to be problematic, convert the file to the other
format before importing the file. Many wav and mp3
files on the Internet are corrupt or non-standard..

Reinstall Windows: This is quite a drastic step, but if
the previous steps have not helped, Windows itself may
be corrupt. Even though your other applications may
appear to be running properly, the size of the video
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files used in Studio may well tax your system to the
point that a latent instability is revealed.

Case 2: Clicking a tab or button crashes Studio

Please start by trying the steps given above for Case 1.
This kind of problem often means that Studio was not
installed properly or has become corrupt. Uninstalling
Studio, reinstalling it, and patching to the latest version
will generally solve the difficulty.

Otherwise, try creating a new project called
“test01.stu” to try to determine if the failure is specific
to a particular project. Open the demo video file and
drag the first few scenes onto the Timeline. Now click
on the tab or button that seems to cause the failure.

If this test project does not crash, it may be that the
problem is with the project you are working on rather
than with Studio or your system.

If the test project does fail, please contact our support
staff and provide us with the details on the exact failure
mode. We will try to recreate and solve the problem.

Case 3: Performing certain steps crashes Studio

This is just a more complicated version of Case 2, and
the same troubleshooting steps apply.

Since it may be quite difficult to determine the exact
sequence of steps that produces the failure, you will
need to be methodical in your approach. Creating a
small test project, as described for Case 2, helps
eliminate variables that may confuse your test results.
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Capture error occurs on starting capture

Answer ID 2687

Some problems can be traced to incompatibilities or
issues with particular third-party capture cards:

e ATI: Studio should work with most All In Wonder
cards.

e Hauppauge: Please see the FAQ on our web site for
information regarding Hauppauge cards.

e nVidia: Studio should work with most nVidia card
that are designed for video capture.

Troubleshooting steps

The initial goal, before you capture, is to see video

playing in the preview window.

1. Check capture source settings in Studio. Since you
may have more than one capture device in your
system (1394 cards, TV tuners, webcams, etc.) you
must be sure to select the correct capture source. In
Studio’s Capture Mode, click the Settings button,
then click the Capture Source tab on the Setup
Options dialog. Select your video capture device on
the Video dropdown list.

If the option for your desired capture device is not

listed then go to the Windows Device Manager. If

the capture driver for your capture device is flagged
or not listed, reload the capture driver as follows:

e Pinnacle drivers: Use the CD to locate and install
the Pinnacle drivers for the card you have
installed.

e Third party drivers: Use the CD that came with
the capture device or call the manufacturer (or
visit their web-site) for the most current driver.
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2. If you are capturing from an analog source, make
sure the correct analog type is selected. In the
Diskometer window (in Studio’s Capture mode),
click the left tab to open the fly-out panel of analog
video settings. Select Composite or S-Video.

If the correct item is already selected, select the
other one, then toggle back to the correct one after a
few seconds. This can help reset Capture mode to
properly detect the input signal.

3. If you are capturing from an analog source, check
your cabling. It should match the Composite or S-
Video setting you selected above. If possible, try a
different cable, tape and VCR to see if the problem
can be traced to one of those components.

4. Make sure the player heads are clean, and that the
tape is in good condition. Make sure all physical
connections are secure.

5. If you are capturing from an analog source, you will
need to press the play button on the source deck
before capturing — there are no on-screen controls.
If your player is not playing when you click the
Capture button, you will get a Capture Error.

If you continue to get a Capture Error after trying the
above steps, please test your setup with the AMCAP
capture application. AMCAP is a generic application
used to test device compatibility. If you can’t capture
with AMCAP, your capture card probably doesn’t have
the right driver for your version of Windows.

To use AMCAP:
1. Click Start » Programs » Studio 10 > Tools »
Am Capture.

2. In the AMCAP window, select your capture device
on the Devices menu.
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3. Clicking the Options > Preview menu command
should show video in the AMCAP window if the
cabling is correct and the source (camcorder, VCR,
etc.) is turned on. To capture, click on the Capture
menu and select Start Capture. There may be some
selections for setting up your capture card.

Note: AMCAP will not work with capture devices that
have hardware MPEG encoders (e.g., MovieBox USB,
PCTV Deluxe, MP20, and the TDK Indi device).

In the unlikely event that you cannot capture in Studio
with your capture card even after all troubleshooting
steps have been tried, you can work around the problem
by capturing outside of Studio then importing the
captured video into Studio for editing and output.

Studio hangs when rendering

Answer ID 6386

With this type of problem, Studio “gets stuck” during
rendering (preparing your video for output in Make
Movie mode). To identify the solution in a particular
case, try the troubleshooting steps for whichever of the
following failure modes best matches your situation:

e Case 1: Rendering stops immediately after it starts.

e Case 2: Rendering stops randomly in a project. It
typically does not stop in the same spot if rendering
is attempted multiple times.

o Case 3: Render stops at the same spot in a project no
matter how many times rendering is attempted. This
failure mode has more than one possible cause.
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Case 1: Rendering stops immediately

If the hang occurs immediately upon clicking the
Create button, there is some configuration problem on
your system. Try rendering the supplied demo video. If
this fails, the problem is confirmed as a system issue,
since we have not been able to reproduce a render
problem with the demo file during our in-house testing.

Possible solutions:

Uninstall and reinstall Studio.

Uninstall other software that might conflict with
Studio (other video editing software, other video
codecs, etc.).

Make sure that you have installed any available
Windows service packs.

Reinstall Windows over itself (that is, without
uninstalling first). In Windows XP, this procedure is
called Repair.

Case 2: Rendering stops randomly

If the render hangs at random points even within the
same project, the failures may be due to background
tasks, power management or a thermal problem in the
computer.

Possible solutions:

Check your hard drive for errors and defragment it.

End any background tasks, such as virus checkers,
drive indexers and fax modems.

Turn off any power management.
Install cooling fans in the computer case.
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Case 3: Render always stops at the same point

If rendering always hangs at the same spot in a
particular project, see if other projects have the same
problem. If not, the problem project could be corrupt; if
they do, try to isolate a common factor.

Finding a solution to this type of failure is much easier
if you can identify a particular item in the project that is
causing the rendering to stop. Removing the item or
trimming it may allow the rendering to complete,
though in some cases the failure may simply turn up
elsewhere in the project.

Some possible solutions and workarounds:

1. Look at the clips in the project for corrupt video
frames. These may show up as gray, black, blocky
or distorted frames. If you find any, trim the clip to
exclude the offending frames. You could also try
recapturing the footage.

2. Defragment your hard drive.

3. Ensure that you have ample storage — preferably
tens of gigabytes — on the hard drive you use for
video. Rendering may use large amounts of storage,
and can be disrupted if space is insufficient.

4. If you have a separate capture drive, make sure to
move the auxiliary files folder to that drive.

5. Copy the section where the render stops and put it
into a new project. Include 15 to 30 seconds on
either side of the error. Try rendering this excerpt to
an AVI file and, if successful, use the file to replace
the offending section of the original project.
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6.

Render the entire project to an AVI file, then create
a new project and import the file. If you are making
a disc, you will need to add your chapter marks and
menus to the new project. This workaround works
best with NTFS partitions to avoid the 4 GB file
limit in FAT32 partitions (allowing only 18 minutes
of DV video).

It is possible to convert an existing FAT32 hard drive
partition to NTFS without reformatting, and so avoid
the 4 GB file-size limitation. The following procedure
is for the c: drive. For other partitions, simply
substitute the correct drive letter (e.g. d or f) in steps 4
and 5.

To convert a FAT32 partition to NTFS:

1.
2.
3.

Click the Windows Start button.

Select the Run... command.

Type cmd into the Run dialog, and click OK.
A command window appears.

Type vol c: at the prompt, press Enter, and note the
displayed volume label (“PinWin” in the
illustration below).

Type convert c: /fs:ntfs and press Enter.
B C:\WINDOWSsystem32cmd.exe - cmd

Microzoft Windows XP [Uersion 5.1.26801
(C> Copyright 1985-28W1 Microsoft Cowrp.

C:\HINDOHS\sygtem32>unl_c:

Uolume in drive C is n
Uolume Serial Mumber is 6E84A-4DSF

C:sWINDOWS“system32 >convert c: sfs:ontfs

This initiates the conversion from FAT32 to NTFS.
When prompted, enter the volume label noted in the
previous step.
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CD or DVD burner is not detected

Answer ID 1593

If Studio cannot locate your disc burner when you want
to create your disc project, you should get the error
message, “No disc writer device found!” It may be
either Studio or Windows that is failing to recognize
the drive. If it occurs following the installation of a
patch to Studio, it is likely that the patching process did
not work correctly; in that case, uninstall, reinstall and
update Studio as described in item 2 below.

Some possible solutions and workarounds:

1. Verify that the burner is listed in Device Manager.
If it is not, review your burner’s documentation or
contact the manufacturer to get the device installed
properly.

2. Uninstall and reinstall Studio from your original
CD, then update it with the most recent patch. See
page 289 for instructions.

3. Check the disc burner manufacturer's web-site for a
firmware update. You can find the firmware version
for your burner on its properties dialog in Device
Manager.

4. In Device Manager again, check the hard drive
controller to see if it is a VIA controller. VIA’s
web-site is:

www.viaarena.com/?PagelD=2

5. If you have other disc burning software, such as
Nero, Adaptec or Roxio Easy CD Creator, try
upgrading that software to the latest version. If
Studio still can’t detect the drive, uninstall the other
disc burning software and try again.
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Studio hangs on launch or won’t launch

Answer ID 1596

Problems on launch can manifest in various ways.
Studio may give an error message when launching, or it
may freeze in mid-launch, or it may “hang” - fail to
return control to you — after what had seemed an
uneventful launch.

In all such cases, try any or all the following:

1. Restart the computer. After the reboot, double-click
the Studio icon.

2. Wait a few minutes to confirm that the application
is really hung. Even when you suspect Studio has
failed to launch, wait a few minutes more just in
case. On some computers, the launch process may
take longer to complete than you anticipate.

3. Uninstall and reinstall Studio. (See page 289 for
instructions.)

4. Download and reinstall the driver for your sound
card. Remember that the sound card must support
DirectX.

5. Remove the sound card from the system. Some
older sound cards may not work well with newer
versions of Windows. This can be verified by
shutting down the computer, removing the sound
card and restarting. If Studio now launches, you
probably need to replace the sound card (assuming
you have updated to the latest drivers as suggested
in the previous step).

6. Download and reinstall the software for the
graphics card. Remember that the card must support
DirectX.
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“Cannot initialize the DV capture device”
error appears in Capture mode

Answer ID 2716

The error message reads in full: “Pinnacle Studio
cannot initialize the DV capture device. Please ensure
that the camcorder is connected and the power is on.”

This error message occurs only when you are capturing
from a digital source (DV or Digital8 camcorder)
plugged into the DV port (also called a “FireWire” or
“1394” port).

If you are capturing from an analog source:

e You need to correct your capture source setting. In
the Capture devices box on the Capture source
options dialog, notice that Video and Audio are set to
“DV Camcorder — Pinnacle 1394”, the default
setting. To capture from an analog source, select the
applicable devices in both lists.

e Many analog capture cards lack an audio in jack, so
you must both set the audio capture device in Studio
to your sound card's line in, and cable the analog
audio source (VCR or analog camcorder) to the line
in jack on the sound card.

Possible solutions if you are capturing from a digital
source:

1. Verify that the camera is in VTR/VCR mode. For
capturing, the device should be running on AC
power, not batteries.

2. Disconnect and reconnect the 1394 cable. Make
sure you are not mistakenly using a USB cable
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connected to a USB port. Studio will not capture
from a DV or Digital8 camcorder unless it is
connected via the DV port.

3. Turn the camcorder off then back on. The mouse
pointer should briefly turn to an hourglass when
you turn on the camcorder as the device is detected
and Windows loads the driver. By default,
Windows XP will display a message when the
power to the camcorder is cycled.

4. Shut down the computer and move the 1394 capture

card into another PCI slot. If you don't have an
available slot, swap the capture card with a card in
a different slot. Restart the computer.
The Windows hardware wizard should detect the
“new” hardware automatically. Follow any on-
screen instructions to finish loading the driver if
any appear. Check Device Manager to see if the
driver loaded properly.

5. Verify that the 1394 port and the DV/D8 camcorder
drivers are both loaded properly in Device
Manager. See “Checking the drivers” immediately
below.

Checking the drivers

To check your 1394 and DV drivers:

1. Open the Windows Device Manager. (See page 284
for instructions on accessing Device Manager.)

2. You should not have any drivers with the yellow
exclamation mark error flag {2} on them. If you do,
the driver that is flagged is not loaded properly and
will not work correctly.

3. The driver for the card is an OHCI-compliant
IEEE-1394 host controller driver and is listed under
the heading IEEE 1394 Bus host controllers.
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4. The driver for the camcorder, when loaded
properly, is listed under the heading Imaging
Devices.

Click the Uninstall button ¥ in the Device
Manager toolbar, then the Scan for hardware
changes button .

5. The driver should reload properly. It should not
need to ask for the Windows CD, but if it does,
follow the on-screen instructions.

If no error flags are displayed...

Both drivers may be present without any error flags.
We recommend that you then uninstall and reload both
drivers as follows:

1. Uninstall the DV camcorder driver.

2. Disconnect your DV or Digital8 camcorder from
the 1394 port.

3. Uninstall the OHCI-compliant 1394 host controller
driver.

. Reinstall the host controller driver.
5. Reconnect your DV or Digital8 camcorder.

Your camcorder should be automatically redetected
and the driver reloaded.

Repairing your Windows installation

If you continue to get the *“cannot initialize” message
after trying all the steps above, it may be that the 1394
drivers built into Windows are corrupt. We recommend
that you reinstall Windows on top of itself (i.e. without
uninstalling first). For this you will need to run the
Windows installer from your original Windows CD. In
XP, this procedure is called Repair. We recommend
that you contact your computer manufacturer for help if
required.
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® INSTALLATION PROBLEMS

| am getting an error installing Studio from CD

Solution 1: Restart the computer. After the computer
has finished restarting, try to install Studio again.

Solution 2: Inspect the CD for scratches, fingerprints
or smudges. Clean off the CD with a soft cloth if
necessary. Install Studio again.

Solution 3: End background tasks. Here’s how:

Use the End Process button in the Windows Task
Manager, or use one of the available software utilities
designed to assist with this procedure.

To keep applications from loading when your PC is
started (or rebooted):
1. Click on Start » Run
2. In the Open box, type: msconfig
3. Click OK
In the System Configuration Utility window, click
on the far right tab called Startup. Remove all

checks from the boxes except for Explorer and
System Tray (SysTray.exe).

Hardware not found during installation.

Possible cause: The PCI slot in which the hardware is
installed was not assigned an IRQ in the BIOS or it
may be sharing an IRQ with another device. It may also
be that the card is not seated completely into the PCI
slot.
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Solution: Try reseating the card in its original slot or in
a different one. In most cases, you may be able to get a
different IRQ assignment by simply shutting off the
computer and installing the DV card or other hardware
in another slot.

& OPERATION PROBLEMS

Images are missing from the recording, or the
video is jerky.

Possible cause: Your hard drive’s transfer speed is too
low.

Solution: When working with some UDMA hard
drives, the playback may “jump” when an AVI file is
played back at higher data rates. This can be traced
back to the fact that the hard drive carries out a
recalibration while reading the file, thus interrupting
playback.

This problem is not caused by Studio, but is the result
of the manner in which the hard drive operates and
interacts with other system components.

There are several solutions you can use to increase the
speed of your hard drive:

1. End task on background applications. Before
opening your Studio product, hold down the Ctrl
and Alt keys on the keyboard, then hit the Delete
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key. This will open the Close Program window.
Click on the individual applications listed in the
Close Program window and select End Task. Do
this for all applications listed in the Close Program
window except Explorer and SysTray.

2. Click on Start » Programs » Accessories »
System Tools » ScanDisk.

3. Make sure Thorough is checked, and click Start
(this may take a while).

4. After ScanDisk is done, click on Start > Programs
» Accessories » System Tools » Disk
Defragmenter (this may take a while).

5. Turn off energy-saving features (right-click on your
Desktop and select Properties > Screensaver
(under Energy... Settings). Make sure everything
under Settings for... power schemes is set to Never.

6. Go to Start > Settings » Control Panel > System.
Click on the Performance tab, then File System,
then the Troubleshooting tab.

7. Click to the left of the Disable write-behind
caching for all drives option to select it and click
OK.

8. Under the hard-disk tab, set the Read-ahead
optimization option to None.

In general, this will result in an increase in the data
transfer rate. Caution: In some hard drives, it can
result in a decrease in the write rate!

Note: Video-editing programs do not multitask very
well. Do not use any other program while making
movie (videotape or CD) or capturing. You can
multitask while editing.
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There is no video in the Player preview.

Solution 1: Change video resolution and/or color depth
on the Display Properties dialog:

1. Right-click your Desktop and select Properties,
then click the Settings tab on the dialog.

Under Colors, try each of 16-bit, 24-bit and 32-bit.

3. Under Screen resolution, again try each available
setting from 800x600 upwards.

Solution 2: You may be using either a generic
Windows graphics card driver or an older version of
your graphics card. Your graphics card driver may also
be corrupt. Please contact your graphics card vendor to
ensure you have properly installed the most current
driver. Reinstall your graphics driver with the help of
your video card manufacturer’s technical support, or
download and install the latest driver from the
manufacturer’s web-site.

Solution 3: You may not have DirectX installed
properly. Go to Start > Programs > Studio » Help >
DirectX Diagnostic Tool. On the Display tab, click the
Test button next to Direct Draw. After running that test,
run the Direct 3D test. If your card fails either of these
tests, please contact your graphics card vendor for
support.

Note: Please visit our web-site for additional help with
troubleshooting DirectX issues, include specific
solutions for particular capture hardware.

When | output to tape the video and/or audio
stutters or is absent.

Background: There are many possible causes for this
kind of problem. To understand why, consider that the
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data coming from and flowing to your camera is
vulnerable to interference at any stage along its
journey.

Digital data travels from the camcorder through the
IEEE-1394 cable, into the 1394 card and onto the
system main board. It now crosses to the hard drive
cable and up to the hard drive, where it is finally
recorded. Outflowing data makes the same trip in
reverse. Any process that disrupts or delays the flow of
data at any point is a potential source of video output
problems.

Solution 1: Make sure that you are losing no frames
during video capture. Dropped frames during capture
may result in problems during output as well. Capture
problems have a different set of troubleshooting
options. See the Pinnacle knowledge base on our web
site at:

www.pinnaclesys.com/support/studio9

Solution 2: Save your current project, close all your
applications, and restart the system. When Windows
comes back, open your project in Studio without
running any other programs, and try to output to tape. If
the issues persist, try the next solution.

Solution 3: Tune your system:

o Remove wallpaper from the Desktop.

e Remove temporary Internet files from the system
and empty the Recycle Bin.

e Check the system for viruses.

e Turn off any screen savers, and disable any power-
saving features of the operating system or the BIOS.
Most power-saving features can be accessed via the
Power Options icon in Control Panel.
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e Some systems have further power-saving features
that can only be disabled in the BIOS. Please refer to
your system’s documentation for more information.

e Some USB devices — scanners, webcams etc. — can
interfere with other types of software including
video-editing applications like Studio. As a
troubleshooting measure, these devices should be
temporarily removed.

Solution 4: Improve hard drive efficiency.

e Use a separate capture hard drive: When working
with digital video, the use of a second, separate hard-
drive for captured video data is recommended. This
eliminates the problem of Windows competing with
Studio for the capture drive — for instance, when it
updates the system swap file.

e Defragment the hard drive: Hard drives become
“fragmented” with use, meaning that files are stored
inefficiently in small chunks rather than as a single
block. This can slow file access significantly, so it is
important to defragment the hard drive on a regular
basis. The Disk Defragmenter utility can be found in
the Accessories » System Tools folder on the Start
menu of most Windows installations.

e Check hard drive data rates: The Pinnacle video-
editing software has a built-in test that measures the
speed at which the capture drive transfers data. If the
drive is not running at optimum performance levels,
some video-editing operations may fail.

To run the hard drive data transfer rate test:

e Click on Setup » Capture Source. In the lower right
of the setup box, click the Test Data Rate button.

The hard drive test will run. On most systems, data
rates will be between 25,000 and 35,000 Kbytes/sec.
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Note: If you make changes to the system that increase
the speed of the capture hard drive — such as enabling
DMA - you will need to run the hard drive data rate
test again so that the software will recognize the
change.

Solution 5: Use our PPE utility.

Use Pinnacle’s PCI Performance Enhancer utility,
which is installed on the Tools submenu under Studio’s
entry on your Start > Programs menu.

Solution 6: Update the hard drive controller driver.

In Device Manager, check the hard drive controller to
see if it is a Via controller. If it is, get a driver update
from the vendor’s web-site:

www.viaarena.com/?PagelD=2
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APPENDIX D:

Videography tips

To shoot good video, then create from it an interesting,
exciting or informative movie, is something anyone
with a little basic knowledge can achieve. Starting from
a rough script or shooting plan, the first step is to shoot
your raw video. Even at that stage, you should be
looking ahead to the editing phase by making sure you
will have a good set of shots to work from.

Editing a movie involves juggling all your fragments of
footage into some kind of harmonious whole. It means
deciding on the particular techniques, transitions and
effects that will best express your intent. An important
part of editing is the creation of a soundtrack. The right
sound — dialog, music, commentary or effect — can
work with the visuals to create a whole greater than the
sum of its parts.

Studio provides the tools to create professional-quality
home video. The rest is up you — the videographer.

00|
Creating a shooting plan

It is not always necessary to have a shooting plan, but it
can be very helpful for large video projects. The plan
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can be as simple or as complex as you like. A simple
list of planned scenes might be enough, or you might
also want to include some notes regarding detailed
camera directions or prepared dialog. The really
ambitious can go all the way to a full-fledged script in
which every single camera angle is described in detail
along with notes about duration, lighting and props.

Title: “Jack on the kart track”

No. Camera angle Text / Audio Duration  Date

1  Jack's face with helmet,  “Jack is driving his
camera zooms out first race...” 11 sec Tue.

e 06/22
Noise of engines in
the background.

2 Onthe starting line, Music is played in 8 sec Tue.
driver's perspective; low the hall, noise of 06/22
camera position. engines.

3 Man with a starting flag is “Let's go...".
accompanied into the Carry out the start, 12 sec Tue.
scene to the start add starting signal. 06/22
position. Camera stays,
man goes out of the
scene after start.

4 Jack on the start position Music from the hall
from the front, camera no longer audible, 9 sec Tue.

06/22

follows, shows Jack up to
the bend, now from
behind.

fade up same music
from CD over noise
of engines.

Draft of a simple shooting plan

Editing

Using varying perspectives

An important event should always be shot from varying

perspectives and camera positions.

Later,

during

editing, you can use the best camera angles alone or in
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combination. Make a conscious effort to tape events
from more than one camera angle (first the clown in the
circus ring, but then also the laughing spectator from
the clown’s point of view). Interesting events can also
take place behind the protagonists or the protagonists
may be seen in a reverse angle. This can be helpful
later when trying to establish a sense of balance in the
movie.

Close-ups

Don’t be stingy with close-ups of important things or
persons. Close-ups usually look better and more
interesting than long shots do on a television screen,
and they work well in post-production effects.

Long shots / Semi-long shots

Long shots provide the viewer with an overview and
establish the scene of the action. However, these shots
can also be used to tighten longer scenes. When you cut
from a close-up to a long shot, the viewer no longer
sees the details, and it is thus easier to make a
chronological jump. Showing a spectator in a semi-long
shot can also provide visual relief from the main action,
and the opportunity of a transition away from the action
if desired.

Complete actions

Always shoot complete actions with a beginning and an
end. This makes editing easier.

Transitions

Cinematic timing requires some practice. It is not
always possible to film long events in their entirety,
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and in movies they often have to be represented in
severely abbreviated form. Nonetheless, the plot should
remain logical and cuts should almost never call
attention to themselves.

This is where the transition from one scene to the next
is important. Even if the action in neighboring scenes is
separated in time or space, your editorial choices can
make the juxtaposition so smooth that the viewer
bridges the gap without conscious attention.

The secret to a successful transition is establishing an
easily-felt connection between the two scenes. In a
plot-related transition, the connection is that of
successive events in an unfolding story. For example, a
shot of a new car might be used to introduce a
documentary about its design and production.

A neutral transition doesn’t in itself imply a story
development or a change of time or place, but can be
used to smoothly connect different excerpts from a
scene. For example, cutting away to an interested
audience member during a podium discussion lets you
then cut back unobtrusively to a later point in the same
discussion, omitting the part between.

External transitions show something apart from the
action. For example, during a shot inside the marriage
registry, you might cut to the exterior of the marriage
registry, where a surprise is already being set up.

Transitions should underscore the message of the film
and must always fit the respective situation, in order to
avoid confusing viewers or distracting from the actual
storyline.

Logical sequence of action

The shots strung together during editing must interact
appropriately in relation to the action. Viewers will be
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unable to follow the events unless the storyline is
logical. Capture viewer interest from the very
beginning with a fast-paced or spectacular start and
maintain that interest until the very end. Viewers can
lose interest or become disoriented if scenes are strung
together in a manner that is illogical or chronologically
false, or if scenes are too hectic or short (under three
seconds). There should be some continuity of motif
from one scene to the next.

Bridging the gaps

Make an effort to bridge the gaps from one filming
location to another. You can use close-ups, for
example, to bridge chronological jumps, zooming in on
the face, then back out after a few seconds onto a
different scene.

Maintain continuity

Continuity — consistency of detail from one scene to the
next — is vital in providing a satisfying viewing
experience. Sunny weather does not fit with spectators
who opened their umbrellas.

Tempo of cuts

The tempo at which a film cuts from one scene to the
next often influences the message and mood of the
film. The absence of an expected shot and the duration
of a shot are both ways of manipulating the message of
the film.

Avoid visual disjunctions

Stringing together similar shots in succession may
result in visual disjunctions. A person may be in the left
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half of the frame one moment and in the right half of
the frame the next, or may appear first with and then
without eyeglasses.

Do not string together pan shots

Pan shots should not be strung together unless they
have the same direction and tempo.

|
Rules of thumb for video editing

Here are some guidelines that may be helpful when you
come to edit your movie. Of course, there are no hard
and fast rules, especially if your work is humorous or
experimental.

e Do not string together scenes in which the camera is
moving. Pans, zooms, and other moving shots should
always be separated by static shots.

e Shots that follow one another should be from
different camera positions. The camera angle should
vary by at least 45 degrees.

e Sequences of faces should always be shot alternately
from varying angles of view.

e Change perspectives when shooting buildings. When
you have similar shots of the same type and size, the
picture diagonal should alternate between front left
to rear right and vice versa.

e Make cuts when persons are in motion. The viewer
will be distracted by the ongoing motion and the cut
will go almost without notice. In particular, you can
cut to a long shot from the middle of the motion.

o Make harmonious cuts; avoid visual disjunction.
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e The less motion there is in a shot, the shorter it
should be. Shots with fast movements can be longer.

e Long shots have more content, so they should also be
shown longer.

Ordering your video sequences in a deliberate manner
not only permits you to produce certain effects, but
even enables you to convey messages that cannot or
should not be shown in pictures. There are basically six
methods of conveying messages through cuts:

Associative cuts

Shots are strung together in a certain order to trigger
associations in the mind of the viewer, but the actual
message is not shown. Example: A man bets on a horse
race and, in very next scene, we see him shopping for
an expensive new car at a car dealership.

Parallel cuts

Two actions are shown in parallel. The film jumps back
and forth between the two actions; making the shots
shorter and shorter until the end. This is a way of
building suspense until it peaks. Example: Two
different cars drive from different directions at high
speed toward the same intersection.

Contrast cuts

The film purposely cuts unexpectedly from one shot to
another, very different shot, in order to point up the
contrast to the viewer. Example: A tourist lying on the
beach; the next shot shows starving children.

Substitutionary cut

Events that cannot or should not be shown are replaced
by other events (a child is born, but instead of
childbirth, the blossoming of a flower bud is shown).
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Cause and effect cuts

Shots are related by virtue of cause and effect: without
the first shot, the second would be incomprehensible.
Example: A man fights with his wife and, in the very
next shot, winds up sleeping under a bridge.

Formal cuts

Shots that vary in content can be strung together if they
have something in common — the same shapes, colors,
or motions, for example. Examples: A crystal ball and
the earth; a yellow raincoat and yellow flowers; a
falling skydiver and a falling feather.

0 00000|
Soundtrack production

Soundtrack production is an art, but it is an art one can
learn. Of course, it is no easy task to create a superb
narration, but short, informative comments are often
very helpful for the viewer. Whatever narration there is
should sound natural, expressive and spontaneous, not
wooden or stiff.

Keep comments brief

A general rule applicable to all commentary is that less
is more. Pictures should speak for themselves, and
things that are evident to viewers from the pictures
require no comment.

Preserve original sounds

Spoken commentary should be mixed with both the
original sounds and the music in such a way that the
original sounds can still be heard. Natural sound is part
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of your video footage and should not be cut away
altogether if at all possible, because video without
natural sound can easily seem sterile and lacking in
authenticity. Frequently, however, the recording
equipment captures noises from aircraft and cars that
do not appear in the scene later. Sounds such as these,
or loud wind noises, which can be distracting or
annoying, should be masked, filtered or replaced with
appropriate narration or music.

Select appropriate music

Appropriate music adds a professional finishing touch
to your movie and can do a lot to reinforce the message
of a video. The music selected, however, should always
be appropriate to the message of the film. This is
sometimes a time-consuming matter and a challenge,
but greatly appreciated by the viewer.

I
Title

The title should be informative, describe the contents of
the movie, and arouse interest. With the Title Editor
there are no limits to how creative you can be. As a
rule, you can let your fancy run free when designing a
title for your video.

Use a short, clear title
Titles should be short and in a large, legible font.

Title colors

The following combinations of background and text are
easy to read: white with red, yellow with black, and
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white with green. Exercise caution with very white
titles on a very black background. Some video systems
are unable to handle contrast ratios in excess of 1:40
and are unable to reproduce such titles in detail.

Time on screen

As a rule of thumb, a title should be displayed long
enough to be read twice. Allow about three seconds for
a title with ten letters. Allow an additional second of
on-screen time for every five additional letters.

“Found” titles

Besides postproduction titles, natural titles like
directional signs, street signs or title pages of local
newspapers also create interesting possibilities.
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APPENDIX E:

Glossary

Multimedia terminology contains computer and video
terminology. The most important terms are defined
below. Cross-references are indicated by L.

720p: A high-definition (HD) video format with a
resolution of 1280x720 and progressive (non-
interlaced) frames.

108i: A high-definition (HD) video format with a
resolution of 1440x1080 and interlaced frames.

ActiveMovie: Software interface by Microsoft for the
control of multimedia devices under Windows.
DirectShow, DirectMedia

ADPCM: Acronym for Adaptive Delta Pulse Code
Modulation, a method of storing audio information in a
digital format. This is the audio encoding and
compression method used in CD-I and CD-ROM
production.

Address: All available saving positions in a computer
are numbered (addressed). By means of these addresses
each saving position can be occupied. Some addresses
are reserved for the exclusive use of particular
hardware components. If two components are using the
same address, this is called an “address conflict”.
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Aliasing: An inaccurate display of an image due to the
limitations of the output device. Typically, aliasing
appears in the form of jagged edges along curves and
angled shapes.

Anti-aliasing: A method of smoothing out jagged
edges in bitmap images. This is usually accomplished
by shading the edges with pixels intermediate in color
between the edge and the background, making the
transition less apparent. Another method of anti-
aliasing involves wusing higher resolution output
devices.

Aspect ratio: The ratio of width to height in an image
or graphic. Keeping the aspect ratio fixed means that
any change to one value is immediately reflected in the
other.

AVI: Audio Video Interleaved, a standard format for
digital video (and 4 Video for Windows).

Batch capture: An automated process that uses an
edit decision list to locate and recapture specific
clips from a videotape, usually at a higher data rate
than the clip was originally captured.

BIOS: Acronym for Basic Input Output System, which
refers to basic input and output commands saved in a
ROM, PROM or 1 EPROM. The essential task of
the BIOS is the control of input and output. When the
system is started, the ROM-BIOS carries out some
tests. 4 Parallel port, IRQ, 1/0

Bit: Abbreviation of “Blnary digiT”, the smallest

element of a computer’s memory. Among other things,
bits are used to store the color values of pixels in an
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image. The more bits used for each [ pixel, the
greater the number of available colors. For example:

1-bit: each pixel is either black or white.
4-bit: allows 16 colors or gray shades.
8-bit: allows 256 colors or gray shades.
16-bit: allows 65,536 colors.

24-bit: allows about 16.7 million colors.

Bitmap: An image format made up of a collection of
dots or “pixels” arranged in rows. L4 Pixel

Blacking: The process of preparing a videotape for
insert editing by recording video black and continuous
control track on the entire tape. If the recording deck
supports timecode, continuous timecode will be
recorded simultaneously (also called “striping”).

Brightness: Also “luminance”. Indicates the brightness
of video.

Byte: One byte corresponds to eight 1 bits. With one
byte, exactly one alphanumeric character can be
displayed (i.e. a letter, number).

CD-ROM: Mass storage media for digital data, such as
digital video. CD-ROMs can be read from but not
written (recorded) onto: ROM is an acronym for
Read-Only Memory.

Channel: Classifications of information within a data
file to isolate a particular aspect of the file. For
example, color images use different channels to classify
the color components in the image. Stereo audio files
use channels to identify the sounds intended for the left
and right speakers. Video files use combinations of the
channels used for image and audio files.
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Clip: In Studio, any media type that goes on the Movie
Window Storyboard or Timeline, including video
images, trimmed video scenes, images, audio files and
disc menus.

Clipboard: A temporary storage area shared by all
Windows programs, used to hold data during cut, copy,
and paste operations. Any new data you place onto the
clipboard immediately replaces the existing data.

Closed GOP: GOP

Codec: Contraction of compressor/decompressor — an
algorithm that compresses (packs) and decompresses
(unpacks) image data. Codecs can be implemented in
either software or hardware.

Color depth: Number of bits delivering the color
information for each pixel. A 1-bit color depth allows
2'=2 colors, an 8-bit depth allows 28=256 colors, and a
24-bit depth allows 2%*=16,777,216 colors.

Color model: A way to mathematically describe and
define colors and the way they relate to each other.
Each color model has its own strengths. The two most
common color models are LI RGB and L YUV.

Color saturation: Intensity of a color.

Complementary color: Complementary colors are
opposite in value to primary colors. If you were to
combine a color with its complement, the result would
be white. For example, the complementary colors of
red, green and blue are cyan, magenta and yellow
respectively.

COM Port: A serial port located on the back of your
computer for attaching a modem, plotter, printer or
mouse to the system.
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Composite video: Composite video encodes luminance
and chrominance information into one signal. VHS
and 8mm are formats that record and play back
composite video.

Compression: A method for making files smaller in
size. There are two types of compression: lossless and
lossy. Files compressed with a lossless scheme can be
restored unchanged from their original state. Lossy
schemes discard data during compression, so some
image quality is sacrificed. The loss of quality may be
negligible or severe depending on the amount of
compression.

Cropping: Choosing the area of an image to be
displayed.

Data rate: The quantity of data transmitted per unit
time; for example, the number of bytes read from or
written to a hard drive per second, or the amount of
video data processed per second.

Data transfer rate: The measurement of the speed at
which information passes between the storage device
(e.g. LLJ CD-ROM or hard drive) and the display device
(e.g. monitor or MCI device). Depending on the
devices used, some transfer rates may offer better
performance than others.

DCT: Discrete Cosine Transformation — part of
(O JPEG image data compression and related
algorithms. The brightness and color information is
saved as a frequency coefficient.

DirectShow: System extension by Microsoft for
multimedia applications under Windows.
ActiveMovie
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DirectMedia: System extension by Microsoft for
multimedia applications under Windows.
ActiveMovie

DirectX: A bundle of several system extensions
developed by Microsoft for Windows 95 and its
successors to make possible video and game
acceleration.

Dissolve: A transitional effect in which the video is
faded from one scene to the next.

Dithering: Increasing the number of apparent colors in
an image by the application of color patterns.

Decibel (dB): A unit of measurement of the loudness
of sound. An increase of 3 dB doubles the loudness.

Digital8: Digital videotape format that records DV-
coded audio and video data on L. Hi8 tapes. Currently
sold only by Sony, Digital8 camcorders and VCRs can
play both Hi8 and 8mm cassettes.

Digital video: Digital video stores information bit
by bit in a file (in contrast to analog storage media).

DMA: Direct Memory Access.

Driver: A file containing information needed to
operate peripherals. The video capture driver operates a
video capture board, for example.

DV: Digital videotape format for recording digital
audio and video on Y”-wide metal evaporated tape.
Mini-DV tapes hold up to 60 minutes of content, while
standard DV tapes can hold up to 270 minutes.

ECP: “Enhanced Compatible Port”. Enables
accelerated bi-directional data transfer via the
parallel port. L EPP
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Edit decision list (EDL): A list of clips and effects in a
particular order that will be recorded onto your output
tape, disc or file. Studio allows you to create and edit
your own edit decision list by adding, deleting and
reordering clips and effects in the Movie Window.

EPP: “Enhanced Parallel Port”. Enables accelerated bi-
directional data transfer via the parallel port;
recommended for Studio DV. ECP

EPROM: “Erasable Programmable Read-Only
Memory”. Memory chip that after programming retains
its data without power supply. The memory contents
can be erased with ultraviolet light and rewritten.

Fade to/from black: A digital effect that fades up from
black at the beginning of a clip or down to black at the
end.

Field: A frame of video consists of horizontal lines
and is divided into two fields. The odd lines in the
frame are Field 1; the even-numbered lines are Field 2.

File format: The organization of information within a
computer file such as an image or word processor
document. The format of a file is usually indicated by
its “file extension” (e.g. doc, avi or wmf).

Filters: Tools that alter data to produce special effects.

FireWire: Apple Computer’s trademarked name for
the LI IEEE-1394 serial data protocol.

Frame: A single image in a video or animation
sequence. If using full NTSC or PAL resolution, one
frame consists of two interlaced fields. NTSC, PAL,
field, resolution

Frame rate: The frame rate defines how many frames
of a video sequence are played in one second. The
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frame rate for LI NTSC video is 30 frames per second.
The frame rate for PAL video is 25 frames per
second.

Frame size: The maximum size for displaying image
data in a video or animation sequence. If an image
intended for the sequence is larger than the frame size,
it must be cropped or scaled to fit.

Frequency: The number of repetitions in a periodic
process (like a sound wave or an alternating voltage)
per unit of time. Usually measured in repetitions per
second, or Hertz (Hz).

GOP: In MPEG compression the data stream is
first divided into “Groups Of Pictures” — sections of
several frames each. Each GOP contains three types of
frames: I-Frames, P-Frames (pictures) and B-Frames.

GOP size: The GOP size defines, how many I-Frames,
B-Frames and P-Frames are included in one GOP.
For example, current GOP sizes are 9 or 12.

Hardware codec: Compression method that uses
special hardware to create and play back compressed
digital video sequences. A hardware codec may offer
better encoding speed and image quality than a codec
implemented completely in software. Codec,
Software codec

HD: High Definition video. Most HD formats in use
have a resolution of either 1920x1080 resolution or
1280x720 resolution. A substantial difference exists
between the 1080 and 720 standards: the larger format
uses 2.25 more pixels per frame. This difference
substantially increases requirements for processing
1080 content in terms of encoding time, decoding
speed, and storage. The 720 formats are all progressive.
The 1080 format has a mixture of progressive and
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interlaced frame types. Computers and their displays
are inherently progressive, whereas television
broadcasting has been based on interlaced techniques
and standards. For HD terminology, we indicate
progressive with the letter "p" and interlaced with the
letter "i"

HDV: A format for the recording and playback of
high-definition video on a DV cassette tape. has been
established as the "HDV" format". Instead of the "DV"
codec, HDV uses a flavor of MPEG-2 . There are two
varieties of HDV: HDV1 and HDV2. HDV1 is
1280x720 resolution with progressive frames (720p).
The MPEG transport stream is 19.7 Mbps/s. HDV?2 is
1440x1080 resolution with interlaced frames (1080i).
The MPEG transport stream is 25 Mbps/s.

Hi8: Improved version of L Video8 using [E S-Video
recorded on metal particle or metal evaporated tape.
Because of higher luminance resolution and wider
bandwidth, the result is sharper pictures than Video8.

HiColor: For images, this normally means a 16-bit
(5-6-5) data type that can contain up to 65,536 colors.
TGA file formats support images of this type. Other file
formats require prior conversion of a HiColor image
into X TrueColor. For displays, HiColor normally
refers to 15-bit (5-5-5) display adapters that can display
up to 32,768 colors. [ Bit

Huffman coding: Technique used in EJ JPEG and
other data compression methods in which seldom
occurring values receive a long code, while frequently-
occurring values receive a short code.

IDE: “Integrated Device Electronics” — a hard-drive
interface that combines all drive control electronics on
the drive itself, rather than on the adapter connecting
the drive to the expansion bus.
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IEEE-1394: Developed by Apple Computers and
introduced as FireWire, this is a serial data
transmission protocol with rates up to 400 Mbits/sec.
Sony offers a slightly modified version for transmitting
DV signals named i.LINK, providing transmission
speeds up to 100 Mbits/sec.

Image: An image is a reproduction, or picture of
something. The term is often applied to digitized
pictures, consisting of pixels, that can be shown on a
computer display and manipulated by software.

Image compression: Method of reducing the amount
of data required to store digital image and video files.

Interlaced: The screen refresh method used by
television systems. The PAL TV image consists of
two interleaved image halves (L fields) of 312% lines
each. The NTSC TV image consists of two image
halves of 242% lines each. The fields are displayed
alternately to produce a blended image.

Interleave: An arrangement of audio and video to
promote smoother playback and synchronization or
compression. The standard EJ AVI format equally
spaces audio and video.

1/0: Input/Output.

IRQ: “Interrupt Request”. An “interrupt” is a
temporary break in the main processing stream of a
computer so that housekeeping or background tasks can
be performed. Interrupts can be requested by either
hardware (e.g. keyboard, mouse) or software.

JPEG: Joint Photographic Experts Group, and the
standard developed by them for compressing digital
frames based on [ DCT.

Kbyte (also KB): One Kbyte (kilobyte) contains 1024
bytes. The “K” here stands for the number 1024
(29, and not 1000 as in the metric prefix.
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Key color: A color whose display is suppressed so that
a background image can show through. Most
commonly used when overlaying one video sequence
on top of another, allowing the underlying video to
display wherever the key color appears.

Key frames: In some compression methods, such as
MPEG, the video data of certain frames — the key
frames — is stored completely in the compressed file,
while any intervening frames are only partially saved.
On decompression these partial frames reconstruct their
data from the key frames.

Laser disc: Medium that stores analog video.
Information on laser discs cannot be modified.

LPT: L Parallel port
Luminance: X Brightness

M1V: (File extension for) an MPEG file that contains
video data only. £ MPA, MPEG, MPG

Mbyte (also MB): One Mbyte (megabyte) corresponds
to 1024 [ Kbytes — 1024 x 1024 bytes.

Mark In / Mark Out: In video editing, the mark in
and mark out times refer to the starting and ending
timecodes that identify the portions of clips to be
included in the project.

MCI: Media Control Interface. Programming interface
developed by Microsoft recording and playing back
audio and video data. It is also used to connect a
computer to an external video source such as a VCR or
laser disc.

Modulation: The encoding of information upon an
empty carrier signal.

Motion-JPEG (M-JPEG): A [ Video for Windows
format, specified by Microsoft, for encoding video
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sequences. JPEG compression is used to compress
each frame individually.

MPA: (File extension for) an MPEG file that contains
audio data only. £ M1V, MPEG, MPG

MPEG: Motion Picture Experts Group, and the
standard developed by them for the compression of
moving images. Compared to M-JPEG, it offers 75-
80% data reduction with the same visual quality.

MPG: (File extension for) an MPEG file that contains
both video and audio data. L M1V, MPEG, MPA

MPV: (File extension for) an MPEG file that contains
video data only. L1 MPA, MPEG, MPG

Non-interlaced: Describes an image refresh method in
which the complete image is generated as a single field
without skipping lines. A non-interlaced image (most
computer monitors) flickers much less than an
interlaced image (most TVs).

NTSC: National Television Standards Committee, and
the color TV standard created by them in 1953. NTSC
video has 525 lines per frame and 60 image fields per
second. It is used in North and Central America, Japan
and other countries. £ PAL, SECAM

PAL: “Phase Alternation Line”, a color TV standard
developed in Germany and used throughout most of
Europe. PAL video has 625 lines per frame and 50
image fields per second. L NTSC, SECAM

Parallel port: Parallel port data is transmitted via an
8-bit data line. This means that eight bits (one
(L) byte) can be transmitted at once. This kind of
transmission is much faster than serial transmission,
but is not appropriate for long-distance connections.
Parallel ports are often named “LPTn”, where n is a
number (e.g. “LPT1"). LI Serial port
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Pixel: The smallest element of a monitor image. The
word is an abbreviation of “picture element”.

Port: Electrical transfer point for the transmission of
audio, video, control or other data between two
devices. [ Serial port, Parallel port

Primary colors: The colors that are the basis of the
RGB color model: red, green, and blue. It is possible to
create most other colors on a computer screen by
varying the blend of these primaries.

QSIF: Quarter Standard Image Format. An MPEG-1
format specifying a resolution of 176 x 144 under PAL
and 176 x 120 under NTSC. MPEG, SIF

Quantization: One part of the JPEG image data
compression strategy. Relevant details are represented
precisely, while details that are less relevant for the
human eye are represented with less precision.

Raster: The area of a video display that is covered by
sweeping the electron beam of the display in a series of
horizontal lines from upper left to lower right (from the
viewer’s perspective).

Redundancy: This trait of images is exploited by
compression algorithms. Superfluous information can
be eliminated during compression and restored without
loss during decompression.

Resolution: The number of pixels that can be displayed
on the monitor horizontally and vertically. The higher
the resolution, the more details can be displayed.
Pixel

RGB: Red, Green and Blue: the primary colors in
additive color mixing. RGB designates the method
used in computer technology of encoding image infor-
mation in pixels, each containing some combination of
the three primaries.
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ROM: Read Only Memory: Memory storage that,
having been programmed once, retains its data without
requiring electrical power. EPROM

Run Length Encoding (RLE): A technique used in
many image compression methods, including
JPEG. Repeating values are not stored separately
but with a counter to indicate how many times the
value occurs in succession — the length of the “run”.

Scaling: Adaptation of an image to a desired size.

SCSI: Small Computers System Interface. SCSI was
long preferred as the hard drive interface for some
high-performance PCs because of its high data rate. Up
to eight SCSI devices can be connected to a computer
at the same time.

SECAM: “Séquentiel Couleur a Mémoire”, a color TV
transmission system used in France and Eastern
Europe. Like PAL, SECAM video has 625 lines per
frame and 50 image fields per second. [El NTSC, PAL

Serial port: Data transmitted via a serial port is
processed one LU bit at a time; that is, “serially” — one
after another. The transmission rate is much slower
than that of a parallel port, where parallel data lines
allow multiple bits to be sent simultaneously. Serial
ports are named “COMN”, where n is a number (e.g.
“COM2”). [J Parallel port

SIF: Standard Image Format. An MPEG-1 format
specifying a resolution of 352 x 288 under PAL and
352 x 240 under NTSC. MPEG, QSIF

Single frame: A single L frame is part of a series or
sequence. When this series is viewed at sufficient
speed, the illusion of a “moving picture” is created.
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Software codec: Compression method that can create
and play back compressed digital video sequences
without special hardware. The quality of the sequences
depends on the performance of the complete system.
Codec, Hardware codec

Still video: Still images (or “freeze-frames™) extracted
from video.

S-VHS: Improved version of VHS using S-Video and
metal particle tape to deliver higher luminance
resolution, resulting in sharper pictures than VHS.
VHS, S-Video

S-Video: With S-Video (Y/C) signals, the brightness
(luminance or “Y™) and the color (chrominance or “C”)
information are transferred separately using multiple
wires, avoiding modulating and demodulating the video
and the resulting loss of picture quality.

Timecode: Timecode identifies the position of each
frame in a video sequence with respect to a starting
point (normally the beginning of the shot). The usual
format is H:M:S:F (hours, minutes, seconds, frames),
e.g. “01:22:13:21”. Unlike a tape counter (which can be
“zeroed” or reset at any point in a tape), timecode is an
electronic signal written onto videotape, and is
permanent once it is assigned.

Transition: The visual connection between adjacent
video clips, ranging from a simple “cut” to a showy
animated effect. The common transitions like cuts,
fades, dissolves, wipes and slides are part of the visual
language of film and video. They can convey passages
of time and changes of viewpoint concisely — and often
subliminally.
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TrueColor: The name indicates an image with enough
color resolution to appear “true to life”. In practice,
TrueColor normally refers to 24-bit RGB color, which
allows about 16.7 million combinations of the red,
green and blue primary colors. E1 Bit, HiColor

TWAIN driver: TWAIN is a standardized software
interface allowing graphics and capture programs to
communicate with devices that supply graphical data. If
the TWAIN driver is installed, the capture function of a
graphics application can be used to load images directly
from your video source into the program. The driver
supports 32-bit programs only and captures images in
24-bit mode.

VCR: “Video cassette recorder”.

VHS: “Video Home System” — Popular video standard
for home VCRs. Half-inch tape is used to store
“composite” signals incorporating both brightness and
color information.

VISCA: Protocol used with certain devices for control-
ling external video sources from computers.

Video8: Analog video system using 8mm tape. Video8
recorders generate composite signals.

Video CD: CD-ROM standard that uses MPEG
compressed videos.

Video decoder: Converts digital information into
analog video signals.

Video encoder: Converts analog video signals into
digital information.

Video for Windows: A Microsoft Windows system
extension that can record digital video sequences to
files on a hard drive and subsequently play them back.
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Video scan rate: Frequency with which the video
signal is scanned onto an image display. The higher the
video scan rate, the higher the image quality and the
less noticeable the flicker.

WAV: (File extension for) a popular file format for
digitized audio signals.

White balance: In an electronic camera, this is the
adjustment of the amplifiers for the three color
channels (red, green and blue) so that white areas of the
scene do not show a color cast.

Y/C: YIC is a color signal with two components:
brightness information (Y) and color information (C).

YUV: The color model of a video signal where Y
delivers the brightness information and U and V the
color information.
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APPENDIX F:

License agreement

Pinnacle End User License Agreement

This End User License Agreement (“License™) is a legal agreement
between you and Pinnacle Systems (“Pinnacle™) regarding Pinnacle’s
software and the accompanying documentation (collectively, the
"Software"). CAREFULLY READ THE FOLLOWING LICENSE.
USING THIS SOFTWARE INDICATES YOUR ACCEPTANCE OF
THIS LICENSE. IF YOU DO NOT ACCEPT OR UNDERSTAND
THE TERMS OF THIS LICENSE, YOU SHOULD NOT INSTALL
THE SOFTWARE AND SHOULD PROMPTLY RETURN THIS
PRODUCT TO THE PLACE OF PURCHASE.

1. License Grant. Subject to the restrictions set forth below, this
License grants you a non-exclusive, perpetual license to (a) install the
Software on only one computer; (b) use or authorise use of the
Software on only one computer; (c) make one copy of the Software, in
machine-readable form, solely for backup purposes; provided you
include all copyright and other proprietary rights notices on the copy
and (d) transfer the Software and this License to another party if the
other party agrees to accept the terms and conditions of this License.
If you transfer the Software, you must at the same time either transfer
all copies to the same party or destroy any copies not transferred. If
you transfer possession of any copy of the Software to another party,
your License is automatically terminated. Some features of the
Software may be locked and require that you activate, either for free
or subject to payment of additional license fees, the features before
you may use them. Additionally, Pinnacle may, either for free or
subject to payment of additional license fees, grant you a license for
plug-ins to the Software produced or distributed by Pinnacle (the
"Plug-ins"). Your use of any such features and any of the Plug-ins
shall be subject to the terms of this Agreement, unless accompanied
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by another license agreement, in which case the Plug-ins license
agreement shall prevail.

2. License Restrictions. You may not, or allow any third party to, (a)
rent, lease, sell, loan or otherwise transfer the Software or any of your
rights and obligations under this License; (b) install the Software on a
network for use by multiple users, unless each user has purchased a
license; (c) reverse-engineer, decompile or disassemble the Software
or hardware in whole or in part; (d) remove or destroy any copyright
notices or other proprietary markings of the Software or any third-
party software; (e) modify or adapt the Software, merge the Software
into another program or create derivative works based on the
Software; (f) make copies of or distribute, for profit or otherwise, the
Software, except as expressly provided above; (g) make any
alteration, modification, connection, disconnection, improvement or
adjustment of any kind to or use the Software except as explicitly
contemplated in the enclosed documentation and in this License and
(h) sublicense, transfer or assign this License or any of the rights and
obligations granted under this License, except as explicitly
contemplated in this License. Any purported transfer or assignment
will be void.

3. Export Restrictions. The export and re-export of Pinnacle
software products are controlled by the United States Export
Administration Regulations and such software may not be exported or
re-exported to any country to which the United States embargoes
goods. In addition, Pinnacle software may not be distributed to
persons on the Table of Denial Orders, the Entity List, or the List of
Specially Designated Nationals. By downloading or using a Pinnacle
software product you are certifying that you are not a national of any
country to which the United States embargoes goods and that you are
not a person on the Table of Denial Orders, the Entity List, or the List
of Specially Designated Nationals.

4. Ownership. The license granted hereunder does not constitute a
transfer or sale of ownership rights in or to the Software. Except for
the license rights granted above, Pinnacle retains all rights, title and
interest in and to the Software including all intellectual property rights
therein. The Software is protected by applicable intellectual property
laws, including United States copyright laws and international treaties.

5. Third Party Proprietary Property. This Software may contain
the proprietary property of others, which has been licensed to
Pinnacle. Your use of the Software is expressly subject to your
agreement not to remove any copyright notices or other proprietary
markings of the third party software.

Pinnacle Studio 10 Plus



6. Security. You acknowledge and agree that in order to protect the
integrity of certain third party content, Pinnacle and/or its licensors
may provide for Software security related updates that will be
automatically downloaded and installed on your computer. Such
security related updates may impair the Software (and any other
software on your computer which specifically depends on the
Software) including disabling your ability to copy and/or play
"secure" content, i.e. content protected by digital rights management.
In such an event, Pinnacle and/or its licensors shall use reasonable
efforts to post notices promptly on Pinnacle’s web site explaining the
security update and providing instructions to end-users for obtaining
new versions or further updates of the Software that restore access to
secure content and related features.

7. Updates. You acknowledge and agree that Pinnacle may
automatically check the version of the Software and/or its components
that you are using and may provide updates or fixes to the Software
that may be automatically downloaded to your computer. Updates
provided after the expiry of the Limited Warranty period set forth in
Section 9 below are not covered by any warranty, express, implied, or
statutory.

8. Term and Termination. This License shall be effective upon
installation of the Software and shall terminate upon the earlier of
(a) your failure to comply with any term of this License; (b) return,
destruction or deletion of all copies of the Software in your possession
or (c) transfer of the Software and this License to another party in
accordance with Section 1(d). Pinnacle’s rights and your obligations
shall survive termination of this License.

9. Limited Warranty. Pinnacle warrants to the original licensee that
the Software, as delivered, will perform in accordance with the
accompanying documentation for a period of 30 days from the date of
the original purchase (“Limited Warranty”). Pinnacle’s entire liability
and your exclusive remedy for breach of the preceding Limited
Warranty shall be, at Pinnacle’s sole option, repair or replacement of
the Software that does not meet the warranty set forth herein and that
is returned to Pinnacle. This limited warranty shall be void if failure
of the Software has resulted from any accident, abuse, misuse or
misapplication by you. Any replacement Software will be warranted
for the remainder of the original warranty period or 30 days,
whichever is longer.

10. NO OTHER WARRANTIES. EXCEPT AS SET FORTH
ABOVE, THE SOFTWARE IS PROVIDED ON AN “AS IS” BASIS.
YOU ASSUME ALL RESPONSIBILITIES FOR THE QUALITY
AND PERFORMANCE OF THE SOFTWARE. TO THE
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MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
PINNACLE DISCLAIMS ALL WARRANTIES, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE. LICENSOR DOES NOT WARRANT THAT THE
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET
YOUR REQUIREMENTS, BE UNINTERRUPTED OR ERROR
FREE.

11. LIMITATION OF LIABILITY. YOU AGREE THAT IN NO
EVENT WILL PINNACLE BE LIABLE FOR ANY
CONSEQUENTIAL, SPECIAL, INDIRECT, INCIDENTAL OR
PUNITIVE DAMAGES WHATSOEVER, EVEN IF PINNACLE
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN NO EVENT SHALL PINNACLE’S LIABILITY
EXCEED THE TOTAL AMOUNT OF THE FEES PAID FOR THE
SOFTWARE. Some states/jurisdictions do not allow the limitation or
exclusion of incidental or consequential damages in certain
circumstances, so the above limitations may not apply in some
circumstances.

12. General. This License is governed by the laws of the State of
California and by the federal laws of the United States, without
reference to conflict of laws principles. The federal and state courts
within the County of Santa Clara, California shall have excusive
jurisdiction to adjudicate any dispute arising out of this License and
you hereby consent to the personal jurisdiction of the federal and state
courts within the County of Santa Clara, California. This License is
the entire agreement between you and Pinnacle and supersedes any
other communication with respect to the Software. No modification of
or amendment to this License will be effective unless in writing
signed by both parties. If any provision of this License is held invalid
or unenforceable, the remainder of this License will continue in full
force and effect.
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APPENDIX G:

Keyboard shortcuts

The terms Left, Right, Up and Down in this table refer
to the arrow (cursor) keys.

Main Studio interface

Space bar
J

X or Ctrl+Up

Y or Ctrl+Down
Aorl

SorO
Ctrl+Left
Ctrl+Right
Alt+Left
Alt+Right
Alt+Ctrl+Left

Alt+Ctrl+Right
G

D

F

E or Home

Play and stop

Fast reverse (hit multiple times for
faster playback)

Halt playback

Fast forward (hit multiple times for
faster playback)

Step forward 1 frame
Step back 1 frame

Mark in

Mark out

Trim in point by -1 frame
Trim in point by +1 frame
Trim out point by -1 frame
Trim out point by +1 frame

Rolling trim out point by -1 frame
(trims following clip too)

Rolling trim out point by +1 frame
Clear mark in and mark out

Go to mark in (in trimmer tool)
Go to mark out (in trimmer tool)
Go to start
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R or End

Left

Right

Delete

Insert

Page up

Page down
Numeric pad +
Numeric pad -
C

\Y,

M

Ctrl+Page up
Ctrl+Page down

Title Editor

Alt+Plus
Alt+Minus
Ctrl+Plus
Ctrl+Minus
Ctrl+0
Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrl+6
Ctrl+7
Ctrl+8
Ctrl+9
Ctrl+K
Ctrl+M
Shift+Left
Shift+Right

Go to end

Select previous clip

Select next clip

Delete selected clip(s)

Split clip at scrubber position
Go to next page in Movie Window

Go to previous page in Movie Window

Zoom in the Timeline

Zoom out the Timeline

Set menu chapter

Clear menu chapter

Set return to menu

Go to previous menu chapter
Go to next menu chapter

Bring to front

Send to back

Bring forward one layer

Send back one layer

Text justification off

Text justification: bottom left
Text justification: bottom center
Text justification: bottom right
Text justification: middle left
Text justification: middle center
Text justification: middle right
Text justification: top left

Text justification: top center
Text justification: top right
Kern, leading and skew

Move, scale and rotate

Expand character selection left
Expand character selection right
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Ctrl+Left

Ctrl+Right

Ctrl+Down

Ctrl+Up

Shift+Ctrl+Left
Shift+Ctrl+Right
Shift+Ctrl+Down
Shift+Ctrl+Up
Alt+Left

Alt+Right

Shift+Alt+Left
Shift+Alt+Right

Reduce horizontal scale of, or
squeeze (kern), text selection
depending on current edit mode
(move/scale/rotate or
kern/skew/leading)

Increase horizontal scale of, or stretch
(kern), text selection

Reduce scale or leading of text
selection depending on current edit
mode

Increase scale or leading of text
selection

Same as Ctrl+Left (coarse)
Same as Ctrl+Right (coarse)
Same as Ctrl+Down (coarse)
Same as Ctrl+Up (coarse)

In text selection: Move characters
left. No selection: Move left all text
from cursor to end of line.

In text selection: Move characters
right. No selection: Move right all
text from cursor to end of line.

Same as Alt+Left (coarse)
Same as Alt+Right (coarse)

Appendix G: Keyboard shortcuts
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2
2D editor (video effect), 117

A

A/B editing, 127
Abbreviations, xiii
Activate
Explained, 14
Activating
Disc menus, 56
Hollywood FX, 52
Sound effects, 58
Album
Aspect ratio, 78
Clipboard operations, 75
Disc Menus section, 55, 169
Drag-and-drop editing, 74
Filled during capture, 19
Image sections, 152
Interface features, 39
Introduced, 19
Menu usage, 39
Music section, 58
Overview, 35
Previewing, 6, 37
Selecting video scenes, 45
Sound Effects section, 57
Source folders, 37
Still Images section, 54

Index

Index

Title Editor. See Title Editor
Album
Titles section, 53
Transitions section, 51, 141
Video Scenes section, 38, 73
Album menu
Combine Scenes, 48
Comment view, 46
Details view, 46
Find Scene in Project, 39, 80
Icon view, 46
Scene detection commands, 50
Scene view, 46
Select By Name, 47
Set Thumbnail, 42
Subdivide Scenes, 49
Alpha Magic transitions, 143
Analog
Capture quality options, 31
Levels during capture, 31
Outputting to, 243
Animated pan-and-zoom, 157
Animation, 281
Aspect ratios (frame formats), 24,
42
Capture option, 248
Mixing, 76
Audio
Adjusting on Timeline, 216
Background music, 204
Insert editing, 94
Muting, 66
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Original, 203
Overlay, 126
Overlay, original, 203
Scrubbing, 60
Settings (for File output), 268
Sound effects, 203
Surround, 218
Synchronized with video, 90
Synchronous, 63, 146, 203
Tracks on Timeline, 203
Transitions, 146
Uses of, 201
Using in Studio, 202
Using without video, 75
Voice-overs, 203
Volume and mixing, 213, 218
Audio clips, 63
Interface details, 213
Trimming, 211
Audio compression, 268
Audio effects, 223
ChannelTool, 226
Chorus, 227
DeEsser, 227
Equalizer, 227
Grungelizer, 228
Icons, 224
In Studio Plus, 226
Leveler, 229
Noise reduction, 225
Reverb, 230
Standard vs. Plus, 224
Stereo Echo, 230
Stereo Spread, 230
Tool, 223
Unlocking, 101
Audio levels
Changing during capture, 20
In analog capture, 32
In DV capture, 30
Audio scrubbing button, 60
Audio toolbox, 71
Audio track
Linked to video track, 92
Audio tracks, 204
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Auto color correction (video
effect), 111

Automatic scene detection. See
Scene detection

AVI files, 57

B

Background

In Title Editor, 195
Background music, 62, 63

CD, 205

Formats, 204

SmartSound, 206
Background rendering, 77

Enabling and disabling, 146

Of Hollywood FX, 146

Of moving menu thumbnails, 177

Of video effects, 108
Backgrounds section

Of Title Editor Album, 195
Balance

Adjusting on Timeline, 217
Balance and volume, 71, 213
Black and white (video effect),

119

Blur (video effect), 114
Buttons

Audio scrubbing, 60

Chapter. See Disc menus

Clip, 59

Clip delete, 61

Clip split, 59

DVD toggle, 6

Edit menu, 70

Highlighting, 200

Mode, 2

Playback, 8

Razorblade, 89

Reset (pan-and-zoom), 156

Split clip, 89, 92

Split clip/scene, 60

Start/stop capture, 21

Tool selector, 68

Toolbox, 68
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Track-locking, 91
Undo, Redo, Help, Support and
Activate, 3
View selection, 59
Buttons section
Of Title Editor Album, 198

C

Camcorder Controller, 20, 22, 162
Capture, 17
Analog quality options, 31
Analog vs. digital, 20
And the Album, 19
Audio and video levels, 31
Change directory, 22
Device selection, 24
Devices, 246
Directory, 21
Drive-speed, 29
Format options, 250
From analog sources, 30
From DV, 28, 30
From DVD, 33
From HDV, 30
Hardware, 23
MPEG options, 253
Preparing hard drive, 278
Scene detection, 27
Source options, 246
Sources, 23
Step-by-step, 25
To multiple files, 76
Capture mode
Interface, 19
Introduced, 1
Capture settings, 21
Captured video
Folders, 40
Opening file, 40
CD audio clips
Properties of, 212
CD audio tool, 72, 205
ChannelTool (audio effect), 226
Chapter links. See Links
Chapters

Index

On menu track, 173
Chorus (audio effect), 227
Chroma key
Background cloth for, 139
Tips, 138
Tool, 133
Video effect, 137
Clip properties
Duration, 155
Name, 155
Clip properties tool, 66, 70, 71
For audio clips, 211
For disc menus, 174
For still images, 154
For transitions, 148
For video clips, 87
Trimming with, 86, 148
Clipboard
With Album and Movie Window,
75
Clips
Audio, 63
Changing name, 86
Combining, 90
Deleting, 61
Splitting, 60, 89
Trimming on the Timeline, 81
Trimming tips, 85
Video, 63
Close-ups, 313
Color correction (video effect),
119
Color effects
White balance, 121
Colors
Selecting, 140
Combine Clips menu command,
90
Compression
Audio, 268
Video, 267
Configuration. See Options
Continuity (videography tip), 315
Conventions, xiii
Counter, 10
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Cross fade
In audio, 146
Cut (transition), 143
Cuts
Associative, 317
Cause and effect, 318
Contrast, 317
Formal, 318
Parallel, 317
Substitutionary, 317
Tempo of (videography tip), 315

D

Data rate
For DV capture, 249
DeEsser (audio effect), 227
Delete clip button, 61
Deleting clips, 61
Deleting scenes, 61
Devices
Capture, 24, 246
Dialog boxes
Main Options, 245
Make Movie Options, 245
Options, 245
DirectX, xii
Disc
MPEG encoding, 28
Previewing, 171
Saving movie to, 233
Disc chapter command, 170
Disc menu tool, 70, 179
Disc menus, 165
Activating, 56
Automatic link creation, 170
Button captions, 169
Chapter editing, 178
Creating, 181
Described, 165
Editing, 181
Editing links, 174
Editing on Timeline, 172

Link numbers during editing, 176

Loop during playback, 166
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Menus vs. titles, 168
Motion backgrounds, 196
Moving Thumbnails option, 177
Name and duration, 175
On moving video, 168
Opening in Title Editor, 175
Placing on Timeline, 170
Sample movie layout, 166
Section (of Album), 55, 169
Setting thumbnail, 177
Supplied, 169
VCD, S-VCD limitations, 169
Discs
Authoring, 1, 36, 55, 151, 167,
198, 213
Diskometer, 20, 21
Dissolve (transition), 144
Drag-and-drop
Editing, 74
From Album, 74, 141
Setting menu links, 179
Drive space
For DV capture, 29
Drive speed
For video capture, 29
Insufficient data rate, 249
Durations (of transitions etc.), 255
DV, xiv
Capturing, 28, 30
Data rate for capture, 249
Outputting to, 242
Storage calculation, 29
DVD
Image on hard drive, 234
Importing video from, 33
Menus, 55, See Disc menus
MPEG encoding, 28
Output movie to, 233
Playback controls, 6, 11, 167
Player control, 171
Previewing, 171

E

Earthquake (video effect), 117
Edit
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Video clips, 73
Edit line

Clips inserted at, 75
Edit menu button, 70
Edit mode

Interface, 5

Introduced, 1
Editing, 312

A/B, 127

Advanced, 65, 125

Disc menus, 172

Insert, 92

Split, 94

Still images, 154
Editing photos and other images,

155

Editor, Menu and Title, 181
Effects

Audio. See Audio effects

Video. See Video effects
Emboss (video effect), 115
Equalizer (audio effect), 227
Equipment requirements, Xi

E

Fade

Adjusting balance on Timeline,

217

Fade (transition), 143
Fades

Default duration of, 255
File

Saving movie to, 237
File name

Project, 59
File type

AVI, 238

DivX, 239

iPod compatible, 239

MPEG, 240

Real Media, 241
Sony PSP compatible, 241
Windows Media, 242

File types

Index

AVI, 57
Image, 54
MP3, 57
Music, 58
Sound, 57
WAV, 57
Find Scene in Album command,
39
Find Scene in Project command,
39
Flags
Placing on menu track, 174
Folders
Music, 58
Still images, 54
Titles, 54
Fonts, 192
Frame formats. See Aspect ratios
Frame grabber, 161
Tool, 70, 152
Tool, described, 161
With HDV, 162
Frame rate
Increasing, 280
Full-screen images
Described, 152

G

Glossary, 321
GOP
Closed, 324
Size, 328
Grab frames tool
Described, 161
Graphics
Editing, 155
Groups
Temporary, In Title Editor, 190
Grungelizer (audio effect), 228

H

Hard drive
Preparing for capture, 278
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Space for video capture, 29
Speed for video capture, 29
Hardware
Capture, 23
HD, 329
HDV, xiv, 329
Capturing, 30
Help button, 3
Highlighting
Of menu buttons, 200
Hollywood FX
Activating, 52
And background rendering, 146
Editing, 145, 149
Previewing, 146
Transitions, 143, 144

Icons for effects
Audio, 224
Video, 80
IEEE-1394, xiv
Cable, 242
Images. See Still images
Importing video from DVD, 33
Insert edit
A/B, 127
Insert editing, 92
Audio, 94
Introduced, 92
Method, 92
Invert, 120

J-cut
A/B, 127
Defined, 94
Explained, 97
Jog buttons, 9

K
Ken Burns, 155
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Keyboard conventions, xiv
Keyframing (of video effects
parameters), 103, 106

L

Layers
In Title Editor, 185
L-cut
A/B, 127
Defined, 94
Explained, 95
Lens flare (video effect), 117
Letterboxing, 78
Leveler (audio effect), 229
Levels, Audio and video
In analog capture, 31
In DV capture, 30
Lighting, 120
Links
Adjusting, 174
Automatic creation of, 170
Creating, 174
Deleting, 174
Editing, 174
In disc menu tool, 178
On disc menus, 165
Repositioning, 174
Return to menu, 174
Setting with drag-and-drop, 179
Show numbers while editing, 176
Locked content
Activating, 11
Locking tracks, 65
Indication of, 91
Long shots (videography tip), 313
Luma key (video effect), 116

M

Magnify (video effect), 118

Make Movie mode, 231
Introduced, 3

Making movies, 231

Media Player, 242
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Menu and Title Editor, 181
Menu buttons
Highlighting, 200
Menu commands, xiv
Menu Editor. See Title Editor
Menu links. See Links
Menu track, 173
Editing, 174
Flags, 173
Menus, Disc. See Disc menus
Microphone
Connecting, 210
Modes
Capture, 19
Edit, 5
Introduced, 1
Make Movie, 231
Setting, 3
Monitors
Dual, 257
Motion blur (video effect), 118
Movie
Previewing, 6
Movie Window, 59
Clipboard operations, 75
Drag-and-drop editing, 74
Find scene in Album, 39, 80
Interface features, 79
Positioning, 62
Status message area, 59
Trimming on the Timeline, 81
Views, 62
MP3 files, 57
MPEG
Capture options, 253
Captures from DV, 29
Encoding of DV captures, 28
For DVD etc., 28, 29
Quality options, 29
Rendering for output, 233
Multiple capture files
Using, 76
Multiple selection
In Title Editor, 190
Multitrack editing, 125

Index

Music, 201, See Background
music
Folder, 58
Section (of Album), 58
Selecting (videography tip), 319
Music video. See SmartMovie
Muting audio tracks, 66

N

Names
In Text and Storyboard view, 86
Of clips - changing, 86
Noise reduction (audio effect), 225
Noise reduction (video effect), 112
NTSC, 247

O

Objects
In Title Editor, 184
Old film (video effect), 115
Optical disc. See Disc
Optical disc summary, 236
Options, 245
Aspect ratio for analog capture,
248
Audio for file output, 268
Capture devices, 246
Capture format, 250
Capture source, 246
Data rate, 249
Data rate and quality, 268
Frame rate, 268
Include video, 267, 269
List all codecs, 267, 269
Main dialog, 245
Make AVI file, 266
Make Disc, 262
Make Movie, 245
Make MPEG file, 266
Make Real Media file, 270
Make tape, 274
Make Windows Media file, 273
MPEG capture, 253
Organization of, 245
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Output to VGA display, 276
Overlay for analog capture
preview, 247
Preview during capture, 247
Project preferences, 253
Scene detection, 248
Setting, 4
TV standard, 247
VCR input checkbox, 247
Video and audio preferences, 257
Video compression, 267
Video for file output, 267
Video preview, 257
Original audio
Properties, 212
Synchronized with video, 90
Original sounds
Preserving (videography tip), 318
Output
Browser, 231
Media type, 231
To AVl file, 238
To DivX file, 239
To file, 237
To iPod compatible file, 239
To MPEG file, 240
To optical disc, 233
To Real Media file, 241
To Sony PSP compatible file, 241
To Tape, 242
To videotape, 243
To Windows Media, 242
Overlay effects, 125
Overlay images
Controlling transparency in, 153
Described, 152
Overlay track, 125
Always show option, 126
Audio, 203
Audio, original, 126
Displaying, hiding, 126
Introduced, 125
Opening, 125
Overlays track
And still images, 151
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PAL, 247
Pan and scan, 78
Pan and zoom
Video effect, 160
Pan-and-zoom
Animated, 157
Complex animations, 159
Photos, 156
Tool, 155
Parameters for effects
Resetting, 103
Parameters for plug-in effects
Presets, 102
Parameters for video effects
Editing, 101
Passport, 14
Perspectives
Varying, 312
Photos
Editing, 155
Panning and zooming, 156
Red-eye reduction, 156
Rotating, 156
Picture-in-picture
Tool, 128
Video effect, 132
Playback controls, 6
DVD, 6, 11, 167
Fast forward/reverse, 9
Go to beginning, 9
Jog buttons, 9
Loop, 9
Play/Pause, 8
Standard, 6, 8
Playback speed
Changing, 113
Player, 19
During Timeline trimming, 81
Introduced, 6
Previewing transitions, 53, 145
Scrubber, 9
Player control
DVD, 171
Plug-in effects
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Unlocking, 101, 110
Plus audio effects pack, 226
Plus RTFX video effects pack, 114
Posterize (video effect), 120
Premium button, 3
Premium content and features, 15
Presets for effects, 102
Preview
During capture, 247
Preview window, 6, 84
Preview Window, 7
Previewing
Discs, 171
Hollywood FX, 146
Menus, 6
Transitions, 53, 145
Video effects, 108
Problems and solutions, 283
Product names, xiii
Progressive encoding (advanced
output setting), 263
Project. See Movie
Project preferences (options
panel), 253
Project video format, 77
Push (transition), 144

R
Razorblade button, 60
Real Media
Files, 241

RealNetworks® RealPlayer®, 241
RealNetworks® RealPlayer®
Viewing files with, 237
Recording voice-overs, 208
Quality, 210
Red-eye reduction
Explained, 156
Removing, 157
Redo button, 3
Rendering, 233
Reordering objects
In three dimensions, 185

Index

Requirements, equipment, xi

Return to menu link, 174

Reverb (audio effect), 230

RGB color balance (video effect),
121

Ripple transition, 147, 153, 168

S

Save to disc, 233
Save to file, 237
AVI, 238
DixX, 239
iPod compatible, 239
MPEG, 240
Real Media, 241
Sony PSP compatible, 241
Windows Media, 242
Save to tape, 242
Scanning, progressive vs.
interlaced, 263
Scene detection, 26, 27, 42
Menu commands, 50
Options, 248
Scenes. See Video scenes
Scenes (videography tip), 316
Scrubber, 9
Scrubbing audio, 60
SCSI, xii
Sepia (video effect), 121
Set Thumbnail menu command, 42
Settings. See Options
Setup menu, 4
Setup options, 245
Slide (transition), 144
Slideshow, 147, 153, 168
Slow motion, 113
SmartSound
Clip properties, 212
Duration of clips, 211
Tool, 72, 206
Soften (video effect), 116
Sound effects, 63, 201
Activating, 58
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Properties, 212
Section (of Album), 57
Sound files, 57
Speed (video effect), 113
Split Clip menu command, 89
Split clip/scene button, 60, 89
In insert editing, 92
Split edit
A/B, 127
Split editing
Introduced, 94
Splitting clips, 89
Restoring from, 89
Stabilize (video effect), 112
Stained glass (video effect), 116
Start/stop capture button, 21
Stereo
Adjusting balance on Timeline,
217
Stereo Echo (audio effect), 230
Stereo Spread (audio effect), 230
Still images
Creating, 152
Default duration of, 255
Described, 151
Editing, 155
Folder, 54
Full-screen, 152
Full-screen vs. overlay, 151
Overlay, 152
Section (of Album), 54
Transparency in, 153
Trimming, 154
Trimming and editing, 154
Types, 151
Still Images
Rotating, 156
Storyboard view, 62, 63
Studio Plus, 125
Audio effects, 224, 226
Keyframing, 103, 106
Video effects, 114
Support button, 3
Surround sound, 218
S-VCD
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Menus, 55, See Disc menus
MPEG encoding, 28
Output movie to, 233
Synchronization (of video and
audio)
Overriding, 90

T
Tape

Saving movie to, 242
Text editing

Advanced, 187
Text view, 62, 67, 86
Thumbnail frames
In Album, 42
Setting in disc menus, 177
With moving video, in menus, 177
Timeline
Adjusting volume on, 216
Audio tracks, 203
Editing disc menus on, 172
Locking tracks, 91
Overlay video, 125
Placing disc menus on, 170
Tracks, 63
Trimming clips on, 81
Timeline view, 62, 63
Advanced editing in, 90
Insert editing, 92
Splitting clips in, 89
Timescale, 63
Title
Choosing (videography tip), 319
Colors (videography tip), 319
Title Editor, 181
Advanced text editing, 187
Introduced, 69
Launching, 182
Multiple selection in, 190
Title Editor Album, 193
Backgrounds section, 195
Buttons section, 198
Looks Browser, 193
Pictures section, 197
Title Editor controls
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Clipboard and delete buttons, 191

Mode selection buttons, 187
Object layout buttons, 189
Object toolbox, 184
Selection tool, 184
Text styling, 191
Title-type buttons, 183
Title Editor objects, 184
Reordering layers, 185
Text, 186
Title track
Locking, 91
Titles
Crawls, 183
Creating, 181
Editing, 181
Folder, 54
Rolls, 183
Section (of Album), 53
Titles and overlays track
And still images, 151
Titles tool, 70
Toolbox, 59
Audio, 71
Video, 70
Toolboxes, 68
Tools
Audio effects, 72, 223

Automatic background music, 72

CD audio, 72, 205
Chroma key, 133
Clip properties, 66, 70, 71, 86,
174, 211
Disc menu, 70, 179
Frame grabber, 70
Pan-and-zoom, 155
Picture-in-picture, 128
PIP and chroma key, 70
SmartMovie, 70, 122
SmartSound, 206
Titles, 70
Video effects, 70, 99
Voice-overs, 72, 208

Volume and balance, 71, 213, 218

Track lock buttons, 91
Tracks

Index

Audio, 203, 204
Background music, 204
Indication when locked, 91
Locking, 65

Menu, 173

Muting and hiding, 66
Original audio, 203
Overlay, 125

Sound effect and voice-over, 203
Title, 91

Video, 65, 90

Video linked to audio, 92

Transitions

Adding to movie, 141
Alpha Magic, 143
Criteria for selecting, 142
Cut, 143

Default duration of, 255
Described, 141
Displaying type, 52
Dissolve, 144

Effect on clip duration, 142
Fade, 143

Groups, 51

Hollywood FX, 143, 144
In audio, 146

Looping in preview, 149
Naming, 149

On Timeline, 141
Premium, 52

Previewing, 53, 145, 149
Reversing direction, 149
Ripple transition, 147, 153, 168
Section (of Album), 51
Setting duration of, 149
Standard (2D), 143
Three-dimensional, 144
Trimming, 148

Types of, 142
Videography tip, 313
Wipe, slide, push, 144

Transparency

In overlay images, 153

Transport controls

On-screen, 20, 22

Trashcan button, 61
Trim scrubber, 66
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Trimming
Audio clips, 211
Described, 81
Introduced, 73
On the Timeline, 81
Still images, 154
Tips, 85
Transitions, 148
Undoing, 88
Video clips, 81
With Ctrl key, 84
Troubleshooting, 283
TV set
Simultaneous output to, 243

U

UDMA, xii
Undo button, 3
Unlocking
Plug-in effects, 101, 110
Premium content, 11
Sound effects, 58
USB video camera
Capturing from, 30
Use keyframes (checkbox), 106

\Y

VCD
Menus, 55, See Disc menus
MPEG encoding, 28
Output movie to, 233
VGA
Output movie to, 276
Video
Aspect ratios. See Aspect ratios
Capture. See Capture
Frame format. See Aspect ratios
Hiding, 66
Options, 32
Output hardware, xiii
Settings (for File output), 267
Video and audio preferences
(options panel), 257
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Video capture
Step-by-step, 25
Video clips, 63
Applying effects to, 98
Changing name, 86
Changing playback speed, 113
Combining, 90
Editing, 73
Finding Album scene, 80
Interface features, 79
Properties tool, 87
Shortened by transition, 142
Splitting, 89
Synchronization with audio, 90
Trimming, 81
Trimming on the Timeline, 81
Trimming tips, 85
Undoing trim, 88
Using audio portion only, 75
Video compression, 267
Video effects, 98
2D editor, 117
Adding, 110
Adding and deleting, 100
Auto color correction, 111
Basic, 109
Black and white, 119
Blur, 114
Changing parameters, 101
Chroma key, 137
Cleaning effects, 111
Color correction, 119
Earthquake, 117
Emboss, 115
Icons, 80
Invert, 120
Keyframing, 103, 106
Lens flare, 117
Lighting, 120
Luma key, 116
Magnify, 118
Motion blur, 118
Noise reduction, 112
Old film, 115
Pan and zoom, 160
Picture-in-picture, 132
Plus RTFX, 114

Pinnacle Studio 10 Plus



Posterize, 120
Presets, 102

Previewing and rendering, 108

RGB color balance, 121
Sepia, 121
Soften, 116
Speed, 113
Stabilize, 112
Stained glass, 116
Standard, 111
The effects list, 99
Tool, 99
Unlocking, 101
Water drop, 118
Water wave, 119
Video formats, 77
Video levels
Changing during capture, 20
In analog capture, 32
In DV capture, 30
Video monitor
Simultaneous output to, 243
Video preview
External, 257
Full-screen, 257
Options, 257
Video scene catalog, 167
Video scenes
Adding to movie, 73, 74
Album interface features, 39

Combining and subdividing, 48

Comments, 46
Displaying length of, 46
Finding in Album, 39
Folders, 40

In-use indicator, 39, 79
Neighboring, 80

Order of, 39
Redetecting, 50
Section (of Album), 38
Selecting, 45

Splitting, 60
Thumbnail frames, 42

Index

Viewing, 43
Video Scenes section
Views, 46
Video toolbox, 70
Video track, 65, 75, 90
And still images, 151
Linked to audio track, 92
Videography, 311
Videotape
Output to, 243
Views, Movie Window
Storyboard, 62, 63
Text, 62, 67
Timeline, 62, 63
Voice-over tool, 208
Voice-overs, Xii, 63
Properties, 212
Recording, 208
Recording quality options, 210
Volume, 209
Voice-overs tool, 72
Volume
Adjusting on Timeline, 216
Fades, Default duration of, 255
Mixing, 213, 218
Voice-over levels, 209
Volume and balance tool, 71, 213,
218

W

Water drop (video effect), 118
Water wave (video effect), 119
WALV files, 57
White balance, 121
Windows Media
Files, 242
Player, 242
Windows Media Player
Viewing files with, 237
Wipe (transition), 144
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